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Table 1. Building an iCOMPEL part number, example ICPS-2U-PU-N-H.

iCOMPEL (1st 2 
characters) Series (3rd and 4th characters)

Chassis type  
(after 1st dash)* Role (after 2nd dash)

Wi-Fi (after 3rd 
dash)** Video option***

IC PS, SS, KS, KP, or OS 2U or VE or no value PU, SU, KU, or IU N, W, or no value A, D, or H

* O series has no chassis type value here.

**O series has no Wi-Fi value here.

*** Video option applies only to 2U models.

Examples:

ICPS-2U-PU-N-H—iCOMPEL unit, P series, 2U chassis type, publisher role, no WiFi, HDMI capture

ICPS-VE-PU-N-H—iCOMPEL unit, P series, VESA mount chassis type, publisher role, no WiFi, HDMI capture

ICOS-PU—iCOMPEL unit, O series, publisher role

Letter key for part numbers:

iCOMPEL (1st 2 characters):

IC

Series (3rd and 4th characters):

PS = P series  
SS = S series 
KS = K series 
KP = K+ series 
OS = O series

Chassis type (after 1st dash):

2U = desktop/rackmount/ wallmount chassis type      
VE = VESA mount chassis type 
None (O series has no chassis type value here)   

Role (after 2nd dash):

PU = publisher role 
SU = subscriber role  
KU = kiosk role (standalone)  
IU = interactive kiosk (standalone)

Wi-Fi (after 3rd dash):

N = no Wi-Fi 
W = Wi-Fi 
None (O series has no WiFi value here)

Video option (after 4th dash):

A = ATSC/NTSC/QAM video 
D = DVB-T video 
H = HDMI capture



This equipment generates, uses, and can radiate radio-frequency energy, and if not installed and usedproperly, that is, in strict
accordance with the manufacturer’s instructions, may cause interference to radio communication. It has been tested and found to
comply with the limits for a Class A computing device in accordance with the specifications in Subpart B of Part 15 of FCC rules,
which are designed to provide reasonable protection against such interference when the equipment is operated in a commercial
environment. Operation of this equipment in a residential area is likely to cause interference, in which case the user at his own
expense will be required to take whatever measures may be necessary to correct the interference.

Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate
the equipment.

This digital apparatus does not exceed the Class A limits for radio noise emission from digital apparatus set out in the Radio
Interference Regulation of Industry Canada.

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques
de la classe A prescrites dans le Règlement sur le brouillage radioélectrique publié par Industrie Canada.

Federal Communications Commission and Industry Canada Radio Frequency Interference
Statements
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1. Todas las instrucciones de seguridad y operación deberán ser leídas antes de que el aparato eléctrico sea operado.

2. Las instrucciones de seguridad y operación deberán ser guardadas para referencia futura.

3. Todas las advertencias en el aparato eléctrico y en sus instrucciones de operación deben ser respetadas.

4. Todas las instrucciones de operación y uso deben ser seguidas.

5. El aparato eléctrico no deberá ser usado cerca del agua—por ejemplo, cerca de la tina de baño, lavabo, sótano mojado o cerca
de una alberca, etc..

6. El aparato eléctrico debe ser usado únicamente con carritos o pedestales que sean recomendados por el fabricante. 

7. El aparato eléctrico debe ser montado a la pared o al techo sólo como sea recomendado por el fabricante.

8. Servicio El usuario no debe intentar dar servicio al equipo eléctrico más allá a lo descrito en las instrucciones de operación.
Todo otro servicio deberá ser referido a personal de servicio calificado. 

9. El aparato eléctrico debe ser situado de tal manera que su posición no interfiera su uso. La colocación del aparato eléctrico
sobre una cama, sofá, alfombra o superficie similar puede bloquea la ventilación, no se debe colocar en libreros o gabinetes que
impidan el flujo de aire por los orificios de ventilación.

10. El equipo eléctrico deber ser situado fuera del alcance de fuentes de calor como radiadores, registros de calor, estufas u otros
aparatos (incluyendo amplificadores) que producen calor.

11. El aparato eléctrico deberá ser connectado a una fuente de poder sólo del tipo descrito en el instructivo de operación, o como
se indique en el aparato.

12. Precaución debe ser tomada de tal manera que la tierra fisica y la polarización del equipo no sea eliminada.

13. Los cables de la fuente de poder deben ser guiados de tal manera que no sean pisados ni pellizcados por objetos colocados
sobre o contra ellos, poniendo particular atención a los contactos y receptáculos donde salen del aparato.

14. El equipo eléctrico debe ser limpiado únicamente de acuerdo a las recomendaciones del fabricante.

15. En caso de existir, una antena externa deberá ser localizada lejos de las lineas de energia.

16. El cable de corriente deberá ser desconectado del cuando el equipo no sea usado por un largo periodo de tiempo.

17. Cuidado debe ser tomado de tal manera que objectos liquidos no sean derramados sobre la cubierta u orificios de ventilación.

18. Servicio por personal calificado deberá ser provisto cuando:

    A: El cable de poder o el contacto ha sido dañado; u
    B: Objectos han caído o líquido ha sido derramado dentro del aparato; o
    C: El aparato ha sido expuesto a la lluvia; o
    D: El aparato parece no operar normalmente o muestra un cambio en su desempeño; o
    E: El aparato ha sido tirado o su cubierta ha sido dañada.

Instrucciones de Seguridad
(Normas Oficiales Mexicanas Electrical Safety Statement)

NOM Statement
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Trademarks Used in this Manual

Black Box and the Double Diamond logo are registered trademarks of BB Technologies, Inc.

Any other trademarks mentioned in this manual are acknowledged to be the property of the trademark owners.

All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical,
including photocopying, recording, taping, or information storage and retrieval systems - without the written permission of the
publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the respective owners. The
publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no responsibility
for errors or omissions, or for damages resulting from the use of information contained in this document or from the use of
programs and source code that may accompany it. In no event shall the publisher and the author be liable for any loss of profit or
any other commercial damage caused or alleged to have been caused directly or indirectly by this document.

Printed: April 2013
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iCOMPEL Digital Signage User Guide (V9.2.3)

1. Welcome to Black Box Digital Signage

Welcome to the iCOMPEL user guide. Here you will find comprehensive information about how to create digital signage with
the iCOMPEL and how to manage the iCOMPEL unit.

Find the subject you are looking for in the table of contents or in the PDF bookmarks. Track down the location of specific
topics with the index at the end of the guide or by using the Adobe Reader search facility.

If you are new to the iCOMPEL, how it operates, and what it can offer, you will find helpful orientation by reading through
the Terms You Need to Know . Following that, check through the steps needed to log on to the iCOMPEL  and the
description of the iCOMPEL user interface features .

The more experienced may wish to go straight to the information about creating and controlling digital displays:

Creating Digital Signage  – Getting started with designing and implementing your display.

Understanding Media Types  – Understanding the different types of content you can display and how the iCOMPEL
manages them.

You can also find background Information on setting up and managing the iCOMPEL:

Player and System Status  – Keeping your iCOMPEL running smoothly.

Setup  – Performing configuration and maintenance tasks.

1.1 Terms You Need to Know

The iCOMPEL provides powerful facilities to help you to design, structure, and control sophisticated and effective content
display. Before you can make full use of those facilities, you need to be familiar with some core concepts.

The iCOMPEL is a digital signage player that displays content on a screen. The screen is physically attached to the
iCOMPEL and is usually an LCD panel or LCD TV. To design what appears on the screen, and to manage the iCOMPEL
itself, you connect to it over your network using a web browser running on your PC.

To understand how you use the iCOMPEL to manage display of content, it is important to understand how certain key
features relate to each other. The following diagram illustrates the critical relationships between Schedules, Layouts,
Zones, and Playlists:
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To flesh out how those relationships work, consider each of those key features in turn.

Schedule

Your iCOMPEL is designed to run continuously. You control which Layouts are displayed on what days and at which times
by creating a Schedule. The schedule may be something like this:

Layout A runs from 4.00 pm to 6.00 pm, Mondays to Fridays.

Layout B runs from 2.00 pm to 8.00 pm, Saturdays and Sundays.

Layout C runs at all other times, throughout the week.

Layout

A Layout is the arrangement of individual display areas, known as Zones, that you use to compose your on-screen
display. Your layout might display video in one zone, scrolling text in another, a sequence of still images in a third zone,
with a full-screen zone behind the others showing a background color or image.

Zones

Zones are rectangular areas, each of which can display various forms of content (known as media items). You can design
layouts with any number of zones, of any size, in any location, either separate or overlapping. You specify which zones
display which media types (for example, one for a promotional video, one for scrolling text, another for your organization's
name or logo, and so on). You can also have zones display a mix of media types. You arrange the media items for each
zone in a Playlist.

Playlist

A Playlist contains one or several media items that you choose to display in a zone. Media items include fixed and
scrolling text, movies, images, Adobe Flash animations, web pages, and newsfeeds. To display a media item, you add it to
the playlist. Each zone has its own playlist, which runs continuously. You can also synchronize the display between two
playlists (for example, to run a scrolling text message at the same time as a related promotional video or image.

That examination of the key features gives a flavor of how you put together your signage display on a single iCOMPEL.
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However, if your software key permits it, you can also easily create a network of inter-related iCOMPEL players. You do
this by designating and configuring one iCOMPEL as a Publisher, which means it shares the design and content of its
schedule and layout with other iCOMPEL players. In turn, you designate those other iCOMPEL players as Subscribers.
This shared content is referred to as a Channel. 

You can also allow people local to the subscriber iCOMPEL players to have a degree of control over the content the
iCOMPEL displays. The material and features that you allow local users to modify is called Ad Hoc content and they are
called Ad Hoc Users.

That brief survey of the key terms provides the foundation to start using the iCOMPEL. Other sections introduce and
describe additional terms and concepts as needed. An extensive glossary  provides definitions of the core iCOMPEL
terminology. 

But now, to consider further how to use schedules, layouts, zones, and playlists to create your digital signage, you might
want to refer to Creating Digital Signage . 

1.2 Logging On

During the log on process, you will need to provide the IP address of your iCOMPEL. Make a note of this before you begin. 
If you do not know the IP address, restart the iCOMPEL: it displays its IP address above the progress bar towards the end
of the boot sequence.

Follow these steps to log in to your iCOMPEL:

1. Ensure that the iCOMPEL is connected to the network.

2. Open a web browser (such as Mozilla Firefox or Microsoft Internet Explorer) on a computer on the same network as the
iCOMPEL.

3. In your browser's address bar, type in the IP address of your iCOMPEL and click the 'go to' arrow or press the Enter key.

4. When prompted, enter the username and password. The factory-set defaults for these are remote and 9999 respectively.
Your iCOMPEL displays its Home page

Security: It is strongly recommended that you change the remote account password from the factory default as soon
as possible. Also change the iCOMPEL master password and check that the security services configuration matches
your requirements (see Security – General Settings  for details).

For the future, you might want to bookmark the Home page or add it to your favorites for easier access. If your network is
set up to provide DHCP and DNS support, you can also access the iCOMPEL later using its name rather than its IP
address: the name is automatically generated in the format iCOMPELserial, where serial is the serial number of your
iCOMPEL (for example, iCOMPEL123456).

The iCOMPEL comes ready-installed with a number of sample displays and you might find those useful to illustrate the
kinds of features you can implement. 

If you need assistance at any time, click Help on the menu bar to access page-specific help or to navigate to any other
help page. 

You can now begin to become familiar with the iCOMPEL user interface. 
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1.3 Using the Web Interface

You control and manage the iCOMPEL through your browser using the web-style pages of the iCOMPEL user interface. 

You should familiarize yourself with the essential features of the user interface before beginning to use the iCOMPEL. Most
important is the main Home page but you should also be aware of the generic navigation and command features employed
on other pages. What follows is a tour of the Home page followed by descriptions of those generic features. 

The Home Page

This is the first page you see after logging onto the iCOMPEL. 

At its heart is this view of the current state of the iCOMPEL, picturing what it is currently displaying and showing a
summary of its operational status:

The components of this display are:

Layout thumbnail

Layout icons

Status bars

Layout Thumbnail

This shows you what the iCOMPEL is currently playing. If you click on the thumbnail, the iCOMPEL opens the page
showing a full-size screen snap shot. 
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The bar above the thumbnail includes the name of the layout and a link to open the editor for it. The time underneath
indicates when the iCOMPEL last updated it.

Layout Icons

This shows you the arrangement of zones in the layout. Each zone is represented by a rectangle and the colors indicate
the kind of content that zone can display. If you click on a zone, the iCOMPEL opens the graphical layout editor for you to
edit it.

The panels underneath the layout show:

How much CPU the iCOMPEL is currently using to display the layout 

The  icon: click this to open the system status page.

Status Bars

These indicate the status of key iCOMPEL operational components. Each status bar has this general appearance:

The features to note are:

Open/close arrow – Click the  arrow to reveal more details. Click the  arrow to reduce the detail.

Name – The subject of the status report (in the above case the subject is the Network).

Status summary – The color of the icon indicate the current status (in the above case, the network status is good).

Here are status bars that respectively indicate attention needed and problem detected:
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If you click the open arrow on an attention or problem status bar, the iCOMPEL provides a description of the problem in the
information revealed. To take corrective action, click on the appropriate button to open the relevant page in the interface.

More generally, opening a status bar provides you with additional information about the subject area with a selection of
buttons to take you to relevant pages in the user interface. For example, opening the Media status bar reveals details
about the iCOMPEL media state:

Generic Features: The Menu Bar

The menu bar appears on every page of the user interface. It allows you to navigate to the page you need to perform
detailed actions. Broadly speaking, each page corresponds to a particular feature such as:

Layout design

Playlist creation

Channel publishing

Managing user accounts

The menu bar offers these top-level options:

The relevant explanatory sections describe those options in detail. You can also change how you interact with the menu bar
on the Help > UI Options page. Some iCOMPEL features are only available if you enable the Detailed or Expert option on
the UI Options page. Restrictions may also apply if your iCOMPEL hardware components and capabilities do not support
certain functions or if you do not have the requisite software feature keys.

To speed your access to important pages and information, the right-hand side of the menu bar includes a selection of icons.
Click the icon to access the following:

 – The Home page.

 – The Manage Schedules page.

 – The Manage Layouts page.

 – The Setup icons page.
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 – Confirmation of no known issues.

 – Brief description of an attention item (only shown if one is active).

 – Brief description of a problem item (only shown if one is active)

Note: The iCOMPEL does not display the quick access icons if your PC screen is too small or you have restricted the
size of the browser window.

To allow you to use more of the screen to display page content, the left-hand side of the menu bar includes a control to
collapse and expand the screen banner:

 – Collapse the banner.

 – Expand the banner.

Generic Features: Tabbed Pages

Many options in the iCOMPEL user interface are split across tabbed pages.

To access the options on the tabbed page, click the tab label (for example, Add Schedule).

Generic Features: Action Buttons

Numerous actions are common across different iCOMPEL pages. The user interface indicates these with icon action
buttons. Click the button to perform the indicated action:

 – Audition

 – Delete

 – Rename

 – Copy

 – Edit

 – Drag to reorder

Generic Features: Command Buttons

Some commands are common across different iCOMPEL pages. The user interface provides command buttons for these.

To execute the command, click the button. The label on the button describes the command, such as  or

.
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2. Creating Digital Signage

This section describes how to create your digital signs. If you are new to the iCOMPEL see Terms you need to know
before you begin. 

The details in this section apply equally to creating content for a standalone iCOMPEL and for creating content for a 
channel publisher .

Click on the links below for more information on:

Schedules

Layouts

Zones

Playlists

Media types

Enhancing your digital signage

2.1 Using Schedules

Your iCOMPEL is designed to run continuously. You control which layouts are displayed on what days and at what times
by creating a Schedule. A schedule always contains at least one Schedule Entry, which defines at least one iCOMPEL
action (often, which layout to display). A schedule entry does not necessarily specify a layout change, it could specify
some other action (for example, switching the audio to mute).

The schedule entries define periods of time during which actions occur. The program of schedule entries is based on a one-
week cycle. The Default Schedule Entry defines the layout that appears, or the actions that occur, when no other
schedule entry is active.

The iCOMPEL always displays the schedule with the most recent start time. Once a schedule starts running it continues
until another schedule is set to begin. If there is only one schedule it runs indefinitely.

An example schedule might contain schedule entries taking these actions:

Playing layout X from 4:00 pm to 6:00 pm, Mondays to Fridays.

Playing layout Y from 2:00 pm to 8:00 pm on Saturdays and Sundays.

The default schedule entry, playing layout Z at all other times.

Whenever you make a change to a schedule or layout, you must click the  button to implement the
change.

You can temporarily interrupt a schedule by using a Schedule Override.

To list all of the schedules configured on the iCOMPEL:

1. On the menu bar, click Schedules.

2. Click Manage Schedules.

There are these action buttons for each schedule:

 – Delete the schedule (does not delete the associated layouts).
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 – Copy the schedule.

 – Edit the schedule.

To create a new schedule, click the Add Schedule tab.

2.1.1 Creating a Schedule

To display content on your iCOMPEL, you need to create at least one schedule. Create additional schedules as required.
You add schedule entries to a schedule to fine tune how the iCOMPEL runs it.

To create a new schedule:

1. On the menu bar, click Schedules

2. Click Manage Schedules. 

3. Click the Add Schedule tab.

To create the new schedule, complete the following details and click the  button:

Schedule Name Enter a unique name for the schedule.

Valid From Select the date and time when the iCOMPEL starts running the schedule (the default is in 24 hours time).

Valid Until Select the option that matches your requirement:

Superseded – The iCOMPEL keeps playing this schedule until a more eligible schedule becomes
available.

Date – The iCOMPEL keeps playing this schedule until the date and time you choose. It then plays the next

eligible schedule. If the iCOMPEL cannot find an eligible schedule, it continues to play this one.

Show Layout Select the layout to display.

Conditional Play This is only enabled when you have added Player Local Information (PLI) to the iCOMPEL (see Player Local
Information  for details).

If it is enabled, you have two options:

Play Always – Default. The iCOMPEL always plays the schedule.

Play if Player Local Information Item – The iCOMPEL only plays the schedule if certain conditions are met.

If you select Play if Player Local Information Item, complete these steps:

1.Select the name of the relevant player local information from the first drop-down list.

2.Select the test to apply from the second drop-down list.

3.Enter the value to test for in the final field (add further values by clicking the  button or delete values

by clicking the  button).
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2.1.2 Schedule Entries

A schedule entry is a set of one or more actions for the iCOMPEL to perform at specified times. Schedule entries repeat
over a weekly cycle and a program of schedule entries make up a schedule.

Use schedule entries to specify these actions:

Displaying a layout

Switching a screen on or off

Switching audio on or off

Performing Advance To commands. 

Whenever you create a new Schedule, the iCOMPEL automatically includes a Default Schedule Entry. The default
schedule entry has no start and end time and defines the default states when no other entry is active.

Schedule entries allow you to direct your iCOMPEL to perform simple or highly sophisticated sequences of actions. You
can have the iCOMPEL display different layouts at different times of the day and different days of the week, switch the
display on and off, or repeat actions at specified intervals.

To illustrate the use of schedule entries in more detail, here is a worked example.

With the following schedule, made up of three schedule entries, the iCOMPEL will:

Turn the screen on to show the Showroom layout from 08:45 until 18:00 on Mondays to Fridays.

Display the Active layout (carrying a news broadcast) for 10 minutes every hour. 

Turn the screen off at all other times the screen is turned off.

Schedule made up of three Schedule Entries

Looking at the respective settings on the Add Schedule Entry tab reveals how you would go about specifying each of
those schedule entries.
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The first schedule entry causes the iCOMPEL to turn the screen off and mute the audio soundtrack (note that the
Showroom layout plays even though the screen is off):

Details of first Schedule Entry

The second schedule entry causes the iCOMPEL to turn the screen on and play the Showroom layout:

Details of second Schedule Entry

The third schedule entry causes the iCOMPEL to change to the Active layout for 10 minutes every hour:

Details of third Schedule Entry
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To create a new schedule entry, click the Add Schedule Entry tab, complete the following details, and click the

 button:

From Select the time range during which you want the iCOMPEL to apply the schedule entry.

00:00:00 means midnight. Set both From and Until to midnight for the iCOMPEL to run the schedule entry all
day. For a period that runs through midnight, add separate schedule entries: one ending at midnight, one
commencing from midnight.

On Check the boxes for the days you want the iCOMPEL to play the schedule entry.

Repeat Choose the option that matches your requirement:

Perform actions for the entire period – The iCOMPEL performs the actions all of the time.

During the period, only perform actions – The iCOMPEL performs the actions only when and for as long
as you specify. Specify the regularity with the Every options and the duration with the for options. The Every
setting must be at least 30 seconds longer the for setting. The minimum for setting is 30 seconds.

Ad hoc This is only enabled when you have added schedule ad hoc items to the iCOMPEL (see Managing Ad Hoc
Pages  for details).

Check the User can override From, On and Repeat settings using Ad hoc Schedule Item box to allow ad hoc
users to alter those time settings.

Actions Check the boxes and select the required action you want the iCOMPEL to perform:

Audio – Unmute or mute the display's sound.

Screen – Turn the screen on or off.

Layout – Display the selected layout.

Advance To – Play the next item in the zones containing the selected rendezvous point. 

Modify a schedule entry by clicking the  button next to it on the Schedule tab.

2.1.3 Overriding the Schedule

You may need to override the current schedule at certain times (for example, to show a special event from a TV broadcast
feed). You can create a Schedule Override which temporarily replaces the current schedule. The iCOMPEL stops playing
the current schedule and displays a different layout. You restore the normal schedule by clicking the

 button.

Note: Although channel subscriptions take place, they are not activated until you click the 
button to return to the normal schedule.

To create a schedule override, follow these steps.

1. On the menu bar, select Schedules then Manage Schedules. 

2. Click the Add Override tab. 

3. Enter a name for the override. Use a descriptive name (for example, 'Emergency Instructions').

4. Select what you want the iCOMPEL to do with audio and the screen.
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5. Choose a layout for the iCOMPEL to display.

6. Click the  button.

To activate an override, follow these steps:

1. On the menu bar, select Schedules then Manage Schedules. 

2. Click the Overrides tab. 

3. Click the  button next to the override you want to use. 

The iCOMPEL displays the override layout immediately and continues to do so until you click the 
button. 

2.2 Using Layouts

A layout is an arrangement of various display areas, called zones. Your layout may include video in one zone, scrolling text
in another zone, and a sequence of still images in a third zone. You may also have a zone that is the same size as the
layout and contains a background image on which all the other zones are superimposed. Your audience sees everything in
your layout, so you need to take care to design layouts that are appealing and effective. 

By default, the iCOMPEL names the zones for each layout on the screen in the order in which they were created – zone A,
B, C and so on. To help manage the zones, you can change the names to make them more descriptive (for example,
'Background' or 'Main Video'). You can change the relative display positions of the zones in a layout.

Each zone can display media items of different types, according to the media player or players you enable for the zone. 

The iCOMPEL screen background is visible in any part of the layout that is not covered by a zone. You can define the color
or image for the screen background independently of any layout.

2.2.1 Manage Layout Page

The Layouts > Manage Layouts  page shows all the layouts available on this iCOMPEL. 

For each layout, the iCOMPEL displays:

A thumbnail image (blank if the iCOMPEL has not used the layout yet).

A diagram of the layout's zones.

The name and description of the layout.

If applicable, the names of the schedules that use the layout.

The canvas size required for the layout.

The names of any rendezvous points or Change Layout commands.

A link to the layout's Ad hoc Page. 

Additionally, the iCOMPEL displays an audio icon if you enable a soundtrack and a touch-screen icon if you enable
interactivity. Click on the icon to edit those properties.

Click the layout name (or the thumbnail) to open the graphical layout editor or to access the layout's properties. Click a
zone in the layout diagram to open the zone's playlist.
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The iCOMPEL provides the following action buttons for each layout:

 – Audition the layout (on the screen or in your browser, depending on your UI Options setting).

 – Delete the layout (you cannot delete a layout referenced by a schedule, even if inactive).

 – Rename the layout.

 – Copy the layout.

 – Edit the playlists for the layout's zones or edit the layout itself.

To reduce the number of layouts displayed, follow these steps:

1. Click the  button.

2. Enter all or part of the layout's name.

3. Click the  button. 

To clear a filter, click the  button.

2.2.2 Adding a New Layout

To add a new layout, follow these steps:

1. On the menu bar, select Layouts then Manage Layouts. 

2. Click the Add Layout tab.

3. Enter a name for the new layout and click the  button

4. Click the  button next to your new layout in the layouts list to open the graphical layout editor. 

5. Add and set the properties for the zones you require.

6. When done, click  and .

You can return and edit your layout whenever you wish.

2.2.3 Editing a Layout

To edit a layout, click on its name or thumbnail on the Layouts > Manage Layouts page.

The layout's page has these tabs:

Zones – Displays the graphical layout editor for you to add or modify zones and their properties.

Layout Properties – Displays the Ad Hoc Page and Soundtrack options for you to enable or disable.

Interaction – Displays the interactivity options for you to configure.
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2.2.4 Layout Properties

The Layout Properties tab allows you to configure the following details (when complete, click the 
button):

Description Optional. Enter a description of the layout. The iCOMPEL displays this on the Layout pages underneath the
layout's name.

Layout Ad hoc
Page

Check this box and the iCOMPEL will automatically create an ad hoc page if you add ad hoc items to this
layout. 

If you add or remove ad hoc items, the iCOMPEL will add or remove them from that ad hoc page. If you delete
all ad hoc items, iCOMPEL deletes the ad hoc page. 

Soundtrack Check the Include Soundtrack box to enable a soundtrack for this layout. 

By default, the iCOMPEL checks the Add default media to Soundtrack's Playlist box. This means that the
iCOMPEL will play the default soundtrack media. If you uncheck that box, you will need to add a media file by
opening the Soundtrack item in the layout's Playlist menu. 

2.2.5 Interaction Properties

The Interaction tab allows you to define how the layout responds to touch screen and general purpose input/output events.

Note: You may require a feature key to use these options.

See Using Interactivity  for details on designing and implementing interactive responses.

2.3 Using Zones

You compose layouts from defined rectangular areas called zones. Each zone can display various types of media content.
The number of zones in your layout, their size, and location is up to you. 

It is common to use different zones to display different types of content (for example, one for scrolling text, one for a
promotional video, and so on). However, any zone can display any media type: you just have to enable the zone with the
appropriate media player. You can have a zone display a single item or a sequence of items. You define the items that a
zone displays in a playlist.
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2.3.1 The Layout Editor

To create and manage the zones in a layout, you use the graphical layout editor. To edit a layout, click on its name or
thumbnail on the Layouts > Manage Layouts page.

The Zones tab provides the graphical editor that you use to adjust the position and size of each zone in your layout:

The graphical layout editor

By default, the editor displays the layout at 75% of the currently defined screen resolution (not the monitor of your PC). You
can change this by using the drop-down list at the top of the page.

The editor displays each zone in a color indicating the media player enabled for the zone:

Red – Movie player (zone B)

Light green – HTML player (zone E).

Light blue – Image player (zone D).

Yellow – Text player (zone C).
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Note: The display shows the zones with a slight transparency (for example, to aid in aligning with background images).
This does not indicate how the zone appears when displayed on screen.

To select a zone, click it. The editor shows the selected zone with handles (as seen for zone E). To move the zone,
drag-and-drop it. To resize the zone, drag one of the handles.

You can also right-click a zone to open a context menu containing common functions:

Zone context menu

When you have finished making changes to your zones, click the  button. This offers these options:

 – Simply saves your layout changes.

 – Saves your layout changes and the iCOMPEL auditions them.

 – Saves your layout changes and opens the playlist for you to edit it.

2.3.2 Editing a Zone

The Zones tab includes these buttons:

 – Click to add a zone to the layout. The iCOMPEL adds the zone for you to start sizing and positioning it.

 – Click to display a list of all zones in the current layout. 

 – Click to toggle the Zone Properties dialog off and on. The iCOMPEL displays the toolbar for the
currently selected zone.

 – Click to select the Save options.

The  and  buttons provide the detailed editing features. 

Click the  button to open a list like this:
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Select Zone list

The list highlights the currently selected zone (in this case, zone B).

Perform the following actions with the Select Zone features:

Click the  button to delete a zone.

Click the  button to select the zone you want to size and position. This includes zones hidden by other zones.

Change the zone order by dragging-and-dropping the  icon. This is the zone order in layers (for example, moving the
'Background' image to the back of the layout).

Close the Select Zone list by clicking its button again or clicking elsewhere on the page.

2.3.3 Editing a Zone's Properties

Click the  button to open its dialog:

Zone Properties dialog

You can move the dialog around the screen by dragging it by its title bar. Close the dialog by clicking its  button or by

clicking the  button again.

You can access and configure the properties by selecting the appropriate tab and entering the values required:

Zone Choose from the following options:

Zone Name – Optional. Enter a descriptive name for the zone. The iCOMPEL shows this name when you
are on a zone-specific page (such as in its playlist).

Media – Check the relevant box or boxes to enable the zone to play that media type.
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Size & Position Size and position the zone by entering specific values.

Note: If you use pixel values, the result may vary according to the resolution of the screen.

Top, Bottom, Left, and Right Edge Offsets – The iCOMPEL offsets the position of the zone relative to the
edge of the screen. 

Width – Exact width for the zone.

Height – Exact height for the zone.

Aspect Ratio – Use to automatically size the zone depending on the aspect ratio of its content. Only
available if you use pixels for Width and Height and do not select the Specify custom width and height
option. First, select the type of aspect ratio needed from the drop-down list. Second, select whether the
iCOMPEL calculates the required zone size keyed to the height or to the width. 

Properties Check the box or boxes to enable the options required:

Image – If you have enabled the zone to show images, check this box to see the first item in the playlist in
the layout editor (instead of the standard colored area). This helps preview the image and align other zones
to it.

Design Visibility – Uncheck this box so that the zone is not shown in thumbnail views. This helps to edit
other zones that are overlapped by this zone.

Media Audit – Check this box to enable media audit reporting for the zone. You can override this on an item-
by-item basis in the playlist. See Reporting & Remote Setup  for more details on reporting.

2.4 Using Playlists

A playlist is a sequence of media items that you choose for display in a zone. Each zone has its own playlist and runs
independently of other playlists. A soundtrack also has its own playlist.

Playlists play their content in a continuous loop. After the iCOMPEL plays the last item, it starts again with the first.

You can include the following in a playlist: 

Individual content files (such as images, movies, or text).

Folders containing multiple items.

Special Items (such as a newsfeeds, TV stations, and tables).

Ad hoc Items (controlled by your local users).

To add or modify items in a playlist, you need to access its specific page. Use one of these methods to access a playlist's
page:

On the menu bar, click Playlists and select the zone from the relevant layout.

On the menu bar, click Layouts > Manage Layouts and click on the zone in the relevant layout diagram.

The playlist page has these tabs:

Playlist – Lists the items in the playlist (displays their type, media details, and play duration).

Files & Folders – Lists the folders containing media items you can add to the playlist (also use to navigate between
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folders and move files between folders). You can also add a whole folder to a playlist. See Media Run from the
iCOMPEL Disk  for more information.

Upload Files – Use to copy files onto the iCOMPEL and to create new folders. See Uploading Content Files  for
more information.

Specials – Use to add special items to the playlist (items other than files and folders). See Adding Special Items to a
Playlist  for more information.

Defaults – Use to set the default properties for media items when you first add them to the playlist. Changing a default
value does not affect items already in the playlist.

The iCOMPEL provides the following action buttons for each item in a playlist:

 – Move the item (by drag-and-drop).

 – Audition an item (preview on the screen or in your browser).

 – Delete an item.

 – Edit an item's properties.

2.4.1 Adding Media Item Files to a Playlist

Before you can add a media item file to a playlist, you need to upload it to the iCOMPEL. You must have enabled the zone
to play the type of media you want to add to the playlist. 

To add a file to a playlist, open the playlist page and follow these steps:

1. Click the Files & Folders tab.

2. Click the name of the folder containing the file.

3. Click the  button alongside the file you want to add.

4. Click the Playlist tab to view the updated playlist. 

5. Perform any other required actions (for example, adjusting the play order or modifying the item properties).

2.4.2 Adding Special Items to a Playlist

You can add special items to a playlist if supported by your iCOMPEL and the media you have enabled the zone to play.

There are two groups of special items:

Those you need to set up in advance.

Those you do not need to set up in advance.

The special items you need to set up in advance are:

Video (including TV stations).

Newsfeeds.

Tables.

The special items you do not need to set up in advance are:

40
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Clocks.

Direct text.

External web pages.

QR Codes.

Interactivity actions.

The Wait, Rendezvous Point, Advance To, and Change Layout commands.

To add a special item to a playlist, open the playlist page and follow these steps:

1. Click the Specials tab.

2. Click the  button alongside the item you want to add. (Depending on the item, you may need to enter text or
select properties first.)

3. Click the Playlist tab to view the updated playlist. 

4. Perform any other required actions (for example, adjusting the play order or modifying the item properties).

2.4.3 Adding Folders to a Playlist

You can add a whole folder to a playlist. The iCOMPEL treats the folder as a single playlist item but plays the files within it
individually.

Before you add it, ensure that the folder contains the media items you want to use. 

To add a folder to a playlist, open the playlist page and follow these steps:

1. Click the Files & Folders tab.

2. Click the  button alongside the folder you want to add.

3. Click the Playlist tab to view the updated playlist. 

4. Perform any other required actions (see Folder Play Properties  for information on customizing how the iCOMPEL
plays the folder items).

2.4.4 Playing Content Items to Test Them

There are various ways of playing content items to test them:

Activate a layout and view it on the screen. This is useful if you want to see the complete run of all items and you can
easily view the screen.

Audition a layout, playlist, or individual items on the screen. This is useful if you want to see individual items and you can
easily view the screen.

Display a single image of the current screen or view a live screen display of the current layout in your web browser. This
is useful if you want to see the content of the current display but cannot easily view the screen.

Preview an item in your web browser. This is useful if you want to see one particular item but cannot easily view the
screen.
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Activate a Layout and View it on the Screen 

To activate a Layout and view it on the Screen, take these steps:

1. On the menu bar, click Layouts and Manage Layouts. 

2. Click the layout's  button.

To return to what was previous being played, click the  button.

Audition a Layout, Playlist, or Individual Item on the Screen 

To audition a layout on the screen, take these steps:

1. On the menu bar, click Layouts and then Manage Layouts. 

2. Click the layout's  button. 

3. The iCOMPEL shows the layout on the screen until you click the Activate Schedule and Layouts button.

Alternatively, to view an item, click on a zone in the layout preview and then the item's  button. 

Display a Single Image of the Current Screen or View a Live-Screen Display in Your Web Browser 

To preview a single pixel-perfect screen snap shot or a 60 second-long live-screen display, take these steps:

1. On the menu bar, click Status and Player.

2. Click the Screen Snap Shot tab. iCOMPEL displays an exact image of the current screen content.

3. To run the live-screen display, choose the view size you want and how many frames per second to update it.

Note: Viewing the live-screen display may impact the quality of the actual screen's output.

4. Click the  button. The iCOMPEL displays the live-screen display in your web browser. By default, it

runs for 60 seconds but you can stop it at any time by clicking the  button.

Preview an Item in Your Web Browser 

To preview an item in your web browser, take these steps:

1. On the menu bar, click Help and UI Options.

2. On the My Options tab, set the Audition method to Web Preview.

3. Click the  button.

4. On the menu bar, click Layouts and Manage Layouts. 

5. Click the layout's  button. 

Note: The screen will go black for a moment while the iCOMPEL takes the snap shot then reverts to the current layout.
The iCOMPEL displays the snap shot in a new browser window (or browser tab).
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3. Understanding Media Types

The iCOMPEL allows you to display a great many types of digital content (also referred to as media). 

When creating a layout, you must specify the type of media each zone will display. This enables the zone to 'play' the
media concerned. You can configure zones to support one or more of these players: 

Movie player – For media such as video and TV.

HTML player – For media such as web pages and tables.

Image player – For media such as graphics and photographs.

Text player – For media such as text and newsfeeds.

In addition to those media types, you can add audio to a layout using the Soundtrack feature (see Audio  and Radio
 for more details).

The iCOMPEL provides many features for setting up and managing the media items you want to use. It is important to
understand how the iCOMPEL handles groups of media differently depending on their types and characteristics:

Media Directly Managed by the iCOMPEL  (includes text, newsfeeds, clocks, tables, RS-232 outputs, and QR
Codes).

Media Run from the iCOMPEL Disk  (includes video, text files, images and photos, audio, presentations, HTML web
pages, Adobe Flash files, and folder play).

Media from External Sources  (includes TV, radio, live video, multicast video, and external web pages).

3.1 Media Directly Managed by the iCOMPEL

Some types of media are managed directly by the iCOMPEL. These include:

Text

Newsfeeds

Clocks

Tables

RS-232 Outputs

QR Codes

Ad Hoc Content  items are also managed by the iCOMPEL.

3.1.1 Text

You can display text you directly enter on the iCOMPEL. (You can also display text files: see Text Files  for more
details.)

Zone player type to enable: Text.

Playlist tab containing the item: Special.

45

48

36

40

48

36

37

38

38

40

40

80

44



Copyright © 2010-2013 Black Box Network Services. All Rights Reserved.724-746-5500   |   blackbox.com 37

Understanding Media Types

Additional notes:

Supported Format Notes

iCOMPEL text editor
formats

The iCOMPEL text editor offers formatting features (for example, use of bold,
italic, font size, and color).

3.1.2 Newsfeeds

You can display newsfeeds from external sources on the iCOMPEL. 

Broadcasters or news agencies (for example, the BBC or Reuters) provide newsfeeds containing headline news or sports
reports. Providers often do not charge and usually do not require usernames or passwords. However, some providers do
define terms restricting display of their newsfeeds in digital signage networks and you must check on this before using
newsfeed content.

Zone player type to enable: Text.

Playlist tab containing the item: Special.

Additional notes:

Supported Format Notes

RSS 0.91 and 2.0 (must
say 'RSS' or 'XML' ).

Compatible newsfeeds are normally indicated by the  symbol.

To subscribe to a newsfeed, follow these steps:

1. Find the newsfeed using your browser. 

2. Click the link to the newsfeed or click the RSS button .

3. Copy the newsfeed's web address from the browser's address bar.

4. On the iCOMPEL, on the menu bar, click Media and Newsfeeds.

5. Click the Add Newsfeed tab, complete the newsfeed properties, and click the  button.

The newsfeed properties are:

Name Enter a unique name for the newsfeed.

RSS Newsfeed
URL

Enter or paste in the newsfeed web address. You must include the protocol (for example, http://www.bbc.co.
uk/travelnews/tpeg/en/pti/pti_rss.xml).

Refresh Interval Specify how often the iCOMPEL checks for updates.

Maximum Age Specify how long the iCOMPEL will continue to display existing items if there is no connection to the newsfeed
to obtain new ones.

Authentication Select the required authentication style:
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No authentication required – The newsfeed does not require a username and password.

Login with – The newsfeed requires a username and password. Enter them in the fields provided.

Proxy Select the required proxy configuration:

No proxy required – The iCOMPEL connects directly to the internet.

Use proxy if configured – The iCOMPEL accesses the internet through the configured proxy. You must first
configure the proxy (on the Setup > System > HTTP Proxy page).

3.1.3 Clocks

You can display a digital clock on the iCOMPEL showing the date and time in any one of a variety of formats.

Zone player type to enable: Text.

Note: Earlier versions of the iCOMPEL supported clocks in zones enabled with the HTML player. If you already have
HTML clocks in your layout you can continue to use them. 

Playlist tab containing the item: Special.

3.1.4 Tables

You can create, format, and display tables using the iCOMPEL. Before you can add a table to a playlist, you have to create
it.

Tables are a convenient way of displaying static data. You can also use tables to hold ad hoc entries that local users
control (for example, a table showing conference center room allocations). The iCOMPEL creates tables using HTML.

Zone player type to enable: HTML.

Playlist tab containing the item: Special.

Adding and Editing an Ordinary Table:

To add a table, follow these steps:

1. On the menu bar, click Media and Tables.

2. Click the Add Table tab.

3. Enter a descriptive name for the table.

4. Enter the number of rows and columns. The maximum size is 19 rows by 39 columns. You cannot change the size of a t
able after you create it.

5. Click the  button. 

The iCOMPEL displays the Tables tab with your table added to the list. Click the button next to a table to take these
actions:

Delete the table. You cannot delete a table that is in use. Check the right-hand column to see the items using the
table.
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Rename the table. Enter the new name in the field and click the  button. If you decide not to

rename the table, click the  button.

Copy the table. Enter the name for the copy in the field and click the  button. If you decide not to

copy the table, click the  button.

Edit the table. To edit a table after creating it, follow the same steps as described next for setting up a new table.

You need to set up your new table by following these steps:

1. Click the table's  button.

2. Click the Style tab.

3. Take whichever of these formatting steps are needed to get the effect you want:

Click the  button to change the width and color of the border.

Click the  button for each column you want to size manually.

Click the  button for each cell whose text font and size you want to adjust. Text Properties  describes the
formatting options. You can edit one cell and specify that the iCOMPEL also applies those changes to other cells.

4. Click the Values tab.

5. Edit the default text in each cell as required.

6. Click the  button.

Adding and Editing Ad Hoc Tables:

To create an ad hoc table, follow these steps:

1. Create a table as described above.

2. On the menu bar, click Media and Manage Ad hoc Items.

3. Click the Add Item tab.

4. Add a new Ad hoc Table Item that references the table.

Note: If you copy an ad hoc table, the copied table is not an ad hoc table.

To edit an ad hoc table, open the Tables page and click the table's  button. Make changes on the Style and Default
Values tabs as described for the Style and Values tabs above. Click the Ad Hoc tab to specify the ad hoc features. Click

the  button for the cell you want to change and select the option required:

Default Value – The ad hoc user cannot change the cell value.

Override with any value – The ad hoc user can enter any value in the cell.

If you set the User Interface Policy to Detailed, the iCOMPEL also offers these options:

Override with Integer between – The ad hoc user can only enter values between the lower limit and upper limit you
specify (both inclusive).
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Override with text of maximum length – The ad hoc user can only enter text up to the number of characters you
specify.

Override value with text matching – The ad hoc user can only enter text that matches the regular expression you
specify. In the Feedback Message field, enter the message you want the iCOMPEL to display to the ad hoc user if what
they enter does not match the regular expression. Information about using regular expressions is readily available (for
example, at http://www.regular-expressions.info/).

3.1.5 RS-232 Outputs

You can add an RS-232 output item to a playlist. When the item is reached in a playlist, the iCOMPEL sends a character
string to an external device through its RS-232 port (for example, to switch on a light at the start of the day). See RS-232
Outputs  for how to set up RS-232 items on the iCOMPEL.

To add an RS-232 output item to a playlist, follow these steps:

1. On the menu bar, click Playlists and select the layout and zone where you want to add the RS-232 item. 

2. Click the Specials tab.

3. Check the Send RS-232 Item.

4. Click the  button.

5. In the playlist, drag the  icon to adjust the position of the RS-232 item in the playlist, as necessary.

6. If required, click the  button to adjust the interaction properties.

3.1.6 QR Codes

You can create and display QR Codes using the iCOMPEL. 

QR Codes (Quick Response Codes) are two-dimensional barcodes carrying content that can be read by a suitable device.
For example, a QR Code can contain a web site URL or an email address: a user scans the QR Code with a smartphone to
open that web site or to compose an email to that address.

Zone player type to enable: Image.

Playlist tab containing the item: Special.

Additional notes:

Supported Format Notes

QR Code The iCOMPEL creates QR Codes with Level H error correction (30%) and
uses byte encoding.

3.2 Media Run from the iCOMPEL Disk

Use the Media > Files & Folders option to manage media content files on the iCOMPEL disk. 

Note: You cannot create or edit files on the iCOMPEL. Create or edit files elsewhere and upload the result to the
iCOMPEL.
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The File & Folders tab provides these file management features:

List – Displays all the files and folders in the current location.

Navigate – Move between folders (click on a folder name or on a link in the Folder field to open it).

Act – Delete, move, and rename files and folders and also copy files.

Click the button next to a folder to take these actions:

 – Delete the folder

 – Move or rename the folder.

Click the button next to a file to take these actions:

 – Delete the file.

 – Move or rename the file.

 – Copy the file.

Note: You cannot take any folder or file actions in the iCOMPEL system folders.

The Upload Files tab provides the means to bring files onto the iCOMPEL and to create new folders (as described in
Uploading Content Files ). 

Refer to the media-specific information to see which zone player type to enable and for additional notes on the formats
supported by the iCOMPEL:

Video

Text Files

Images and Photos

Audio

Presentations

HTML Web Pages

Adobe Flash

Folder Play

3.2.1 Uploading Content Files

You can upload content files to the iCOMPEL in several ways:

Using the Upload Files Tab  – The iCOMPEL offers an Upload Files tab on the Media > Files & Folders page or
when you open a specific playlist. 

Using FTP .

Using Drag and Drop  – If supported by your browser.

Note: Always add your content files to the Media folder or to sub-folders of the Media folder.
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Using the Upload Files Tab

You use both the Files & Folders and playlist Upload Files tabs in the same way: 

1. Navigate to the folder where you want to add the file.

2. Click the Upload Files tab.

3. If required, create a sub-folder:

a. Type a name for the sub-folder in the Folder name field.

b. Click the  button.

c. Click the sub-folder name to enter it.

d. Click the Upload Files tab.

4. Click the  button and navigate to the file you want to upload.

5. Click the  button.

6. Repeat those steps for each file.

Using FTP

Before using FTP, make a note of the IP address of your iCOMPEL. If you do not know the IP address, consult the person
who administers your network or reboot the iCOMPEL: it displays its IP address during the process.

Note: You need to have the FTP Read/Write permission on the iCOMPEL to upload using FTP. FTP may also be
disabled on your network for security reasons. If you have difficulty using FTP, check with the person who administers
your iCOMPEL or network.

You can upload using a dedicated FTP program. A quick alternative is to use Windows Explorer (or similar file-management
program):

1. Open two copies of Windows Explorer.

2. In the first copy, navigate to the folder with the content you want to upload.

3. In the second copy, type ftp:// and the IP address of your iCOMPEL in the address bar (for example, ftp://192.168.0.254)
and press the Enter key.

4. When prompted, enter your iCOMPEL username and password. Windows Explorer now displays your default iCOMPEL
folder location.

5. Navigate to the Media folder. Do not add or modify files in any other folder as this may render the iCOMPEL unusable.

6. As required, create further folders under the Media folder. It is good practice to create separate folders for each layout
and sub-folders for each zone (for example, media/Layout_reception/Zone_A).

7. To upload content to the iCOMPEL, drag-and-drop or copy-and-paste folders and files from the first copy of Windows
Explorer to the second copy of Windows Explorer. 

Note: If the FTP page does not refresh, press the F5 key or click Refresh to update it. 

When you have connected Windows Explorer to your iCOMPEL with FTP, you can also:

Rename and delete files on the iCOMPEL.
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Download files from the iCOMPEL to your PC using drag-and-drop or copy-and-paste.

You cannot move files from one folder to another using FTP. Instead, download the file to your PC and then upload it to the
other iCOMPEL folder. Alternatively, move files using the Media > Files & Folders page. 

Using Drag and Drop:

Some browsers allow you to drag files off of your PC desktop and drop them directly into a playlist or a folder on the
iCOMPEL. Neither Internet Explorer nor Opera provide drag and drop, but the following browsers do:

Operating System Browser and Minimum Version

Windows Mozilla Firefox 6.0.2, Google Chrome 14

Mac OS X Mozilla Firefox 3.6.19, Google Chrome 14, Apple Safari 5.0.6

Linux Mozilla Firefox 6.0.2

Note these limitations of drag and drop:

You cannot upload folders, only individual or groups of files.

If you upload a file to a place containing a file with the same name, the iCOMPEL overwrites the existing file.

If the file is for a media type not enabled for the zone, you can upload the file but it will not appear in the playlist until you
enable its media type.

You can drag and drop a file into these locations using the method indicated:

Playlist – Hover over the preferred position.

Folder within a playlist – Hover over the folder.

Folder – Hover over the preferred location.

Folder within a folder – Hover over the folder. 

To perform an upload using drag and drop, follow these steps:

1. Open the page on the iCOMPEL that is the location for the upload (either a playlist or a folder).

2. On your PC desktop, select the file or files you want to upload.

3. Hold down the left mouse button.

4. Move your mouse until the cursor is over the upload location.

5. Release the mouse button. A progress bar tracks the upload (you might not see this for small files).

3.2.2 Video

You can play various video formats with the iCOMPEL.

Zone player type to enable: Movie.

Note: For best performance, only enable one movie zone per layout on less powerful iCOMPEL models.

Playlist tab containing the item: Files & Folders.
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Additional notes:

Supported Formats Notes

MPEG-1 Good performance but poor resolution.

MPEG-2 Recommended. Best combination of performance and resolution but large
file size. 

MPEG-2 is the recommended format as it requires less decoding by the
processor. Where possible, convert other formats to MPEG-2 before upload.

MPEG-4 Small file size but high processing load. May slow down some models. 

AVI Best image quality but extremely high processing load. May overload some
models. 

QuickTime (MOV) Apple Macintosh format. Can have very high processing load. May overload
some models.

VOB Same as MPEG-2. 

3.2.3 Text Files

You can display text files on the iCOMPEL. (You can also display text you enter directly: see Text  for more details.)

Zone player type to enable: Text.

Playlist tab containing the item: Files & Folders.

Additional notes:

Supported Format Notes

TXT Plain text only. The iCOMPEL does not support the display of files formatted
by word-processor (for example, DOC or DOCX files from Microsoft Word or
PDF files from Adobe Acrobat). 

3.2.4 Images and Photos

You can display several image formats with the iCOMPEL.

Zone player type to enable: Image.

Note: Large images may take several seconds to appear and may slow down the performance of the iCOMPEL.
Always resize an image to match the size of the zone before uploading it.

Playlist tab containing the item: Files & Folders.
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Additional notes:

Supported Formats Notes

PNG Recommended. Good quality and supports transparency.

JPG Recommended. Edges can blur and does not look good when shown on a
large screen.

GIF Can look very grainy. Only supports 256 colors but does support
transparency.

The iCOMPEL does not support animated GIFs. To use an animated GIF,
first embed it into an HTML page.

BMP Large file size but no loss of quality. 

3.2.5 Audio

You can play various audio formats with the iCOMPEL.

You add audio files to a whole layout and not to an individual zone. Layout property to enable: Soundtrack.

Playlist tab containing the item: Files & Folders.

Additional notes:

Supported Formats Notes

MP3 Recommended. Good performance. 

WAV Similar quality to MP3 but much larger file sizes.

WMA Performs acceptably on the iCOMPEL.

3.2.6 Presentations

Presentations often have complex animations, timings, and graphics. To ensure the iCOMPEL displays a presentation
correctly, save it in the best format to ensure faithful reproduction.

Zone player type to enable:

If saved as video – Movie.

If saved as Adobe Flash – HTML.

If saved as image slide show – Image.

Playlist tab containing the item: Files & Folders.

Additional notes:
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Supported Formats Notes

Microsoft Office
PowerPoint 2010 (PPT,
PPTX)

Save as WMV video – Best option for high quality and complex animations
and transitions but files can be large.

Save as Adobe Flash – Supports animations and transitions but complex
and fast animation may appear choppy. Creates small files.

Save as image slide show – Use if animations and transitions are not
important.

Apple Keynote Save as MOV video – Best option for high quality and complex animations
and transitions but files can be large.

Save as a Video:

To save a PowerPoint 2010 presentation as a video:

1. Select File > Save & Send > Create a Video.

2. Select the Computer & HD displays profile as this is likely to be the best for the iCOMPEL.

3. When prompted, choose where to save the video. 

There are also third-party products specifically for converting PowerPoint 2010 presentations to video. Other products are
more general screen capture applications, which can be useful if you want to include mouse movement or provide a voice-
over. 

Save as Adobe Flash:

There are third-party products for converting PowerPoint 2010 presentations to an Adobe Flash animation with varying
degrees of complexity. For example, you can use the free OpenOffice suite to open a PowerPoint 2010 presentation and
export it to an Adobe Flash file but without slide transitions or animations. 

Save as Image Slide Show:

To save a PowerPoint 2010 presentation as an image slide show:

1. Select File > Save & Send > Change file type.

2. Choose a supported image file type (PNG is recommended, but the iCOMPEL also supports JPG, TIF, and BMP).

3. When prompted, choose where to save the files and select Every Slide.

3.2.7 HTML Web Pages

You can display local HTML files on the iCOMPEL. (You can also display whole or part pages from a remote web site: see 
External Web Pages  for details.)

Zone player type to enable: HTML.

Playlist tab containing the item: Files & Folders.

Additional notes:

50
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Supported Format Notes

HTML The iCOMPEL displays HTML using the WebKit browser engine for Linux.
(The Apple Safari and Google Chrome browsers also use the WebKit
engine.)

WebKit supports web pages including JavaScript and Adobe Flash but not
ActiveX.

3.2.8 Adobe Flash

You can display Adobe Flash files with the iCOMPEL. 

Note: Complex Adobe Flash files may not run smoothly on less powerful iCOMPEL models 

Zone player type to enable: HTML.

Playlist tab containing the item: Files & Folders.

Additional notes:

Supported Format Notes

SWF The iCOMPEL supports Adobe Flash Player version 11.

Flash files give no indication to the iCOMPEL that they are finished. You
need to set a maximum duration when you add the file to a playlist to
force the iCOMPEL to move on to the next item.

3.2.9 Folder Play

Rather than adding a number of files individually to a playlist, you can add and play an entire folder from the iCOMPEL disk.
This is known as Folder Play. You can add or delete files even while the iCOMPEL is playing the folder.

Zone player type to enable: as required by the media types in the files.

Playlist tab containing the item: Files & Folders.

You can configure folder play properties to control how the iCOMPEL plays the files:

In sequence – Files play in file name order. Numbers come before letters and uppercase characters before lowercase (for
example, '1' comes before 'A' which comes before 'a').

In random order – Files play in a random order (shuffle play).

Coupled with the order of play, you can also configure these properties:

How many of the files to play.

The number of files to jump before playing the next file.
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3.3 Media from External Sources

You can display media running directly from external sources with the iCOMPEL. 

Refer to the media-specific Information to see which zone player type to enable and for additional notes on the formats
supported:

TV

Radio

Live Video

Multicast Video

External Web Pages

3.3.1 TV

You can play output from external digital and analog TV stations with the iCOMPEL.

Zone player type to enable: Movie.

Playlist tab containing the item: Specials.

Additional notes:

Supported Formats Notes

Digital TV Broadcast  digital TV, where available. ATSC digital cable and over-the-air,
where available.

Analog TV Broadcast TV, where available.

Your iCOMPEL must be set up with:

TV antenna connected to its TV socket. 

TV tuner card tuned to the digital transmitter. 

Analog TV station name and number pairs.

See TV & Radio  for more details of tuning and setting up digital and analog TV.

3.3.2 Radio

You can play output from external digital radio stations with the iCOMPEL.

You add audio to a whole layout and not to an individual zone. Layout property to enable: Soundtrack.

Playlist tab containing the item: Specials.

Additional notes:
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Supported Format Notes

Digital radio Digital radio stations, where available. 

Your iCOMPEL must be set up with:

A TV antenna connected to its TV socket.

A tuner card for tuning in to the stations (see TV & Radio  for more details).

3.3.3 Live Video

You can output live video from various devices with the iCOMPEL.

Zone player type to enable: Movie. 

Playlist tab containing the item: Specials.

Additional notes:

Supported Formats Notes

S-Video 
Composite video

Includes output from video cameras, DVD players, set-top boxes, and so on.

Your iCOMPEL must be set up with:

A TV tuner card.

Either an S-Video or composite video cable connecting the video device to
the TV tuner card. 

Before you can add live video in to a playlist you need to configure your TV Tuner  to recognize the video source as a TV
input.

3.3.4 Multicast Video

As an alternative to receiving TV broadcasts directly, your iCOMPEL can receive multicast video (also known as Internet
Protocol Television (IPTV)) over the local network. 

Note: Using multicast video requires an additional feature unlock key.

Zone player type to enable: Movie.

Playlist tab containing the item: Specials.

Additional notes:

Supported Format Notes

MPEG-2 Transport
Stream in UDP

Your set up needs to include:

An Internet Group Management Protocol (IGMP) network infrastructure to
support multicast streaming. 
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Supported Format Notes

A device to stream video onto the network. 

Before you can add live video in to a playlist, you need to configure your TV tuner to recognize the video source as a TV
input. See TV & Radio  for more details.

3.3.5 External Web Pages

You can display whole or parts of pages from an external web site with the iCOMPEL. See Displaying Part of a Movie or
Web Page  for details of how to display only a part of a web page. See HTML Web Pages  for how to display HTML
files held locally on the iCOMPEL.

Zone player type to enable: HTML.

Playlist tab containing the item: Specials.

Additional notes:

Supported Format Notes

HTML The iCOMPEL displays HTML using the WebKit browser engine for Linux.
(The Apple Safari and Google Chrome browsers also use the WebKit
engine.) WebKit supports web pages including JavaScript and Adobe Flash
but not ActiveX.

To display a web page, your iCOMPEL must have live access to it at the time.

If the web page requires a username and password to log in, include
those in the URL in the format: protocol://username:password@site.

Adding External Web Pages to a Playlist:

To add an external web page to a playlist, follow these steps:

1. Open the web page you want to link to and copy its whole URL address. (You can also sometimes use the URL to link
to a specific frame or image to display.)

2. On the iCOMPEL menu bar, click Playlists and select the zone in the layout you want to add the page to. 

3. Select the Specials tab.

4. Paste the web site URL into the External Web Page field.

5. Click the  button.

6. In the playlist, you can drag the  icon to adjust the item's position or click its  button to modify its properties.

Notes: 

HTML pages always have a white, non-transparent background.

Auto-refresh web pages direct the iCOMPEL browser to reload the page at regular intervals. Add auto-refresh pages
to a playlist with an indefinite duration to be sure that they always show the latest information. Determine whether a
page auto-refreshes by searching for the <meta http-equiv=refresh> tag in its HTML code:
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To keep non-auto-refresh pages current, you need to reload them periodically. To do so, add the pages to a playlist
with a fixed duration, as this forces the iCOMPEL to reload the page.

Saving Web Pages to Disk and Adding to a Playlist:

As an alternative to displaying a web page directly from an external source, you can save it on the iCOMPEL. This loses
the connection with the source and your files will not be updated.

To save the HTML files, use your browser's Save function. For example, with Internet Explorer, follow these steps:

1. From the File menu select Save as.

2. Navigate to the location where you want to save the files.

3. From the Save as type drop-down list, select Web page, complete. This saves the page as well as all its associated
files (such as images). Internet Explorer saves the associated files in a folder called pagename_files, where pagename
is the name of the HTML page.

When you have saved the HTML page and its files, add to a playlist by following these steps:

1. Upload the HTML page file and the folder with all its files onto the iCOMPEL as described in Uploading Content Files
.

2. Add to a playlist as described in Adding Media Item Files to a Playlist .

3.4 Media Item Properties

There are different playlist properties for each type of media item. To edit the properties for a playlist item, click the 
button alongside the item. 

The iCOMPEL displays the properties on three tabs:

Media – Location and name of the media. Can also contain ad hoc, touch screen, and item-specific properties (for
example, for clocks, newsfeeds, and folder play).

Style – Properties specific to the media type (this tab is not shown for folder play items).

Advanced – Advanced properties that apply to all media items (position and size, time validity, conditional play, and
media audit). (See Common Advanced Properties  for details.)

The following table lists the generic properties you will find on the Media and Style tabs for each of the zone media
players:

Movie HTML Image Text Soundtrack

Duration O O O O

Deinterlace O

Mode O O

Letterbox Color O O

Subtitles O

Volume O O O
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Movie HTML Image Text Soundtrack

Opacity O O O O

Movie Size O

Web Page Size O

Zoom O

Page Background O

Fade In O

Fade Out O

Text Style O

Font O

Text Color O

Background Color O

Horizontal Alignment O

Vertical Alignment O

Margins O

White Space O

Character Set O

For details of those generic properties, see the information specific to each type of media player:

Movie Properties

HTML Properties

Image Properties

Text Properties

Soundtrack Properties

Some playlist items have properties additional to the generic properties. For details of those item-specific properties, see
the information for each item:

Newsfeed Properties

Clock Properties

Folder Play Properties

Ad Hoc Properties
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3.4.1 Movie Properties

The following properties apply to zones enabled as a Movie player:

Duration Select the duration you require:

Play the movie file indefinitely – The movie plays continuously.

Play movie file for – The movie plays for the period you specify.

Deinterlace The iCOMPEL automatically performs deinterlacing if required. To explicitly enable or disable deinterlacing,
select Yes or No from the drop-down list.

Mode You can set the display mode to one of these options:

Fit to Zone – Stretches the movie to fill the zone. This will distort the movie if the zone does not have the
same aspect ratio as the movie.

Letterbox – Shows the entire movie and preserves its aspect ratio. The iCOMPEL displays the letterbox
color in any space in the zone not covered by the movie.

Crop – Preserves the movie aspect ratio but cuts off its edges if it is larger than the zone.

Letterbox Color If you select Letterbox as the display mode, some space may be left in the zone outside of the movie. Use
this option to select the color the iCOMPEL displays in that space.

Subtitles Check the Display subtitles box to enable subtitles for the video (if available).

Volume Enter the volume as a percentage of the maximum volume.

Opacity To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely
opaque and 1% is almost completely transparent.

Movie Size Choose the option you require:

Use Zone Size – Display whole movie in the zone.

Show Part of Movie – Display only a 'window' view of the movie in the zone:

o Left edge offset – Amount to indent the window relative to the movie's left edge.

o Top edge offset – Amount to indent the window relative to the movie's top edge.

o Movie width – Full width of movie.

o Movie height – Full height of movie.

Note: This is only available if you set the User Interface Policy to Detailed or Expert on the UI Options page.

3.4.2 HTML Properties

The following properties apply to zones enabled as a HTML player:

Duration Select the duration you require:
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Show the web page indefinitely – The iCOMPEL shows the web page always.

Show the web page for – The iCOMPEL shows the web page for the period you specify.

Web Page Size Choose the option you require:

Use Zone Size – Display whole movie in the zone.

Show Part of Web Page – Display only a 'window' view of the movie in the zone:

o Left edge offset – Amount to indent the window relative to the page's left edge.

o Top edge offset – Amount to indent the window relative to the page's top edge.

o Web Page width – Full width of page.

o Web Page height – Full height of page.

Note: This is only available if you set the User Interface Policy to Detailed or Expert on the UI Options page.

Volume Enter the volume as a percentage of the maximum volume.

Opacity To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely
opaque and 1% is almost completely transparent.

Zoom Enables the Zone to zoom in on the HTML content. Smaller than 100% zooms out (to get the whole web page
in a small zone for example) or larger than 100% zoom in, to fill the zone with part of a web page. 

Page Background Check the HTML Page allows transparent backgrounds box to enable a transparent background (for
example, to allow view of a background zone).

Note: Enabling this prevents Adobe Flash playing correctly in the HTML zone.

3.4.3 Image Properties

The following properties apply to zones enabled as an Image player:

Fade In You can set the image to fade in with one of these options:

No Fade in – Image appears immediately without fading in.

Fade In n.n seconds – Image fades in from the background. Specify the number of seconds for the fade-in
to last (default is 1.5 seconds).

Cross fade from previous image – Image fades in as the previous image fades out. You must also
set the previous image's Fade Out option to Cross fade to next image. If no previous image is set
to cross fade, this image fades in from the background in the number of seconds you specify (default
is 1.5 seconds).

Duration Select the duration you require:

Show image indefinitely – The iCOMPEL shows the image always.

Show the image for – The iCOMPEL shows the image for the period you specify.

Fade Out You can set the image to fade out with one of these options:
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No Fade out – Image disappears immediately without fading out.

Fade out in n.n seconds – Image fades out to the background. Specify the number of seconds for the fade-
out to last (default is 1.5 seconds).

Cross fade to next image in n.n seconds – Image fades out as the next image fades in. You must also set
the next image's Fade In option to Cross fade from previous image.If no next image is set to cross fade,
this image fades out to the background in the number of seconds you specify (default is 1.5 seconds).

Mode You can set the display mode to one of these options:

Fit to Zone – Stretches the image to fill the zone. This will distort the image if the zone does not have the
same aspect ratio as the image.

Letterbox – Shows the entire image and preserves its aspect ratio. The iCOMPEL displays the letterbox
color in any space in the zone not covered by the image.

Crop – Preserves the image aspect ratio but cuts off its edges if it is larger than the zone.

Letterbox Color If you select Letterbox as the display mode, some space may be left in the zone outside of the image. Use
this option to select the color the iCOMPEL displays in that space.

Opacity To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely
opaque and 1% is almost completely transparent.

3.4.4 Text Properties

The following properties apply to zones enabled as a Text player:

Text Style Choose the option for how you want the text displayed:

Show text indefinitely – Displays always.

Show text for – Displays for the period you specify.

Text moving from right to left at speed – Scrolls right-to-left at the speed you specify.

Text moving from left to right at speed – Scrolls left-to-right at the speed you specify.

Text moving from bottom to top at speed – Scrolls bottom-to-top at the speed you specify.

Text moving from top to bottom at speed – Scrolls top-to-bottom at the speed you specify.

For best results, set the scrolling speed in multiples of 60 (for example, 60 or 120).

Font Select the font family you want and the size and style to apply.

Text Color If you want text in a different color than the default, click the Pick Color button to select an alternative.

Background Color If you want the background in a different color than the default, click the Pick Color button to select an
alternative.

Horizontal
Alignment

Select the text horizontal position (only enabled for stationary and vertically- scrolling text).
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Vertical
Alignment

Select the text vertical position (only enabled for stationary and horizontally-scrolling text).

Margins Set values to add blank space at each margin (in pixels).

White Space Choose the option for how you want extra spaces, tabs, and new lines handled (collectively termed
'whitespace'):

Display multiple spaces as single space and multiple new lines as single new line – Ignore extra
whitespace (default). 

Display spaces and new lines as entered – Display all whitespace as entered.

Note: This property is for text files only.

Character Set If necessary, select an alternative text-encoding standard.

Note: This property is for text files only.

Opacity To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely
opaque and 1% is almost completely transparent..

3.4.5 Soundtrack Properties

The following properties apply to zones enabled as a Soundtrack player:

Duration Select the duration you require:

Play all of the audio file – The soundtrack plays continuously.

Play audio file for – The soundtrack plays for the period you specify.

Volume Enter the volume as a percentage of the maximum volume.

3.4.6 Newsfeed Properties

The iCOMPEL holds a newsfeed's properties in a number of locations. Access each group of properties by:

Clicking the  button for the newsfeed on the Media > Newsfeeds page (see Newsfeeds  for a description of
those properties).

Clicking the  button for the newsfeed in the playlist. The iCOMPEL displays some properties on the Media tab and
some on the Style tab.

The newsfeed properties on the playlist Media tab are:

Item Type Indicates who can make changes to the set up on this page (click the Save Changes and change Item Type
button to alter this).

Ad Hoc Entry
Label

Enter a reference label for the iCOMPEL to use in the playlist Media column.
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Allowed Choices Select which newsfeeds the ad hoc user can choose:

All Available Newsfeeds – User can choose from any of the newsfeeds you have added to the iCOMPEL.

Only Selected Newsfeeds – User can choose only from the newsfeeds you check. 

Default Newsfeed Select the default newsfeed from the drop-down list.

Fields Select whether to display components of the newsfeed other than the content:

Title – Newsfeed title.

Description – Newsfeed summary description.

Customization
Status

Indicates the newsfeed selection status.

The newsfeed properties on the playlist Style tab are:

Item Selection Choose the properties that specify how you want the iCOMPEL to choose from and sequence the newsfeed
articles:

Play all Items – Play all of the articles.

Play only the first n items – Play just this number of articles.

Play all Items in groups of n items – Jump this number of articles before playing the next article.

Select items sequentially – Play articles in title order. Numbers come before letters and uppercase
characters before lowercase (for example, '1' comes before 'A' which comes before 'a').

Select items at random – Play articles at random (shuffle play).

Item
Synchronization

If you need to synchronize between zones, select the appropriate option for your synchronization strategy:

Slave - track changes to Master – The media shown in this zone is controlled from a master zone. 

Master – This zone controls the media shown in a slave zone.

You may want to show the headline in one zone and the details in another zone: see Synchronizing
Playlist Displays Between Zones  for how to keep the displays aligned.

Text Style Choose the option for how you want the text displayed:

Show text indefinitely – Displays always.

Show text for – Displays for the period you specify.

Text moving from right to left at speed – Scrolls right-to-left at the speed you specify.

Text moving from left to right at speed – Scrolls left-to-right at the speed you specify.

Text moving from bottom to top at speed – Scrolls bottom-to-top at the speed you specify.

Text moving from top to bottom at speed – Scrolls top-to-bottom at the speed you specify.

For best results, set the scrolling speed in multiples of 60 (for example, 60 or 120).
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Font Select the font family you want and the size and style to apply.

Text Color If you want text in a different color than the default, click the Pick Color button to select an alternative.

Background Color If you want the background in a different color than the default, click the Pick Color button to select an
alternative.

Horizontal
Alignment

Select the text horizontal position (only enabled for stationary and vertically- scrolling text).

Vertical
Alignment

Select the text vertical position (only enabled for stationary and horizontally-scrolling text).

Margins Set values to add blank space at each margin (in pixels).

Opacity To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely
opaque and 1% is almost completely transparent..

3.4.7 Clock Properties

The iCOMPEL holds a clock's properties in the playlist's Media and Style tabs.

The clock properties on the Media tab are:

Display Content Select the overall date and time format.

Day of Week
Format

Select the positioning and format of the day.

Date Format Select the sequence of date components.

Year Format Select a 2 or 4 digit year display.

Month Format Select a month name or number display.

Time Format Select whether to use the time format for the locale (defined on the Setup > Player > International page) or
the one you specify here. 

Hour Format Select whether to use 12 hour or 24 hour clock.

Time Zone Select the required time zone from the drop-down list.

The clock properties on the Style tab are:

Duration Select the duration you require:

Show Clock indefinitely – The iCOMPEL displays the clock all the time.

Show Clock for – The iCOMPEL displays the clock for the period you specify

Font Select the font family you want and the size and style to apply.
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Text Color If you want text in a different color than the default, click the Pick Color button to select an alternative.

Background Color If you want the background in a different color than the default, click the Pick Color button to select an
alternative.

Horizontal
Alignment

Select the clock's horizontal position.

Vertical
Alignment

Select the clock's vertical position.

Margins Set values to add blank space at each margin (in pixels).

Opacity To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely
opaque and 1% is almost completely transparent.

3.4.8 Folder Play Properties

The iCOMPEL displays folder play properties on the Media tab. Besides the folder play properties, this contains properties
for all of the player types enabled for the zone.

You can customize how long the iCOMPEL plays movie, HTML, and SWF (Adobe Flash) files. Specify the length of play by
adding the string -duration-x just before the file extension (where x is the duration in seconds). For example, the

iCOMPEL would play the file logo-intro-duration-17.swf for 17 seconds. This customization has no effect if you add
the file into a playlist individually.

The following specific properties apply to folders in a playlist:

Media Check the box to enable the relevant media player for the zone. 

Management Check the Management box to enable ad hoc management of this folder. 

If the ad hoc user places files in the indicated ad hoc media folder, the iCOMPEL plays them instead of those
in the current folder. If there are no suitable files in the ad hoc media folder, the iCOMPEL plays the files in the
current folder.

If this iCOMPEL is a subscriber, a channel update does not remove the ad hoc files. This means that even a
subscriber iCOMPEL can use local content.

Item Selection Choose the properties that specify how you want the iCOMPEL to choose from and sequence the files:

Play all Items – Play all of the files.

Play only the first n items – Play just this number of files.

Play all Items in groups of n items – Jump this number of files before playing the next file.

Select items sequentially – Play files in file name order. Numbers come before letters and uppercase
characters before lowercase (for example, '1' comes before 'A' which comes before 'a').

Select items at random – Play files at random (shuffle play).

Item If you need to synchronize between zones, select the appropriate option for your synchronization strategy:



Copyright © 2010-2013 Black Box Network Services. All Rights Reserved.724-746-5500   |   blackbox.com 60

iCOMPEL Digital Signage User Guide (V9.2.3)

Synchronization Slave - track changes to Master – The media shown in this zone is controlled from a master zone. 

Master – This zone controls the media shown in a slave zone.

See Synchronizing Player Displays Between Zones  for more details.

You can combine folder play properties to create complex sequences to meet specific requirements. For example, you may
wish to set up a playlist that showed a sequence of music videos in a fixed order, and between each video show two
randomly selected advertisements followed by a corporate logo for a fixed time.

To create this sequence of folders, follow these steps:

1. Create three folders on the iCOMPEL as follows: 

Music

Advertisements

Logo

2. Upload videos into the Music folder. Rename the video files as necessary to create the play order you want (for example,
'A Summer in the city.mpg, B Be my girl.mpg', and so on). 

3. Upload the advertisements into the Advertisements folder. 

4. Upload the logo into the Logo folder.

5. Create a playlist as follows: 

Add the Music folder to the playlist, limit 1. 

Add the Advertisements folder to the playlist with memory, limit 2. 

Add the logo image as an individual file, duration 10 seconds. 

3.4.9 Common Advanced Properties

All media items have in common the set of properties present on the Advanced tab.

Other than the Media Audit property, the iCOMPEL only displays the Advanced properties if:

You have set the User Interface Policy to Detailed or Expert on the UI Options page.

You have previously enabled the property.

The following properties apply to any zone:

Position and Size To override the position and size of a zone, select the Use custom position and size radio button and set the
values you require:

Top edge offset – Amount to move the zone relative to the screen's top edge.

Left edge offset – Amount to move the zone relative to the screen's left edge

Width – Width for the zone.

Height – Height for the zone.

This property is not applicable to soundtrack items.
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Time Validity To control when the iCOMPEL shows an item in a playlist, check the relevant boxes and set the times you
require:

Date Range – Select the dates during which you want these settings to apply (for a single day, set both
dates the same).

Days – Select the days you want the item to appear.

Time Period – Select the period during which you want the item to appear.

Examples when you might choose to use this property:

To play adverts only on certain days of the week.

To show a traffic report only after 5.00 pm. 

Points to note:

Outside the times you specify, the iCOMPEL skips the item when its turn comes in the playlist. 

The iCOMPEL continues to play the item even if the valid time expires before the item ends. 

These settings do not prevent you auditioning a single media item or zone.

These settings will apply if you audition the whole layout.

Conditional Play This is only enabled when you have added player local information to the iCOMPEL (see Player Local
Information  for details).

If it is enabled, you have two options:

Play Always – Default. The iCOMPEL always plays the schedule.

Play if Player Local Information Item – The iCOMPEL only plays the schedule if certain conditions are met.

If you select Play if Player Local Information Item, complete these steps:

1.Select the name of the relevant player local information from the first drop-down list.

2.Select the test to apply from the second drop-down list.

3.Enter the value to test for in the final field (add further values by clicking the  button or delete values

by clicking the  button).

4.Click the .button to apply the setting.

Media Audit To change whether the iCOMPEL collects media audit data to send in its reports, check the relevant radio
button:

Inherit the zone's media audit setting – The iCOMPEL collects or does not collect the data depending on
the setting in the zone's properties. 

Disable media auditing – Disables data collection even if it is enabled in the zone's properties.

Enable media auditing – Enables data collection even if it is not enabled in the zone's properties.
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3.4.10 Ad Hoc Properties

The iCOMPEL displays ad hoc properties on the Media tab.

You can apply the following properties to directly entered text, newsfeeds, radio, TV, and tables that you have set to be
customizable or ad hoc:

Item Type Click the  button to save any existing changes to the item and to open the
page to select the item's type:

Content of this item is controlled by the Layout Designer

Content of this item can be customized using this Layout's Ad hoc Entry Page

There are no existing Shared Ad hoc Items of this type

Create and use a new Ad hoc Item.

Ad hoc Entry
Label

The label used to refer to this item on the layout's Ad hoc Page

Ad hoc Item
Name

Unique identifier for the ad hoc Item on the iCOMPEL. (Only for ad hoc items that you cannot customize.)

Properties
dependent on
media type. 

The iCOMPEL displays some properties that are dependent on the type of ad hoc item:

Directly entered text:

o Ad Hoc Input – Options to format the text and specify allowable ad hoc user input.

o Default Text – Enter default text to display.

o Customization Scope – Either Local (customized text displays only on the ad hoc user's local iCOMPEL)
or Remote (customized text displays on players that are subscribers to the ad hoc user's publisher
iCOMPEL).

Newsfeed:

o Allowed Choices – Whether you allow the ad hoc user to select all or a subset of the available
newsfeeds on the iCOMPEL.

o Default Newsfeed – Select the default newsfeed to display.

o Fields – Whether to display newsfeed with or without title or description.

TV and radio:

o Allowed Choices – Whether you allow the ad hoc user to select all or a subset of the available stations
on the iCOMPEL.

o Default Station – Select the default station to play.

o Subtitles – Whether or not to display subtitles (if available).

Tables:

o Table – Name link to the Ad Hoc tab of the Media > Tables page for configuring the table.
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Customization
Status

Indicates if this item is currently displaying its default value or if it has been overridden by an ad hoc User.

Used By Layouts Lists the layouts that use this ad hoc Item. (Only for ad hoc items that you cannot customize.)

3.5 Playlist Commands

You can use the following playlist features to alter the display sequence and appearance:

Rendezvous Points and the Advance To Command

Change Layout Command

3.5.1 Rendezvous Points and the Advance To Command

Each playlist displays a sequence of items that operate independently. Even if two playlists contain items of exactly equal
lengths, you cannot rely on their display being completely synchronized. Instead, if you want to achieve synchronization
between playlists, you need to use a combination of Advance To commands and Rendezvous Points. 

An Advance To command in a playlist causes the iCOMPEL to start displaying an item in another playlist. You specify
the item to display by placing a matching rendezvous point at an appropriate place in the other playlist. If the receiving
zone's playlist contains the rendezvous point, the iCOMPEL immediately starts playing the playlist item after the
rendezvous point.

To link the two together, the Advance To command refers to the rendezvous point by name. You can select whether the
iCOMPEL passes the Advance To command to a single zone or to all zones in the current layout. Therefore, by placing
the same rendezvous point in several zones, you can trigger actions in all of them with a single Advance To command.

You can also use the Advance To mechanism to initiate iCOMPEL actions as a result of user interactions, such as
motion sensor, pressure mat, or touch screen events (see Using Interactivity  for more details).

To add a rendezvous point to a playlist, follow these steps:

1. Click the Specials tab.

2. In the Rendezvous Point field, enter a name. You can enter any text for the name (but not starting with the string auto_
) and names are not case-sensitive.

3. Click the  button.

4. Make sure the rendezvous point appears immediately before the item you want the iCOMPEL to synchronize with the
other playlist.

5. If required, repeat to create additional rendezvous points in other playlists.

6. Add the Advance To command.

To add an Advance To command to a playlist, follow these steps:

1. Click the Specials tab.

2. From the Advance To Rendezvous Point drop-down list, select the relevant rendezvous point name.

3. Click the  button.
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4. Make sure the Advance To command appears immediately before the item you want the iCOMPEL to synchronize with
the other playlist.

5. If you want the Advance To command to target only a specific zone:

a. Click the  button.

b. Select the zone from the In drop-down list.

c. Click the  button.

Note: If you want to change the Advance To command to point to a different rendezvous point or to different zones,

click the  button and alter your selection.

3.5.2 Change Layout Command

Unlike the Advance To command, the Change Layout command launches a different screen layout with its own
arrangement of zones. 

If you want to implement a simple change of the layout, then the Advance To command brings a quick result. However, it
is difficult to implement a complex change using the Advance To command. The Change Layout command displays a
different layout entirely, but it does take longer to refresh the screen. 

To add a Change Layout command to a playlist, follow these steps:

1. Click the Specials tab.

2. From the Change Layout drop-down list, select the new layout you want to use.

3. Click the  button.

4. Make sure the Change Layout command appears in the right place in the playlist.

Note: If you want to change the Change Layout command to point to a different layout, click Edit.and alter your
selection.

3.6 Colors

Use the Media > Colors page to set the colors the iCOMPEL applies to fonts, backgrounds, and other items.

When you create a new layout or a new table, the iCOMPEL automatically creates new color items:

For layouts, the color items are for the text foreground, the text background, and the letterbox background.

For tables, the color items are for the text foreground and text background.

The iCOMPEL names color items in the format Layout name: Color item. For example, if you create a new layout named
'Holidays', the iCOMPEL creates the following color items for it:

Text foreground – Holidays: Text

Text background – Holidays: Background

Letterbox – Holidays: Letterbox

You can modify the properties for these color items as needed.
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You define a Color Item by a unique name, a color value, and an opacity setting. If you change the color value or opacity

setting, the iCOMPEL updates all the items that use the color. Click the  button to apply your
changes. You can define more than one color item with the same color values.

Click the tab for the option you require:

Colors – Listing the color items and their characteristics. Click the  button to delete a color (you cannot delete it if it

is in use). Click the  button to:

o Modify a color – The settings are as described for the Add Color tab. Click the  button to enable your

modifications.

o Access the Used By tab – Lists which layouts are using the color.

Add Color – Adding a new color manually.

To add a new color, complete the following information and click the  button:

Name Enter a unique and meaningful name for the color. This does not have to be in Layout name: Color item
format followed by the iCOMPEL. 

Color Value Specify the color using either separate RGB values or a single hexadecimal value. On a Windows PC, you can
find the RGB values for a color you want to use by following these steps:

1.Click Start and select All Programs > Accessories > Paint.

2.Open a file containing an image that uses the target color.

3.Use the Color Picker tool  to select a pixel of the target color.

4.Click the Edit Colors tool .

5.Read off the RGB values at the bottom right of the Edit Colors display.

Opacity To allow background items to be visible, enter a percentage to match the opacity required. 100% is completely
opaque and 1% is almost completely transparent.

3.7 Fonts

The iCOMPEL offers a collection of standard fonts that are suitable for most purposes. 

To view the installed fonts:

1. On the menu bar, click Media and Fonts.

2. Click the Font Families tab.

The Font Families tab shows details of all the fonts available on the iCOMPEL (including those you install). The Font Files
tab lists the files for any fonts you install.

If you want to use a font that is not available on the iCOMPEL, you must add your own font files. The iCOMPEL supports
TrueType (TTF or TTC) and OpenType (OTF) format font files. If your iCOMPEL is a publisher, you must also install that
additional font on every subscriber iCOMPEL.
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To add a font file, follow these steps:

1. On the menu bar, select Media and Fonts. 

2. Click the Add Fonts tab.

3. Click the  button and navigate to the font file you wish to add.

4. Click the  button.

5. Click the  button.

6. After you add a font file, you must restart the iCOMPEL. 

7. To preview a font, click the  button. This interrupts the current layout display and shows a test message on the
screen. You can change the test message using the Font Options tab.
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4. Enhancing Your displays

You can enhance your digital sign display in various ways:

Synchronizing Playlist Displays Between Zones

Using Interactivity

Using the RS-232 Interface Port

Displaying Part of a Movie or Web Page

Mitigating Plasma Screen Burn

Changing the Screen Background

4.1 Synchronizing Playlist Displays Between Zones

You can synchronize the display between playlists in useful and sophisticated ways using rendezvous points and Advance
To commands.

Examples include:

Displaying video or images in one zone and related text captions in another zone (for a method to achieve this, see
Automatic Captioning ).

Displaying a selection of videos or images in response to ad hoc user input (for a method to achieve this, see Displaying
Video-on-Demand Using a Sub-Playlist ).

You can achieve further complex and powerful results with other of the rendezvous point and Advance To command
mechanisms: 

An Advance To command executed in any currently playing playlist (including in the same playlist).

An Advance To command delivered over the iCOMPEL player's Ethernet port in the form of an XML message posted to
the HTML TCP port. 

An Advance To command in a schedule entry or in an ad hoc page.

A change in binary input lines on the RS-232 port initiating an Advance To command.

An event on an attached touch-sensitive screen initiating an Advance To command.

4.1.1 Automatic Captioning

To implement synchronization between zones, you need to designate one playlist as the Master Playlist and one or more
other playlists as Slave Playlists. You add rendezvous points to each slave playlist and the identically named Advance
To command in the master playlist. When the master playlist reaches the Advance To command, the iCOMPEL forces
the slave playlists to start playing the first item after the rendezvous point.

To have the iCOMPEL perform automatic captioning, you have to use files with corresponding file names. For example, to
display captioning for a video file called Marketing_Highlights_01.mpg, you would need to create a file called
Marketing_Highlights_01.txt containing the text captions.
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To set up automatic captioning between the zone playing the video and the zone playing the captions, first set up the video
zone:

1. Upload all the videos into one folder on the iCOMPEL.

2. Open the video zone's playlist page.

3. Click the Files & Folders tab and navigate to the video folder location.

4. Click the folder's  button.

5. Click the Playlist tab.

6. Click the folder's  button.

7. From the Item Synchronization drop-down list, select Master.

8. In Movie properties, select the Duration option Play the Movie File Indefinitely.

9. Click the  button.

Second, set up the captioning zone:

1. Upload all of the text files into one folder on the iCOMPEL. (This can be the same folder that contains the videos.)

2. Open the captioning zone's playlist page.

3. Click the Files & Folders tab and navigate to the text folder location.

4. Click the folder's  button.

5. Click the Playlist tab.

6. Click the folder's  button.

7. From the Item Synchronization drop-down list, select Slave - Track Changes to Master.

8. In Text properties, select the Text Style option to Show Text File Indefinitely.

9. Click the  button.

4.1.2 Displaying Video-On-Demand Using a Sub-Playlist

You can use the Ad hoc mechanism  to configure the iCOMPEL to show videos on-demand (in response to a button-
click) by using a series of Advance To commands. The same mechanism can also be used to set up images or any other
media type to be displayed on-demand. You do this using sub-playlists.

You can create a loop, or sub-playlist, by inserting both a rendezvous point at the beginning of a sequence of items and an
Advance To command at the end of the sequence in the same playlist. This means that the iCOMPEL displays the items
in the sequence in a continuous loop until another Advance To command breaks out of the loop. 
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To illustrate that mechanism, here is a sequence of items in a playlist:

Rendezvous Point: Start

Default Movie item

Advance To: Start

Rendezvous Point: Option1

Option1 Movie Item

Advance To: Start

Rendezvous Point: Option2

Option2 Movie item

Advance To: Start

That playlist sequence might run like this:

1. The iCOMPEL plays Default Movie item in a continuous loop created by the Advance To command and rendezvous
point Start.

2. An Advance To command Option1 arrives from an ad hoc page.

3. The iCOMPEL starts playing the item after rendezvous point Option1 and this is Option1 Movie Item.

4. At the end of Option1 Movie item, the iCOMPEL processes the Advance To command Start.

5. The iCOMPEL therefore returns to rendezvous point Start and plays the Default Movie Item again in a continuous loop.

To create a sub-playlist loop, follow these steps:

1. Click on a zone to edit its playlist.

2. Click on the Specials tab. 

3. Type the name of the loop into the Rendezvous Point text box (use as descriptive a name as possible).

4. Click the  button to add the rendezvous point to the playlist. 

5. Add the items that must appear in the sub-playlist in the usual manner. If you want a sub-playlist to play just once, insert
an image at the end with an indefinite duration. 

6. In the Specials tab, select the rendezvous point by name from the Advance To Rendezvous Point list and click the

 button. 

7. Make the layout live by adding to a schedule and clicking the  button. 

You are now able to switch between playlists by adding Advance To commands to an ad hoc page:

1. Select Media > Manage Ad hoc items, and click the Add Item tab.

2. Select the Advance To type, enter a name, and click the  button. Repeat to add an Advance To command for
each rendezvous point.

3. Select Media > Design Pages > Manage Ad hoc pages, and click the Add Pages tab.

4. Create a new page with a name such as 'Movie control'.

5. Click the  button and add the ad hoc items for each rendezvous point to the ad hoc page.

6. In the Properties tab, select the users who are allowed to call the commands. 
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7. Click the  button.

4.2 Using Interactivity

You can configure the iCOMPEL to respond to inputs from an external source. External inputs are known as Events and
they may be caused by:

Someone pressing or releasing a defined area on a USB touch screen.

Someone passing a detector or stepping on a pressure mat that generates a general purpose input/output (GPIO) signal
(received through the iCOMPEL unit's RS-232 port).

Someone pressing a button on a remote keypad (infra-red controller).

The way you configure the iCOMPEL to respond may include:

Executing a Change Layout command.

Executing an Advance To command.

Those responses are known as Actions and you can configure the iCOMPEL to take them immediately or after a timeout.
Together, the combination of an event and an action is known as an Interaction.

For all events (or timeouts), you can have the iCOMPEL take one of these actions:

Change to a specified layout.

Advance to a rendezvous point. 

Ignore the event for this zone or layout and pass it to another zone or layout.

Additionally, for touch and GPIO events, you can have the iCOMPEL take one of these actions:

Touch and GPIO events – Take no action.

Touch event – Pass to a web page. If the zone supports HTML, the iCOMPEL can pass a touch event to the currently
showing web page. If there is no web page, the iCOMPEL takes no action.

Playlist and Layout Interaction:

To provide detailed control, you can specify behavior that differs at the playlist and at the layout level:

Playlist:

o Process the interaction if someone touches the currently playing item.

o Keep the interaction process active awaiting other events. You can implement complex behavior by defining multiple

interaction actions in the same playlist.

Layout:

o Process the interaction if there is no playlist action (that is, the layout action is a default).

o Process the interaction if someone touches anywhere on the screen.

You will find it easier to review layout interaction behavior because the iCOMPEL displays all layout components at once.

To configure touch actions for a playlist, you must either:
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Include an On Touch Advance To command in the playlist. 

Include an On Touch Change Layout command in the playlist. 

Play an HTML page in the zone. 

To add items, click on the playlist's Specials tab and select those required. You can include more than one On Touch
Advance To or On Touch Change Layout commands in the playlist. Each On Touch command overrides the previous
one. This allows you to have the iCOMPEL change its response to touch events throughout the playlist.

If you enable touch for a zone that is displaying an HTML page, the iCOMPEL passes touch events to the HTML player for
handling. You can use this to allow a user to navigate through web pages using links embedded in the displayed HTML
page. 

Note: To use HTML navigation, either omit On Touch playlist items or use Interact Clear (found on the playlist's
Special tab) to deactivate existing On Touch items. Otherwise, On Touch items will take precedence over the HTML
player. Then, the iCOMPEL only passes Left Mouse Button Up and Down events to the HTML player. 

To configure touch actions for a layout, on the menu bar click Layouts and select the layout you want to configure. Click
the Interaction tab and select the touch screen actions in response to a touch screen event. The settings include:

Whether a touch response is required for this layout at the layout level or not.

Whether the touch response is a Change Layout or Advance To command.

Whether it is the touch or release operation that causes the action. 

The period after which the layout will revert to another layout in the absence of a touch event.

Interaction Processing:

The way the iCOMPEL processes an event depends upon:

The source (touch screen, GPIO, or remote keypad).

The currently active interactions.

The iCOMPEL processes interactions for touch screen events as follows:

1. Creates a list of zones showing items directly underneath the touched screen location.

2. Processes that list in depth order, starting with the top zone.

3. If a zone has an active touch action, and that is not to pass the event to another zone, the iCOMPEL performs the
specified action and stops processing.

4. If no zone has an active touch action, the iCOMPEL performs the touch action defined for the layout.

The iCOMPEL processes interactions for RS-232 input events as follows:

1. Creates a list of all zones showing items coincident to the RS-232 input.

2. Processes that list in depth order, starting with the top zone.

3. If a zone has an active RS-232 input action, and that is not to pass the event to another zone, the iCOMPEL performs
the specified action and stops processing.

4. If no zone has an active RS-232 input action, the iCOMPEL performs the RS-232 action defined for the layout.

The iCOMPEL processes a remote keypad button event as follows:
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1. Creates a list of all zones showing items coincident to the remote keypad button event.

2. Processes that list in depth order, starting with the top zone.

3. If a zone has an active remote keypad button action, and that is not to pass the event to another zone, the iCOMPEL
performs the specified action and stops processing.

4. If no zone has an active remote keypad button action, the iCOMPEL performs the remote keypad action defined for the
layout.

Passing Touch Events to HTML Pages:

If the current zone supports HTML, the iCOMPEL can pass touch events directly to the currently showing HTML page.
Using this technique, you can build rich interactive applications using stored HTML content. However, you cannot create
interactions with external web sites.

When developing such HTML applications, you will likely require a large number of files. In order for the iCOMPEL to keep
track of these files during channel publishing and layout package creation, follow these rules:

Initiate the application from a single HTML file (you can redirect from here to other files as required). Add that file to the
playlist.

Place all additional files in a single subdirectory named [pagename]_files, where [pagename] is the name of the
initiating HTML file (without its extension). Locate that subdirectory in the directory containing the initiating HTML file.

4.2.1 Designing Interactive Layouts

You can design layouts that respond to user input in various ways:

Send an Advance To command to play a specific item or start a playlist.

Change the current layout.

Change the size and position of a zone.

Display hidden zones.

Send a signal to another device using the RS-232 port.

You might find the following general guidance helpful when developing interactive layouts.

Develop a Storyboard:

Advance planning is particularly important when designing a layout that smoothly offers choices and options to users. A
storyboard is a plan based on a series of sketches of individual scenes. Storyboarding is very effective technique when
designing interaction sequences. You can create a storyboard with sketches of screen layouts or simply with a flowchart.
The important point is to detail all possible outcomes at each stage of interaction.

Provide Material for Optional Actions:

You must make sure that you have collected and uploaded all the media files you require for any possible scenarios
controlled by interaction events. Before you start implementing your interaction events, create playlists for zones that
include all the necessary Advance To commands and rendezvous points.

Trade-Offs Between Display Change Methods:

You can change the display in response to an interaction either by changing the size and show/hide properties of a zone or
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by using a Change Layout command. Each method has advantages and disadvantages:

Method Advantages Disadvantages

Change zone size and show/hide properties Very fast transition Continues using existing media players

Use Change Layout command Resets all media players Slower, visible transition

4.2.2 General Purpose Input/Output

The iCOMPEL can respond to changes in voltages generated by a GPIO device such as a motion sensor or a pressure
mat. The iCOMPEL receives those inputs through its RS-232 port. It can also send output signals. For more details see
the RS-232 Technical Reference .

Control Line Inputs:

The iCOMPEL RS-232 port has four input lines that can receive binary events such as contact closure or signals from other
devices. The available lines are: 

Clear To Send (CTS).

Data Carrier Detect (DCD).

Data Set Ready (DSR).

Ring Indicator (RI).

The lines do not affect the operation of the RS-232 Send and Receive strings. 

Include an RS-232 Input Items in a playlist and configure it to issue an Advance To or Change Layout command. Use
those commands to change the media played by the iCOMPEL. This is triggered when the iCOMPEL detects a line
transition generated by a user action.

Control Line Outputs:

The iCOMPEL can control the output state of the RS-232 DTR and RTS lines. Create RS-232 Output Items to change one
or both RS-232 outputs and optionally transmit a string of characters. Give the RS-232 Output Items unique names to
clarify their purpose in the iCOMPEL configuration. 

4.2.3 Touch Screens

The iCOMPEL includes support for touch screen input from users. These features allow you to configure the iCOMPEL to
respond to those user inputs (for example, by executing Advance To or Change Layout commands). Connect an overlay
touch-screen panel to the iCOMPEL through its USB port.

You can configure the response at one or both of these levels: 

Touch screen physical interface – The iCOMPEL supports USB touch-screen overlays that report absolute X/Y
coordinates and key up and key down events. There is no support for a mouse-like device that sends relative movements
since this requires an on-screen cursor.

Touch screen calibration – On the menu bar, click Setup and select Player > Interactivity. Click the Touch tab and

click the  button.
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See Interactivity  for more details.

4.2.4 Click On Touch

You can configure the iCOMPEL to play an audio file when someone touches an interactive screen.

To play an audio file, click the layout's Interaction tab and enable Click on Touch. The iCOMPEL does not play a sound
when the setting is No Click on Touch.

Specify these items:

Volume – Express volume as a percentage of the Master Volume level. (You can specify the Master Volume level on
the Audio page in the Setup menu.) If this entry is blank, the iCOMPEL uses 75% of the Master Volume level.

Actions – Check the audio file's Use sound button. If necessary, navigate to the location of the file using the folder
display.

4.3 Using the RS-232 Interface Port

Most products in the iCOMPEL range have a single RS-232 port presented on a 9-way D-type plug. 

Considerations for sending RS-232 strings at specific events or playlist positions:

Define the strings by expressing their byte values as separated hexadecimal pairs (for example, 3A 3B 3C 0D 0A). 

Create the strings in accordance with the needs of the attached device. 

The state of the RS-232 control lines does not affect transmission of RS-232 strings.

Considerations for receiving RS-232 strings:

The iCOMPEL reports the most recently received string in the Items tab on the Setup > Player > RS-232 Outputs
page. 

The state of the RS-232 control lines does not affect reception of RS-232 strings.

4.4 Displaying Part of a Movie or Web Page

You can configure a movie or HTML item in a playlist to display only a part of its output. 

This is useful if you want to:

Show a specific area of a movie or web page without resizing it.

Crop a movie designed for a 16x9 (widescreen) format to a 4x3 (standard) format. This avoids resizing the zone, which
would alter the aspect ratio and distort the image.

To display only part of a movie item, modify the values for its Movie Size property (see Movie Properties  for details).
To display only part of an HTML item, modify the values for its Web Page Size property (see HTML Properties  for
details). 
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4.5 Mitigating Plasma Screen Burn

If a plasma screen continually shows the same image, there is a danger it burns a permanent impression into the screen.
Screen burn is less likely on LCD panels. You should activate any built-in burn-mitigation feature on your plasma screen. 

You can further mitigate the problem by regularly changing the background image or layout. Bear in mind these advisory
points:

If the background image has features that relate to a specific zone (for example, a box around scrolling text), move the
image in conjunction with the zone. 

To make a background image move in conjunction with a specific zone, display the background as a number of zones
that together cover the screen. Add the background images to the playlist for each zone.

Locate a foreground and a background zone together by positioning the foreground zone's center exactly above the
background zone's center.

The iCOMPEL also provides a burn mitigation mechanism and you can enable this for any layout. It works by changing the
location of the zones at regular intervals. You can flip zones horizontally or vertically or have them 'orbit' the screen. 

If you activate burn mitigation for a layout, you cannot exclude any zones.

To activate plasma burn mitigation:

1. On the menu bar, click Layouts and select the layout.

2. Click the Layout Properties tab.

3. Check the Enable Mitigation box.

4. Choose the scheme: 

Mirror Layout Zones Left to Right – Zones swap position along a central horizontal axis.

Mirror Layout Zones Top to Bottom – Zones swap position along a central vertical axis.

Orbit Zones in Layout – Zones rotate around a central point.

5. Choose the time interval.

6. Click the  button.

Note: When the iCOMPEL moves zones, it restarts all playlists. 

4.6 Changing the Screen Background

When switching between layouts, you can have the iCOMPEL display a colored background or image. It can also display
this background in any areas of a layout that are not covered by zones. 

Note: Setting the color to black is not recommended because it makes fault-finding more difficult. 

To change the screen background, follow these steps:

1. On the menu bar, click Media and Screen Background.

2. Select either Solid color or Image:

If you select Solid Color, then click the  button to select a color.

If you select Image, then browse the file system for an image. If you want a splash screen effect, set the Layout
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Activation option to Activate new Layout after and select the delay from the drop-down list. 

3. Click the  button.
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5. Ad Hoc Content

The Ad hoc feature allows you to delegate limited control of content to staff local to the display. This is particularly useful
where several iCOMPEL players share the same channel but also need some customized content. The people at each
location can make those changes with a quick and easy, browser-based operation.

Local control of content is important in a wide range of application areas:

In an office, a secretary or office administrator can display welcome messages for visitors or display staff information.

On a university campus with multiple displays, different information may need to be delivered to different faculties about
upcoming events, room allocations, and so on.

In the retail sector, store information and special offer details will vary from branch to branch.

In health care, patient information and other details will vary in different hospitals or GP practices in the same health
authority area.

As the content designer, you delimit how much access is allowed at each site. You retain control of the key display
elements to maintain a consistent appearance and uniform identity for your organization. 

The ad hoc environment consists of these components:

Ad hoc user – The person, usually at the display location, who has limited access and can update or change only the
content items you specify.

Ad hoc entry – Is where ad hoc users log in through their browser, access pages that are available to them, and make
their changes.

Ad hoc media folders – Contain all the media files that the ad hoc user can use when updating or changing content.

You can delegate local responsibility for several different types of content:

Text

Tables

Newsfeeds

TV channels, radio stations, and streaming TV

Folders

You can allow ad hoc users to update customizable content you have added to a playlist or update content they create in
the layouts you have allowed them to access. 

As well as giving such access to content, you can also allow ad hoc users to:

Change complete layouts.

Change display schedules.

Perform schedule overrides.

Synchronize content.

You can also delegate control of a channel to an ad hoc user. In this case, you designate certain items as Ad hoc from
Center. This allows the ad hoc user to update those items on the publisher and in turn that updates each subscribing
iCOMPEL.

The ad hoc system is secure: no ad hoc user can make changes unless you specify the customizable item and give the
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user permission to access it.

5.1 Enhanced Ad Hoc Access Control

Generating ad hoc content is quick and easy. As the content designer, you can build-in ad hoc content during
implementation of your design. Alternatively, you can work with an existing design and allocate ad hoc content as required.
Whichever route you choose, the overall time taken for generating display content is minimized. Ad hoc users can be
working with the system productively with minimum delay.

Automatic Ad Hoc:

By default, the iCOMPEL enables automatic ad hoc for all newly-created layouts. You can control whether it is disabled or
enabled with the Layout Ad hoc Page setting on the layout's Layout Properties tab.

Automatic ad hoc makes creating content easier, as it eliminates many of the configuration and setup tasks. The layout
automatically creates a single ad hoc page, which contains all ad hoc playlist Items in the layout. As you add or remove ad
hoc items, the iCOMPEL automatically adds or removes them from the layout ad hoc page. 

You have full control over ad hoc pages, including specifying which users are or are not authorized to make changes.
However, you cannot add or remove existing ad hoc Items or reference ad hoc items in other layouts. Therefore, automatic
ad hoc is unsuitable if you want multiple layouts to use the same ad hoc item. 

Manual Ad Hoc:

Manual ad hoc gives you complete responsibility for creating and managing all ad hoc pages and the items within them.
You need to add ad hoc items to one or more playlists and one or more ad hoc pages, as required.

You must create an ad hoc item before you can add it to a playlist. Similarly, you must create an ad hoc page and add one
or more ad hoc items to it before it can be used by ad hoc users. 

In manual ad hoc mode, you can create ad hoc pages that contain ad hoc items added to multiple layout playlists. For
example, this is useful if you want to show the same ad hoc welcome message on multiple layouts. 

Creating Ad Hoc Content as You Build Your Design:

Create your layout in the normal way: 

1. On the menu bar, click Layouts and Manage Layouts. 

2. Click the Add Layout tab.

3. Enter a name for the layout and click the  button.

4. Locate your new layout on the Layouts page and click its  button.

5. Create the zones you require and enable them to play the ad hoc media items you want to add.

6. Click the  button and select Save all changes and edit Playlist from the drop-down list.

You can now add ad hoc items. The way in which you do this depends on the type of ad hoc item you want to add:

Text 1.On the playlist's page, click the Specials tab and enter the text you wish to be displayed.

2.Check the Content of this item can be customized using this Layout's Ad hoc Entry Page box.
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3.Click the  button.

4.Click the  button and set the item's Customization Scope:

Local – Only affects the display for this iCOMPEL). 

Remote – Affects the display for all the subscribers to this publisher's channel.

Tables You should have already created and formatted the ad hoc table you require.

1.On the playlist's page, click the Specials tab.

2.From the Table Item drop-down list, select the table you want.

3.Click the  button.

4.Click the table's  button.

5.Click the  button.

6.Check the Use an existing Ad Hoc Item button and select the table from the drop-down list.

7.Click the  button.

Newsfeeds You should have already configured the newsfeed you require.

1.On the playlist's page, click the Specials tab. 

2.From the Newsfeed drop-down list, select the newsfeed you want.

3.Check the Content of this item can be customized using this Layout's Ad hoc Entry Page box.

4.Click the  button.

5. If you want to further configure the item's ad hoc options, click the  button.

TV and Radio
Stations

You should have already tuned the TV and radio stations. For radio, you must enable the layout's soundtrack.

1.On the playlist's page, click the Specials tab. 

2.Take the action appropriate to the type of station you want::

TV – From the Live Video drop-down list, select the station you want. 

Radio – From the Live Radio drop-down list, select the station you want.

3.Check the Content of this item can be customized using this Layout's Ad hoc Entry Page box.

4.Click the  button.

5. If you want to further configure the item's ad hoc options, click the  button.
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Converting an Existing Design to Ad hoc Content:

You can create ad hoc content after you have completed a design. To create ad hoc content in an existing design, the
process is the same as in each case above. You need to disable Automatic Ad Hoc in the Layout Properties tab.

Creating Ad Hoc Pages:

When ad hoc users log on, their Home page displays the Ad Hoc Pages you create. Ad hoc users cannot access any
other iCOMPEL user interface pages. You design the ad hoc pages to display only the text fields ad hoc users can change
or the commands they are allowed to issue. 

To create an ad hoc page:

1. On the menu bar, click Media and select Design Pages > Manage Ad hoc Pages. 

2. Click the Add Page tab

3. Enter a name for the page. Use a name that will be easily recognizable by your ad hoc users.

4. Click the  button.

5. Click the page's  button.

6. Select the item you require from the drop-down list and click the  button.

7. To add more ad hoc items, click the Add Item tab again. Rearrange the order of items using the  and  buttons.

8. Click the Properties tab. Add any instructive text in the User Guidance Message field and select the users you want to
be able to see this ad hoc page.

9. Click the  button.

5.2 Remote Keypad Control

For convenience and ease of use, ad hoc users can control their local iCOMPEL using an infra-red remote keypad. This
enables them to change content at the touch of a button instead of having to access the iCOMPEL by their browser.

Note: the Remote Keypad tab indicates the status of the iCOMPEL infra-red receiver. The remote keypad feature only
works if the iCOMPEL infra-red receiver is connected.

The remote keypad has the following controls:

Volume (up and down) – Adjusts the master volume level in 10% divisions.

Station (up and down) – Controls the ad hoc TV and radio stations played. The user can scroll up and down the station
list.

Programmable buttons (A, B, C, and D) – Each can be programmed to correspond to a specific rendezvous point or
layout.

When the user presses a button, the iCOMPEL displays a status message at the top right of the screen. 

To allow ad hoc users to control the display with the remote keypad, take these steps:

1. On the menu bar, click Layouts and select the one the remote keypad will control.

2. Click the Interaction tab.
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3. For each button, check the action required:

No default Button Action – Check for the iCOMPEL to take no action when the user presses this button.

When button is pressed Advance to Rendezvous Point – Check to assign a rendezvous point to this button.
Choose the zones you allow the ad hoc user to control.

When button is pressed change to Layout – Check to assign a layout to this button. Ad hoc users press this
button to switch the display to that layout.

To allow ad hoc users to choose TV or radio stations, take these steps:

1. On the menu bar, click Media and Manage Ad hoc items. 

2. Click the Add Item tab. 

3. From the Add Ad hoc Item of Type drop-down list, select TV or Radio and click the  button.

4. In the Ad hoc Item property Allowed Choices, select one of:

All Available TV or Radio Stations – Allows ad hoc users to select from any TV or radio station configured on the
iCOMPEL.

Only Selected TV or Radio Stations – Allows ad hoc users to select from the TV or radio stations you choose. 

5. Select the default TV or radio station from the Default TV or Radio Station drop-down list.

5.3 Additional Ad Hoc

Additional Ad Hoc features allow for greater customization of layout content. This is particularly useful in a channel, where
a network of iCOMPEL players all play the same content.

Using additional Ad hoc, multiple iCOMPEL players in a channel can each show different content, controlled by ad hoc
users locally. This allows an organization to maintain a consistent appearance or brand image across a number of sites,
while allowing local users to upload their own content and change the layouts and playlists to which they have been given
access.

The content types that can be used with additional ad hoc include:

Folder play

Layout

Schedule

Schedule override

Advance To

Folder play allows you to add a folder to a playlist and give ad hoc users permission to upload their own content into the
folder. For example, different GP practices with iCOMPEL players in the same channel could carry different local
information about late night dispensing chemists.

Layouts allow the ad hoc user to select a layout for a specific time slot in the schedule. Typically, if an organization
published a channel with a layout for each department, an ad hoc user in each department could select the right layout for
that location.

Schedule allows the ad hoc user to set the time when a layout should appear on the display. For example, if a lunch hour
layout has been scheduled, but times vary at different locations, local ad hoc users can set their times accordingly.
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Schedule override allows the ad hoc user to display one of a selection of predefined layouts and not have this interrupted
by any other layout changes in the schedule. For example, this can be used to show a special TV event or display an
emergency message without interruption.

Advance To allows the ad hoc user on-demand control in several areas, including content selection. For example, this
might be useful in a foyer where a iCOMPEL is showing a corporate video in a continuous loop. The Ad hoc Advance To
command allows a local user to switch to live TV if required. 

To set up an ad hoc Advance To command:

1. On the menu bar, click Help and UI Options.

2. Select the User Interface Policy as Detailed or Expert.

3. Click Playlists and select the layout and zone to locate the Advance To command.

4. Click the Specials tab.

5. Add a rendezvous point to the playlist and give it a name. 

6. Add one or more media items to the playlist. 

7. Click the Specials tab

8. Select the Advance To item that has the same name as the rendezvous point you created and add it to the playlist.
This causes the playlist to loop back to the start again, regardless of what may follow.

9. Add a second rendezvous point to the playlist. 

10.Add the extra ad hoc media items to the playlist. 

11.Add the Advance To command that has the same name as the second rendezvous point to the playlist. This causes
the playlist to loop continuously through the ad hoc media items. If you want to revert back to the original ad hoc media
items, omit this step.

12.On the Manage Ad hoc Items page, create an ad hoc Advance To item and select the names of the two rendezvous
points you have created. 

13.Add those ad hoc Advance To items to an ad hoc page.

14.Log in as an ad hoc user and browse to the ad hoc page you have created.

15.Select the Advance To command that you wish to test and click the  button. If the iCOMPEL is playing the
playlist, it will jump to the point in the playlist under the selected rendezvous point.

To set up an ad hoc schedule override and make it available to ad hoc users:

1. On the menu bar, click Schedules and Manage Schedules. 

2. Click the Add Override tab. 

3. Enter a descriptive name for the override.

4. Select the layout from the drop-down list.

5. Click the  button.

6. On the menu bar, click Media and Manage Ad hoc items.

7. Click the Add Item tab. 
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8. For the option Add Ad hoc Item of type, select Schedule Override from the drop-down list. 

9. Enter a name for the schedule override and click the  button.

10.In the Allowed Choices panel, select one of the following:

All Available Schedule Overrides – Allows ad hoc users to select from any schedule overrides configured on the
iCOMPEL.

Only Selected Schedule Overrides – Allows ad hoc users to select only from the schedule overrides you select.

5.4 Ad Hoc from Center

The Update from Center feature allows ad hoc users to make changes on a publisher iCOMPEL that will be updated to
the channel's subscribers. The ad hoc users on the publisher iCOMPEL can only change the content on the ad hoc page
you create.

You can use the Update from Center feature with ad hoc text and schedule override items. When you create an ad hoc
from center item, you set its scope as one of:

Local – Default. Ad hoc text items behave as normal. Ad hoc users can log in and change the contents for each
iCOMPEL.

Remote – Ad hoc items will only be visible to ad hoc users on the publisher iCOMPEL. Changing the ad hoc item on the
publisher causes updates to all subscribers too. To restore the original schedule on the publisher, select Default
Schedule from the Ad hoc page.

Subscriber iCOMPEL players may not normally check for updates often enough if the ad hoc from center changes are
frequent. Therefore, you can configure the subscriber players to check for update from center items more frequently. On the
subscriber the Channel Management page offers the Update From Center Poll Interval option. This determines how
often the subscriber polls for update from center items and changes accordingly. The subscriber iCOMPEL checks for
normal publisher updates and for updates from center independently. 

5.5 Making Ad Hoc Changes

To make an ad hoc change:

1. Logon to the iCOMPEL as an ad hoc user.

2. Click the ad hoc page you want to edit.

3. Make the changes you want on the page.

4. If the iCOMPEL is playing the item, click the  button. Your change takes effect immediately.

5. If the iCOMPEL is not playing the item, click the  button. Your change takes effect when the iCOMPEL
next plays the item.

5.6 Managing Ad Hoc Items

The ad hoc items page allows you to create, delete, and set properties for ad hoc items. Reach that page from the menu
bar by clicking Media and Manage Ad hoc Items.

To create an ad hoc item, click the Add Item tab. Select the item type from the drop-down list and enter a unique name for
it.
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To delete an ad hoc item, click the . button. If the iCOMPEL does not display the item's  button, it is in use and

cannot be deleted. To see which items are in use, click the  button and look at the Used By Layouts and Used by
Ad hoc Pages information.

When you add an ad hoc item, you can also set a range of properties, depending on the item. The iCOMPEL supports
these Item types:

Advance To

Layout

Newsfeed

Schedule

Schedule override

Text

TV

When you add an item, you have to select one of these Allowed Choices options:

All Available – Permits the ad hoc user to choose any of the defined items.

Only Selected – Permits the ad hoc user to choose only those items you select.

In addition, for schedule override and text items, the iCOMPEL offers you the Customization Scope option. Use this to
select where those ad hoc items can be customized and displayed:

Local – Ad hoc user changes only affect this iCOMPEL.

Remote – Ad hoc user changes made on the publisher iCOMPEL are also applied to each subscriber iCOMPEL.

Text also has its own set of ad hoc options. Use these to control what an ad hoc user can enter in the Default Text and
Ad hoc User pages:

Rich text – No validation is performed.

Plain text – An ad hoc user cannot customize the text color or styling.

Integer between – Enter the lower and upper integer limits (both inclusive) for ad hoc content. This option is only shown
if you have set the User Interface Policy to Detailed.

Plain text of maximum length – Limits the maximum length of plain text. This option is only shown if you have set the
User Interface Policy to Detailed.

Plain text matching – This option is only shown if you have set the User Interface Policy to Detailed.

Regular Expression – The ad hoc content must match the regular expression that you provide. There are many web
sites and books that provide information about using regular expressions. For example: http://www.regular-expressions.
info/javascript.html.

Feedback Message – Enter a message for the iCOMPEL to display if the ad hoc user text does not match the regular
expression you provided. 

Default Text – Enter the default text to use until an ad hoc user makes a change on the Ad hoc Data Entry page. Your
default text must be compatible with the ad hoc input mode you have selected.

Customization Status – Indicates if the ad hoc user has overridden the default value or not.

http://www.regular-expressions.info/javascript.html
http://www.regular-expressions.info/javascript.html
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5.7 Creating Ad Hoc User Accounts

If you want a user on a subscriber iCOMPEL to update ad hoc channel content, you must create an ad hoc user account
for them on the subscriber. If you want a user on a publisher iCOMPEL to be responsible for ad hoc from center content,
you must create an ad hoc user account for them on the publisher.

To creating an ad hoc user account, take the following steps:

1. On the menu bar, click Setup and select System > Users. 

2. Click the Add User tab.

3. Enter a username and a password. By default, the iCOMPEL provides the user with the Ad Hoc permission.

4. Click the  button.

5. On the Users page, click the new account's  button.

6. Select the other permissions the user needs. As well as the Ad hoc permission, options here include Activate Channel
and Publish Channel. If the user requires access to an ad hoc media folder, select the folder name from the Media
Folder drop-down list.

7. Click the  button.

5.8 Ad Hoc Pages

When ad hoc users access the iCOMPEL using their browser, they only see the pages you have created for them. The
iCOMPEL does not allow ad hoc users access to any other pages in the iCOMPEL user interface. The iCOMPEL displays
ad hoc pages with the text fields you have allowed ad hoc users to change or the commands you have allowed them to
issue. You can give ad hoc users access to the ad hoc media folder, which contains all the items that they can choose
from when updating or changing content.

By default, the iCOMPEL enables ad hoc pages for all layouts when you create them. This means that when you add
customizable or ad hoc items to a layout, the iCOMPEL generates an ad hoc page for that layout containing all the
customizable and ad hoc items within it.

You can also create ad hoc pages that are not directly associated with a specific layout following these steps:

1. On the menu bar, click Help and UI Options. 

2. For the User Interface Policy option, select Detailed or Expert.

3. Click the  button.

4. On the menu bar, click Media and select Design Pages > Manage Ad Hoc Pages. 

5. Click the Add Page tab.

6. Enter a unique name for the ad hoc page.

7. Click the  button.

5.8.1 Managing Ad Hoc Pages

To view or modify an ad hoc page, follow these steps:

1. On the menu bar, click Media and select Design Pages > Manage Ad hoc Pages. 
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2. Click the page's  button.

To delete an ad hoc page, follow the same procedure and click the  button. If the iCOMPEL does not display the

page's . button, it is in use and cannot be deleted. Also, you cannot delete layout ad hoc pages, only disable them on

the Layout Properties tab.

5.8.2 Editing Ad Hoc Pages

The edit ad hoc page lists all the items you have added to the page that an ad hoc user can change. 

Note: Click the Ad hoc Entry Page link at the top of the page to navigate to the Data Entry page.

The iCOMPEL displays these tabs:

Items – Shows the items on the page and allows you to modify them.

Add Items – Allows you to add new items to the page (not shown for layouts automatically managing ad hoc pages).

Properties – Allows you to change the page name, the user message, and the users allowed to change items on it.

Items:

To remove an ad hoc item, click its  button.

Note: This is not available on layouts that automatically manage ad hoc pages.

On pages with multiple items, you can adjust their order using these buttons:

 Move the item to the top.

 Move the item up one place.

 Move the item down one place.

 Move the item to the bottom.

Add Item:

To add an ad hoc item to the page, click the Add Items tab and follow these steps:

1. Select the item from the Add Ad hoc Item drop-down list.

Note: You can have only one ad hoc Schedule Override item on an ad hoc page.

2. Click the  button.

3. Perform other actions on the Items tab. Move the item or click its  button to add a label to show next to it on the
Data Entry page.

Properties:

The options on the Properties tab are:

Page Name – Unique identifier for the ad hoc page. The iCOMPEL displays it on the Data Entry page.

User Guidance Message – Optional. Enter a message for the iCOMPEL to display on the Data Entry page to help users
when entering values.
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Users allowed to Enter Data – Select the users who have permission to view and make changes to the Data Entry page
(users with Layout Manager Access permission can view and modify all ad hoc Data Entry pages).

5.9 Ad Hoc Folder Play

You can add a folder to a playlist and then give ad hoc users permission to upload their own content into that folder. For
example, you might develop a layout for an education authority with a zone dedicated to showing student artwork that is
published to subscriber iCOMPEL units in each school: each school uploads its local artwork to the ad hoc folder so the
content of the zone is unique to that school.

Your iCOMPEL does not need to be a publisher to use an ad hoc folder play. The same principles apply to a standalone
iCOMPEL. 

Your ad hoc folder must contain at least one default item that is shown until ad hoc users upload content. Even if you
republish the channel, local content remains in place (unless you have removed the folder from the playlist).

To add an ad hoc folder to a playlist follow these steps:

1. On the menu bar, click Playlists and select the layout and zone where you want to add the folder. 

2. Click the Files and Folders tab.

3. Click the  button for the folder you want to add to the playlist.

4. Click the Playlist tab and, If necessary, adjust the item order.

5. Click the folder's  button.

6. Check the Management box.

7. Click the  button.

The iCOMPEL creates a default_files subfolder in the folder you have added: put your default content into that subfolder.
The iCOMPEL will display the content ad hoc users upload the main folder but, if it is empty, the iCOMPEL displays what
you have added to the sub-folder.

5.10 Ad Hoc Media Folder

You designate ad hoc media folders to delimit the media folders that ad hoc users can access.

To allow an ad hoc user to access a media folder, you must add it to the playlist and then enable it for the ad hoc user. If
suitable material is available in the folder, the iCOMPEL plays it in preference to any other. If no suitable media is available,
the iCOMPEL plays the content of the default folder for that playlist instead.

You must create an ad hoc folder for the user to upload content to. If you see the message 'No Media Folder has been
configured for this user', you need to designate a media folder for the user's account. Do so by following these steps:

1. On the menu bar, click Setup and select System > Users.

2. Click the user's  button.

3. Select the folder from the Media Folder drop-down list.

4. Click the  button.

Go to the Media > Files & Folders page to create the folders and to browse the file system.
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5.11 Changing Ad Hoc Content

If you want to change the ad hoc content currently playing, the general steps to follow are:

1. Connect to the iCOMPEL with your browser

2. On the menu bar, click Ad hoc Entry.

3. Select the ad hoc page for the content you want to change.

4. Make the necessary changes (see table below for details). 

5. If the iCOMPEL is playing the item, click the  button. Your change takes effect immediately.

6. If the iCOMPEL is not playing the item, click the  button. Your change takes effect when the iCOMPEL
next plays the item.

7. Exit your browser to leave the iCOMPEL.

In more detail, how you make your change depends on the ad hoc item concerned. Follow the steps for the ad hoc item
you want to change:

Text and Tables Change the text scrolling across the screen or in a table:

1.On the menu bar, click Ad hoc Entry.

2.Select the ad hoc page for the content you want to change.

3.Edit the text or table entry. Tips:

To remove text from the screen, delete everything in the box.

To create a line break in vertically scrolling text, press the Enter key at the location required. 

4.Click the  or  button. 

TV Stations Change the TV station showing on the screen:

1.On the menu bar, click Ad hoc Entry.

2.Select the ad hoc page for the content you want to change.

3.Select the new TV channel from the drop-down list

4.Click the  or  button. 

Newsfeeds Change the source for a newsfeed showing on the screen:

1.On the menu bar, click Ad hoc Entry.

2.Select the ad hoc page for the content you want to change.

3.Select the new newsfeed from the drop-down list.

4.Click the  or  button. 

Media Folders Manage media items (typically, still images held in a folder) showing on the screen:



Copyright © 2010-2013 Black Box Network Services. All Rights Reserved.724-746-5500   |   blackbox.com 92

iCOMPEL Digital Signage User Guide (V9.2.3)

1.On the menu bar, click Ad hoc Entry.

2.Select Media Folder. The iCOMPEL shows the contents of your media folder.

3.To view a file, click its name.

4.To upload a new file or manage the existing files, see Uploading Content Files .

5.To change the order in which files play, see Folder Play Properties .

Screen Layouts Change the whole layout (this assumes you have already added an ad hoc layout to the ad hoc page): 

1.On the menu bar, click Ad hoc Entry.

2.Select the ad hoc page relevant to the layout you want to change.

3.Select the new layout from the drop-down list.

4.Click the  or  button. 

Scheduling Change the schedule for when the  iCOMPEL makes changes to the display (for example, to coincide
with meal or break times or for an after-hours event):

1.On the menu bar, click Ad hoc Entry.

2.Select the ad hoc page relevant to the schedule you want to change.

3.Modify the schedule using the drop-down lists and check boxes.

4.Click the  or  button.

If the current time is within your new schedule, the iCOMPEL triggers the change immediately (unless it

has already begun another schedule). 

If the schedule has related audio or you require silence, reprogram the audio on or off time to match.

Advance To (on
demand) 

Activate events on demand (for example, to show a video selected from a list):

1.On the menu bar, click Ad hoc Entry.

2.Select the ad hoc page relevant to the Advance To command you want to invoke.

3.Select the relevant name from the drop-down list.

4.Click the  or  button.

5.12 Ad Hoc Theming

You can change how the iCOMPEL user interface appears to your ad hoc users by using Ad hoc Theming. Ad hoc
theming lets you customize page headers and the text that appears on the page.

You might use ad hoc theming to:

Include a company logo in a page to make it consistent with a brand identity.

Provide a translation of pages in a language not already supported on the iCOMPEL.

The ad hoc theme applies to ad hoc users on the iCOMPEL or on an iCOMPEL subscribing through a channel. You cannot
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include ad hoc themes in layout packages.

To access the Ad hoc theme page, click on Media and select Manage Ad hoc Theme. Create your theming features
using the following tabs:

Properties Select the options you require:

Ad Hoc Theme – Choose the Disabled button to retain the default appearance. Choose the Enabled button
to use the theme you are customizing.

Header text color – Click the Pick Color button to select a different header text color.

Header background color – Click the Pick Color button to select a different header background color.

Page logo – Choose the button for the alignment you want a logo image to have on the page. 

Select the logo image from the files displayed. If your logo file is not there, navigate through the folders to
where it is located or click the Files & Folder link to upload it.

When complete, click the  button. 

Strings Allows you to provide either translations or alternative text for all the headers, boxes, instructions, and
warnings that appear in three ad hoc areas:

Homepage

Ad hoc Edit Pages

Media Folder

The iCOMPEL displays the default text on the left. Enter your new text in the field on the right.

When complete, click the  button. 
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6. Sharing Content Using Layout Packages

A Layout Package is a single file which contains all the media and control files required to fully install one or more layouts
on another iCOMPEL.

You can distribute layout packages on DVDs, by memory sticks, through file servers. or sent by email.

Transferring layouts from one iCOMPEL to another is a two-step process: 

1. Create the layout package  on the originating iCOMPEL.

2. Upload and install the layout package  on the destination iCOMPEL.

6.1 Layout Packages

The Layout Packages page allows you to create, delete, and install layout packages. 

The Layout Packages tab lists all the layout packages available on the iCOMPEL. Click the button next to a layout
package to take these actions:

Delete the layout package. This only removes the layout package file (not any media or layouts you have
already installed).

Display information about the layout package content.

Copy the layouts and media contained in the package onto the iCOMPEL. If any of those items already exist on
the iCOMPEL, but have different values, you are asked how you want conflicts handled (see Layout Package
Conflicts  for details).

Click the Create tab to display the options for creating a new layout package:

Name – Unique identifier for the layout package. In the name, you can only use the characters a-z and A-Z, the numbers
0-9, or a space.

Description – Optional. A description for the layout package.

Include Layouts – Select the layouts you want in the layout package.

Click the Status tab to see information about layout package operations. The iCOMPEL only displays the Status tab if you
have started a layout package operation or have completed one previously.

6.2 Creating a Layout Package

To create a layout package, follow these steps:

1. Finalize the layout or layouts that you will include in the layout package.

2. On the menu bar, click Layouts and Layout Packages.

3. Click the Create tab. 

4. Enter a suitable name and optionally a description for the new layout package. 
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5. Check the box next to each layout to include in the package. 

Note: The iCOMPEL also includes layouts referenced by Change Layout commands even if you do not select those
layouts explicitly here.

6. Click the  button. The iCOMPEL displays the Status tab.

7. When the layout package creation completes, click the Package Filename link and use the dialog to save the package
file on your computer.

8. Send copies of the layout package ZIP file to those who need them. 

Note: There is a 2 GB size limit to layout packages ZIP files. Because a 40 minute MPEG-2 encoded video film can be
2 GB in size, you may need to exclude large video media files before creating your layout packages. 

6.3 Uploading and Installing a Layout Package

To upload and install a layout package on your iCOMPEL, follow these steps:

1. On the menu bar, click Layouts and Layout Packages.

2. Click the  button and navigate to the layout package file on your computer.

3. Click the  button to copy the file onto the iCOMPEL. The iCOMPEL displays a progress bar during upload.

4. After uploading, the iCOMPEL displays the layout package in the list.

5. Click the layout package's  button. If items in the package have the same name as items already on the
iCOMPEL, the iCOMPEL prompts you to resolve the conflict (see Layout Package Conflicts  for more details).

Note: Layout packages are compressed ZIP files. The iCOMPEL does not list other types of file on the layout package
page.

You can also copy layout packages to and from a iCOMPEL by using an FTP client (for example Internet Explorer) on your
computer. Browse to the /HOME/package folder on the iCOMPEL.

6.4 Layout Package Conflicts

When you install a layout package, the iCOMPEL merges items in the package with existing items. This includes:

Layouts

Special items

Ad hoc items

Ad hoc pages

Media files

The iCOMPEL flags a conflict when an item in the package is identical to an existing item, but has different property values.
You are prompted to resolve the conflict with one of these options:

Do Not Copy – The iCOMPEL will not change the existing items. This is equivalent to not copying any conflicting items
or files from the layout package. The iCOMPEL installs all non-conflicting items.

Copy and Replace – The iCOMPEL will replace existing items with items from the layout package. This is equivalent to
the iCOMPEL overwriting the local items.
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Copy but Keep Both Items – The iCOMPEL renames the items in the layout package to avoid conflicts with existing
items. The iCOMPEL displays the new names on the Status tab.

The iCOMPEL may offer specify different conflict actions for media files and layout and special items.

In some cases, selecting Copy but Keep Both Items may cause additional items to be in conflict. For example, if an ad
hoc text item is in conflict and is contained in a layout that exists locally, but is identical, and you choose the Copy but
Keep Both Items option, the iCOMPEL renames the ad hoc text item. This causes the layout in the layout package to be
modified to reference the newly renamed ad hoc text item. This in turn causes a layout conflict, since the local layout and
the modified layout are now different. The iCOMPEL shows additional, secondary conflicts a separate line in the Conflict
Details section.

Click the  button to proceed with the Installation or the  button to stop the installation
process.

6.5 Layout Package Information

To see information about a layout package, follow these steps:

1. On the menu bar, click Layouts and Layout Packages.

2. Click the layout package's  button.

The iCOMPEL displays this information:

The originating iCOMPEL.

Layouts included in the package.

Special Items included in the package.

Other additional settings (such as color items and special fonts).

Media item files in the package.

This information may help you resolve any conflicts between items in the package and those already on your iCOMPEL.
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7. Channels and Signage Networks

Channels provide an easy way to display the same content at multiple locations by setting up a Digital Signage Network of
iCOMPEL players. A collection of iCOMPEL players that all play the same content on their screens is known as a 
Channel.

A channel has three parts:

A Publisher iCOMPEL.

The Channel Content Server (CCS). The server delivering channel content to the subscriber iCOMPEL players.

One or more Subscriber iCOMPEL players.

The publisher iCOMPEL publishes content to the CCS. (On small networks, the publisher iCOMPEL can also act as the
CCS.) Each subscriber iCOMPEL regularly polls the CCS for the most up-to-date content. 

Note: Some iCOMPEL players are sold as 'Subscriber only' and cannot act as publishers.

When you publish to a channel, it includes all the related schedules, layouts, and media content. However, the channel
does not include:

Any custom fonts you have installed.

User records, including ad hoc users.

If your content relies on either of the above, you will need to ensure they are already present on each of the subscribers.

To begin using a channel, you need to take these general steps:

1. Configure each iCOMPEL in the channel with their role (either publisher or subscriber). One iCOMPEL will be the
publisher and the rest will be subscribers. 

2. Decide the best way to get the content from the publisher to the subscribers (see Channel Content Servers  for
more details). 

3. Create the content on the publisher. You need to consider these factors:

Are the subscriber iCOMPEL players powerful enough to show the content? Some content may not show optimally on
less powerful player models (for example, high-resolution movies or Adobe Flash items that require a fast CPU).

What resolution are the screens attached to the subscriber iCOMPEL players? Ideally, to display the same content
you should have screens set to the same resolution. If some screens display at lower resolution, take into account
that content will be cropped.

4. When you are ready, click the Published link that appears at the top of each screen on your publisher iCOMPEL. 

5. Click the  button. The iCOMPEL will not make changes to a channel until you publish them.

After a period, the subscriber iCOMPEL players will poll the publisher, download the channel content, and begin displaying
it on the screens they control.

Two other features may be of interest to you:

Add ad hoc content to your channel. This provides content that varies on a per iCOMPEL basis. For example, if you have
iCOMPEL players on different sites, you may wish to allow local users to display messages specific to their location.
You will need to provide the users on the subscriber iCOMPEL players with the appropriate ad hoc permissions. See Ad
Hoc Content  for more details.

Publish more than one channel from your publisher. See Multichannel Publishing  for more details.
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Note: It is recommended that the publisher iCOMPEL and each subscriber iCOMPEL run the same software version.
Although later-version subscribers can sometimes display content created on earlier-version publishers, they will fail to
display features no longer supported.

7.1 Channel Roles

In a channel, you configure each iCOMPEL to operate according to the role it performs. The iCOMPEL can have one of
these roles:

Publisher – The iCOMPEL publishes content to a channel. Subscribers download and display the content. 

Subscriber – The iCOMPEL downloads and displays content from a channel. Publishers create and publish content to the
channel.

Standalone – The iCOMPEL is neither a publisher or subscriber. It does not take its content from a channel (that is, it is not
part of a digital signage network).

To change the channel role. follow these steps:

1. On the menu bar, click Channels then Manage Channels.

2. Select the required role.

3. Click the  button. If the role is not standalone, iCOMPEL displays a configuration screen matching the role
you have selected.

4. Complete the items on the configuration screen (see either Configuring the Publisher  or Configuring the
Subscriber  for more details).

Notes:

Some iCOMPEL models are 'subscriber-only' and cannot be configured as publishers.

You cannot change the role of a publisher iCOMPEL if it publishes more than one channel. You must delete all but
one channel to proceed.

7.2 Channel Content Servers

Subscriber iCOMPEL players can download channel content directly from your publisher iCOMPEL. However, this is not
always possible or the best solution for your signage network. 

Besides distributing content physically on a USB stick, you can also use an external channel content server (CCS) to
offload channel distribution processing from your publisher iCOMPEL. Each subscriber iCOMPEL polls the CCS for the
latest channel contents in the same way it would poll the publisher directly.

How you publish your channel depends on the number of iCOMPEL players in the channel and the network they are
connected to:

How to Publish Description When Would You Use This Method?

On the publisher
iCOMPEL

You store channel files on the publisher iCOMPEL and
subscribers download them using HTTP, HTTPS
(recommended), or FTP. 

You only have a small number of subscribers
(typically, less than five) that will not slow the
publisher down.

This method requires no extra hardware.
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How to Publish Description When Would You Use This Method?

Using a USB memory
stick

You publish channel files onto USB memory sticks.
You distribute the sticks to each subscriber, which
automatically reads the channel from it.

You have to perform this process every time you
update the channel.

Your subscribers are not connected to a
network or you do not want to publish the
channel through a network.

Using an external CCS You use FTP to upload the channel content to a CCS.
The CCS makes the files available to the subscribers,

either through HTTP, HTTPS (recommended). or FTP.

You have a large number of subscribers or
there are larger media files in the channel.

This method:

Takes the processing load off of your
publisher iCOMPEL

Does not require any special FTP or web
server.

Easily ties this into your existing server
hardware or web host.

When planning how to publish, you should bear in mind these network and bandwidth considerations:

Using a CCS requires both the publisher and subscriber to be able to connect to it through a local network or the internet.

Using network-based publication will not work if there is a problem with connectivity or if the supplied credentials for either
the publisher or a CCS are incorrect.

Bandwidth use depends on the layouts and media being published as well as the number of subscribers. Large media
files take time to transfer and this increases the time before the subscribers begin playing the channel. However, after the
subscriber downloads the media, it will only need to download new or updated items later.

Subscribers periodically poll the publishing source for channel updates. If you do not update your channel frequently, then
save bandwidth by decreasing the rate at which the subscribers check for new content. You need to balance this with it
taking longer for the subscribers to display new content when you do change it.

7.3 Publishing

You can publish content from your publisher iCOMPEL either manually or automatically:

In automatic mode, you set your publisher iCOMPEL to always publish the currently active channel at a specified time of
day. 

In manual mode, you manually issue a command to publish the channel.
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7.3.1 Configuring the Publisher

When you set the iCOMPEL role to Publisher, the iCOMPEL opens the Publisher tab for you to complete the
configuration. You can also access the Publisher tab on the menu bar by clicking Channels and Manage Channels.

Complete the publisher settings you require and click the  button to enable them:

Channel Name Enter a unique name for the channel. When the channel is active, this appears at the top of the page on the
subscriber and publisher. 

Publishing Mode Select the mode of publication you want:

Manual – You publish by issuing a command on the channel publishing page.

Automatic – The iCOMPEL publishes at a specific time every day.

Channel Server Select how you want to publish the channel:

The iCOMPEL /channel/N folder – The iCOMPEL publishes the channel to a folder within the publishing
iCOMPEL. Subscribers access the content through FTP, HTTP, or HTTPS.

The USB Flash Memory's / channel folder – The iCOMPEL publishes the channel to the channel folder to
an attached USB stick.

FTP Site – The iCOMPEL uploads the channel to an FTP site. If you need to provide a username and
password, do so in the Authentication panel.

Publishing Root
URL

If you chose to publish using the FTP Site option, the iCOMPEL enables this box. Enter the URL required.

A valid FTP URL begins with ftp:// followed by the host name or address and the full folder path to the location
to publish the channel. Examples of valid FTP URLs are:

ftp://example.com/mychannel/ 

ftp://192.168.0.23/channel/ 

ftp://somehost/a/b/c/ 

Note these points:

If the folders do not exist on the FTP server, the iCOMPEL attempts to create them. This will fail if you do not
provide a login name and password with appropriate write access. 

To test the setup, the iCOMPEL attempts to log into the FTP server you have defined. It notifies you if this is
successful or not.

Authentication If you chose to publish using the FTP Site option, select whether the destination server requires authentication
or not. If it does, select Login with and enter the required username and password.

Error Retry
Interval

If you chose to publish using the FTP Site option, and the iCOMPEL fails to connect to the FTP server, specify
the period before it tries to publish again. 

Layout Zone Limit Specify the number of zones allowed in published layouts:

Unlimited number of zones – Default. Do not limit the number of zones.

Limit to – Do not allow more zones that the value you specify. For example, if publishing to less powerful
iCOMPEL models, choose a value to ensure you will not overload them.
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You should consider these factors when calculating the storage space required for a channel:

With the exception of video files, content does not require large amounts of storage. If your layouts do not include video
files, you should find 1 GB to 2 GB of space sufficient.

If your layouts include video files, increase storage by at least 2 GB per hour of standard quality video. Allow for more if
the video is high quality.

The iCOMPEL displays the size of the channel on the Status > Channel page. Allow at least twice that on the
subscriber iCOMPEL as it stores the channel twice: once to subscribe and again to display.

7.3.2 Publishing a Channel

After configuring the iCOMPEL as a publisher, you are ready to begin publishing your channel. You can also publish
additional channels later.

Note: If you are publishing to a USB stick, insert that into the iCOMPEL before beginning. Ensure it has the capacity to
hold the channel content.

On the menu bar, click Channels and Publish Channel. 

To publish your channel immediately, click the  button. Alternatively, select the Activation option
Activate after. If you select Activate after, the publisher will publish the channel, but subscribers will not display it until
after the date and time you specify. This is useful to ensure all subscribers start showing the channel content at the same
time (rather than as soon as they can download it). A slow network carrying many large media files can lead to large
differences in when each subscriber completes downloading.

What happens next depends on where you chose to publish the channel:

On the publisher iCOMPEL or to an external server – The iCOMPEL begins the copying process and displays the
Status tab showing a progress bar. The iCOMPEL will display error messages if there are any problems. When copying
is complete, the next time the subscriber players check the channel, they will download the new content.

To a USB stick – The iCOMPEL begins the copying process and displays the Status tab showing a progress bar. The
iCOMPEL will display error messages if there are any problems. When copying is complete, remove the USB stick and
use it to load the channel content onto the subscriber players.

Repeat the same process even if you have only changed the schedule. Subscribers obtaining content from the publisher or
an external server will upload the change the next time they poll for updates. For subscribers you update with a USB stick,
you will need to take the new copy to upload them with.

In all cases, the publisher iCOMPEL displays the following banner if you have changed the channel contents but have not
published it yet:

Clicking the Published link takes you to the Publish tab so that you can publish the new content, as above.
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7.3.3 Multichannel Publishing

You can publish more than one channel from the same publisher iCOMPEL. Although schedules are unique to each
channel, more than one channel can share layouts and contents.

Remember that the iCOMPEL can only publish the currently active channel. Both the publisher and subscriber players
display the name of the active channel at the top of each of their pages. As suggested previously, you will find it helpful to
give a channel a useful name.

To add a new channel, follow these steps:

1. On the menu bar, click Channels and Manage Channels.

2. Click the Channels tab.

3. Click the  button.

4. After the iCOMPEL creates the new channel, click its  button.

5. Create all the content for the new channel.

6. Publish the channel following the usual steps.

To delete a channel, follow these steps:

1. On the menu bar, click Channels and Manage Channels.

2. Click the  button against another channel to make it active. This deactivates the channel for deletion.

3. Click the  button next to the channel you wish to delete. This only deletes the channel schedule: the channel
content is still on the iCOMPEL.

Note: Before you can work with or publish a channel, you must activate it. To do so, follow steps 1 and 2.

7.4 Subscribing

If you configure a iCOMPEL in a subscriber role, it receives all of its content (other than ad hoc content) from a publisher
iCOMPEL. The subscriber iCOMPEL obtains the content across the network from the publisher iCOMPEL or from a
channel content server. It can also obtain its content from a directly-attached USB stick. 

Note: You can log in to a subscriber iCOMPEL and make changes but these are removed (except ad hoc content) the
next time the subscriber uploads a channel update.

7.4.1 Configuring a Subscriber

When you set the iCOMPEL role to Subscriber, the iCOMPEL opens the Subscribing tab for you to complete the
configuration. After you have finished, the iCOMPEL will begin uploading content from the channel and periodically check it
for updates. You can also access the Subscribing tab on the menu bar by clicking Channels and Manage Channels. 

Complete the subscriber settings you require and click the  button to enable them:

Subscription Poll
Interval

Specify how often the subscriber polls for new channel content. Set this often enough to pick up changes but
not so often as to overwhelm the network or channel content server with requests.
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Update From
Center Poll
Interval

Specify how often the subscriber polls for changes to ad hoc from center items. As above, take care with how
often you poll. However, these changes require less bandwidth and you could set the poll interval accordingly.

Channel Server Select where the channel content comes from:

The USB Memory stick's /channel folder – Channel content is on a USB stick

Remote Web site or FTP server – Upload channel content from a publisher iCOMPEL or channel content
server.

Channel
Subscription URL

If the subscriber uploads channel content from a publisher iCOMPEL or channel content server, enter the URL
required. The format of the URL depends on whether you upload content by HTTP/HTTPS or FTP.

For HTTP/HTTPS, the required URL is of the form:

http://<publisher>/data/channel/<channel_number> 

Specify the protocol at the start of the URL (HTTP or HTTPS). In the rest of the URL, <publisher> is the host

name or IP address of the publisher or server and <channel_number> is the channel number. You can find
out the channel number on the publisher's Status > Channel page in the Publisher State report.

For FTP, the required URL is slightly different:

ftp://<publisher>/channel/<channel_number> 

Example subscription URLs:

https://192.168.1.54/data/channel/1 

http://iCOMPEL9038/data/channel/2 

ftp://iCOMPEL9038/channel/2 

ftp://192.168.1.54/channel/5 

Check the Append iCOMPEL Serial to Channel Subscription URL box to have the iCOMPEL add its serial
number to the URL. 

Authentication Select whether the target publisher or server requires authentication or not. If it does, select Login with and
enter the required username and password.

Proxy If access to the internet is by a proxy, select Use Proxy if configured. You must have already configured the
proxy.

Error Retry
Interval

If the subscriber fails to connect, or an update is incomplete, specify the period before trying again.

File Transfer
Allowed

If required, specify From and To times to control when the subscriber uploads files. You might do this if
updates typically involve large files and you want to choose times when other network activity is low.

7.4.2 Updating Subscription

After you configure the iCOMPEL as a subscriber to a channel, it continues to automatically poll the channel for updates
without any further intervention.

You can also manually command a subscriber iCOMPEL to poll for updates by following these steps:
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1. On the menu bar, click Channels. 

2. Click Subscribe Channel. 

3. Click the  button.

To update a subscription by USB stick, follow these steps:

1. On the publisher iCOMPEL, publish the updated channel to the USB stick you are using. 

2. Plug the USB stick into the subscriber iCOMPEL. 

3. The subscriber iCOMPEL detects the USB stick, recognizes there are changes to the channel, and proceeds to upload
the new content. During the update, the subscriber displays a status message at the top left corner. When it completes
the update, the subscriber displays this message to let you know you can remove the USB stick:

7.5 Channel Ad Hoc

Using ad hoc content within a channel enables you to allow users to show their own content on their local iCOMPEL while
still showing the rest of the channel.

Create ad hoc content in the same way as you would a normal part of a layout. Local ad hoc users can then log into their
subscriber iCOMPEL and change that content.

Ad hoc from center is similar to regular ad hoc in that it allows a user to log in to change an element of the signage display
quickly and easily. However, instead of the user making ad hoc changes on the subscriber iCOMPEL, with ad hoc from
center the user can make changes on the publisher iCOMPEL. Consequently, the subscribers to that publisher upload the
ad hoc from center changes to the channel. When configuring those subscribers, you might want to set their polling interval
to a shorter period so that ad hoc from center updates arrive more quickly.
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8. Player and System Status

Use the Status options to access information about the player and the system.

Select the menu item for the status information you want to access:

Player  – Viewing the current and recently displayed layouts and the CPU load.

System  – Viewing the disk and CPU temperatures over time, general system status, and hardware specification.

Conditional Play  – Checking the items that are subject to conditional play.

TV & Radio  – Examining the state and use of the TV card.

Note: The iCOMPEL only displays the TV & Radio item if it has a TV card installed.

8.1 Player Status

The Player status page provides details about what the iCOMPEL is currently playing and what it played recently. The
iCOMPEL refreshes this display automatically as it plays new content.

Select the tab for the option you require:

Playing Now – Displays a CPU usage graph for each zone. Compare this with the information on the CPU Load tab to
determine which media, or combination of media, imposes a high load on the iCOMPEL CPU.

Played Recently – Displays a list of recently displayed layouts and recently-implemented Advance To commands.

Screen Snap Shot – Displays a pixel-perfect image of the current screen display. You can also view a live-screen
display of what is running on the screen. See Screen Snap Shot  for more details).

CPU Load – Displays a graph of processor load sampled every second. Values of 90% and above indicate processor
overload (for example, video may not play smoothly as a result). To avoid CPU overload, you can change the media type
or change the order of items in the zones.

Note: The Home page displays the average CPU load over the last 60 seconds. The iCOMPEL displays a warning if
that value is 90% or above.

8.2 System Status

The System status page provides details of the environmental performance of your iCOMPEL.

Select the tab for the option you require:

°C 24 Hours – Viewing disk and CPU temperatures from the last 24 hours.

°C 30 Days – Viewing disk and CPU temperatures from the last 30 days.

Status – Viewing uptime, temperature, Ethernet, and memory metrics.

Hardware – Viewing iCOMPEL processor specification and memory capacity.

°C 24 Hours:

Illustrates disk and CPU temperatures from the previous 24 hours on separate graphs. Green lines indicate the safe
temperature range and red where the temperature is too high. 
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Beneath each graph, notes indicate the maximum temperature during the period and the shut down temperature. iCOMPEL
shuts itself down if the disk temperature exceeds 50 °C for more than 5 minutes.

°C 30 Days:

As above except covering the previous 30 days.

Status:

The display contains the following information:

iCOMPEL Uptime How long the iCOMPEL has been running since its last restart

Disk Temperature Current disk temperature

CPU Temperature Current CPU temperature

MB Temperature Current motherboard temperature

CPU Fan Speed Speed of CPU cooling fan (in RPM)

Case Fan Speed Speed of system cooling fan (in RPM)

Ethernet Receive Total inbound network traffic (in bytes and packets) and number of errors

Ethernet Transmit Total outbound network traffic (in bytes and packets) and number of errors

System Disk How much system disk space used of how much available 

Data Disk How much data disk space used of how much available

Hardware:

The display contains the following information:

CPU Make, model, and speed of iCOMPEL processor

Available Memory Amount of iCOMPEL main memory 

CMOS Signature Support may request this value.

TV Card The model of TV card installed or if none is fitted. 

TV Card Features TV card features (if fitted).

8.3 Conditional Play Status

The Conditional Play status page summarizes the playlists or schedules with the Conditional Play property set.

The page displays details of the items that you have configured to play conditionally along with the result. If you have not
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added the required player local information for those conditions, the iCOMPEL displays an action message containing a link
you can follow to add the missing name.

The rest of the page is split into two tabs, one each for Playlist Items and Schedules. Each tab displays:

Details of the PLI name on which the item depends.

The operation that the iCOMPEL executes to decide if the item plays.

The values that the item contains and the current values in the PLI. 

The iCOMPEL displays links to the required items: click the link to go to the page you need to access.

8.4 TV & Radio Status

The iCOMPEL only displays the TV & Radio status page if it has a TV card installed. This page provides information about
how the iCOMPEL uses the TV card.

The first line of TV Hardware State contains one of these values:

Not in use No iCOMPEL feature is using the TV card.

Rebroadcasting The iCOMPEL is using the TV card to rebroadcast a TV or radio station. The display includes:

Signal Status (one of Good, Acceptable, or Bad).

The current channel used to rebroadcast.

Bandwidth information.

In use by movie player The iCOMPEL is using the TV card, either to preview or audition TV and radio media or to play a
layout. The display includes

Signal Status (one of Good, Acceptable, or Bad).

The current channel being used.

 Channel type (one of TV or Radio).

8.5 Screen Snap Shot

The Screen Snap Shot status page offers you two views of the current screen display:

When you first open the page, iCOMPEL displays a pixel-perfect image of what is currently on screen.

iCOMPEL can also provide a live-screen display of what is currently running.

To view the live-screen display, follow these steps:

1. Select the relative percentage size for the display.

2. Select the frames-per-second refresh rate for the display.

3. Click the  button. 

By default, the display runs for 60 seconds but you can stop it at any time by clicking the  button.
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Note: Viewing the live-screen display may impact the quality of the actual screen's output.
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9. Setup

Use the Setup options to configure and check the operational features of your iCOMPEL.

Select the menu item for the option you require:

System Setup  – Configuring the administrative and infrastructure aspects of the iCOMPEL system.

Player Setup  – Configuring the display output characteristics you want the iCOMPEL to support.

Maintenance and Troubleshooting  – Performing backup, update, and support activities.

9.1 Help and User Options

Use the Help menu to access the iCOMPEL user interface options, page-specific help, and the user guide.

Use the Help > UI Options page to set the iCOMPEL user interface options. Those options are on these tabs:

My Options – Changing user interface behavior (these changes only apply to the user interface you see).

Shared Options – Adding a title on every page of the user interface (this change applies to the user interface for all
users).

When you have completed making your changes, click the  button to enable them.

To change the general options, select from the following:

User Interface
Policy

Select the display mode you want:

Productive – Displays only the most commonly used features.

Detailed – Displays both commonly used and advanced features.

Expert – Displays commonly used, advanced, and expert features. Take care if you use this mode.

Audition Method Select the audition method you require:

On Screen – The iCOMPEL shows the content on the screen. (The relevant pages will display the audition

 button.)

Web Preview – The iCOMPEL shows the content on your browser. This is useful if you cannot easily view

the screen. (The relevant pages will display the preview  button.)

To create the web preview, the iCOMPEL has to momentarily turn off the screen and mute the audio. It then
restarts the screen and audio again with the existing layout. This is useful when new content should not been
seen before you add it to the active schedule.

Media Thumbnail Disable or resize the thumbnail by selecting from the drop-down list.

To change the Time & Date Display options, select from the following:

Time Style Select the time format you prefer: Locale Specific means the format matches the country and language you
set on the Setup > Player > International page.

Time Separator A colon is the default. Enter another character to use as an alternative.
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Date Style Select the date format you prefer: Locale Specific means the format matches the country and language you
set on the Setup > Player > International page.

Date Separator A hyphen is the default. Enter another character to use as an alternative.

Month Style Select how you prefer to see the month expressed.

To change the Advanced options, select from the following:

Update Currently
Playing Status

Select when you want the iCOMPEL to update the current status information:

Screen thumbnail and currently playing Layout information is updated each time the web page is shown
– Updates when you open the Home page.

Screen thumbnail and currently playing Layout information is updated every few seconds – Updates

every few seconds (this may prevent smooth on-screen text scrolling).

Layout Editing Select how you want to edit layouts:

Graphical Layout Editing – Direct editing including use of drag-and-drop.

Non-Graphical Layout Editing – Indirect editing by entering values. May be needed if your browser does not
support direct editing.

Home Page Select the Home page style you prefer:

Use operational status summary Home page – Displays current layout as thumbnails and player status as
color-themed bars.

Use graphical Home page – Displays current and recently used layouts as thumbnails.

Classic iCOMPEL Home and Setup pages – Displays current layout as thumbnails and setup options as
icons.

Playlist Add Item Select where you want the iCOMPEL to add new items to a playlist:

At Top – Items are added to the top of a playlist.

At Bottom – Items are added to the bottom of a playlist.

After the items are added, you can move them into whichever position you wish.

Drop Down Menu
Display Mode

Select the menu behavior you want:

Menu is shown when hovered over – Menu expands when you hover your cursor over it.

Menu will show when clicked – Menu expands when you click it.

9.2 System Setup

Use the Setup > System options to configure and check the operational features of your iCOMPEL.

Select the menu item for the option you require:

Users  – Adding and managing user accounts.118



Copyright © 2010-2013 Black Box Network Services. All Rights Reserved.724-746-5500   |   blackbox.com 118

iCOMPEL Digital Signage User Guide (V9.2.3)

Date and Time  – Specifying time source and time zone.

Network  – Setting up and testing the network connection.

TV & Radio  – Tuning and using TV and radio stations (only displayed if the iCOMPEL has a TV card installed).

HTTP Proxy  – Setting up proxy server access.

Security  – Configuring firewall and secure access services.

Player Local Information  – Adding customized data items to the player.

Reporting & Remote Setup  – Configuring the iCOMPEL to report to the iCOMPEL Deployment Manager (iDM).

 Feature Keys  – Managing your software feature keys.

9.2.1 Users

Use the Users options to add and manage iCOMPEL user accounts.

Click the tab for the option you require:

Users – Listing the users and their permissions. Click the  button to delete a user (you cannot delete the current

user). Click the  button to change the user settings.

Add Users – Adding a new user.

The iCOMPEL displays the same settings whether you are adding a new user or editing an existing one.

To add or change a user account, complete the following settings and click the  or  button:

Username The name the user logs in with (for example, 'remote', or 'chef'). This must be unique on this iCOMPEL. Follow
the on-screen guidance on how to compose the username.'

Permissions Check the boxes next to the permissions you wish to grant the user:

System Settings – Access to the Setup and Fonts pages.

Layout Editor – Ability to access layouts you have permitted the user to edit. Grant edit permission on the
layout Properties tab.

Subscribe Channel – Read-only access to a channel using HTTPS or HTTP.

FTP Read/Write – Read, write, and delete files in the Media folder and all its subfolders using FTP.

Status Monitor – Access to the Player and System status pages only.

Activate Channel – Permits the user to activate channels.

Ad hoc – Access to the data entry ad hoc pages (not the ad hoc content design pages). Read, write, and
modify files in the Media folder using the Ad hoc Media Folder page. If you enable this permission, you
must specify a named directory using the Media Folder setting (rather than All Folders). 

FTP Read Only – Read-only access to the Media folder and all its subfolders using FTP.

Layout Manager – Access to the Manage Layouts, Schedules, Ad hoc Entry, Newsfeeds, Tables, Colors,
and Files & Folders pages.

Publish Channel – Allows the user to publish to a channel.
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XML Control – Access to the XML message interface allowing non-browser based control of the iCOMPEL.
(Does not allow access to pages.)

Media Folder Select the user's FTP home and ad hoc media folder from the drop-down list. This prevents users from
accessing any folders above the one you specify when they log in through FTP or through the Ad hoc
Media Folder page.

Password The user's password. Repeat in the Password Confirm field.

Note: You cannot retrieve passwords. If users forget their password, you have to give them a new one. It is
strongly recommended you change the factory-supplied password for the remote user.

9.2.2 Date and Time

Use the Date and Time options to configure the time source and time zone for your iCOMPEL.

Click the tab for the option you require:

Settings – Configuring the time source and time zone.

Status – Checking current Network Time Protocol (NTP) characteristics.

Settings:

To configure the time settings, complete the following options then click the  button and reboot the
iCOMPEL:

Date and Time Settings Choose the time method to use:

Network Time Protocol (NTP) – Best for accuracy but requires the iCOMPEL to have a network
connection to an external NTP server.

Windows Compatible Network Time Protocol – Use if the NTP server is a local Windows
server.

Local System Clock – The iCOMPEL internal clock. Only use if the iCOMPEL cannot access
an NTP server. Without an external reference, the local system clock may drift.

Time Zone Setting Select the time zone for the iCOMPEL to use.

Local System Clock Settings If you chose the Local System Clock method, iCOMPEL activates this display. The values shown
are those current when you opened the Date and Time page. Adjust the date and time to those
required.

Network Time Protocol (NTP)
Settings

If you chose one of the NTP methods, you must enter the URL of at least one NTP server (three
are recommended).

Note: The iCOMPEL will only synchronize to NTP server time if the NTP time and the local system time are within a
few minutes of each other. If the difference is greater, reboot the iCOMPEL to synchronize times again.

Status:

Not displayed if you have chosen Local System Clock. Shows the latest characteristics of the NTP servers you have
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designated.

9.2.3 Network

Use the Network options to configure, check, and test the iCOMPEL network connection.

Note: The iCOMPEL displays its active IP address in large text on the splash screen during the boot up process.

Click the tab for the options you require:

Ethernet  – Configuring IP address and DNS settings.

3G Modem  – Configuring a 3G network connection.

Wireless  – Configuring a wireless connection.

Network Status  – Checking current IP address and DNS values.

Order  – Designating the preference order for using network connections.

Tests  – Running ping, trace, DNS lookup, and TCP dump tests.

Ethernet:

To configure IP addressing, complete the following information then click the  button and reboot the
iCOMPEL: 

Ethernet Settings Select how the iCOMPEL obtains its IP address:

DHCP – Select if the iCOMPEL will obtain its IP address from a DHCP server on your network. If the
iCOMPEL cannot find a DHCP server, it defaults to an IP address of 169.254.1.1.

Static – Select if you are specifying an IP address for the iCOMPEL. Enter it in the IP Address field.
If you select this option, the iCOMPEL enables the Static Address Settings and Static DNS
Settings fields.

DHCP Setting Optional. For ease of reference, enter a name for the iCOMPEL. Only available if your DHCP server supports
this feature.

Static Address
Settings

If you selected the Static Ethernet setting, enter the addresses required:

IP Address – Enter the IP address for the iCOMPEL.

Netmask – Specify the address range for the iCOMPEL subnet.

Default Gateway – Enter the gateway IP address if the iCOMPEL uses one.

Static DNS
Settings

If you selected the Static Ethernet setting, enter the addresses required:

DNS Search Path – Enter the path needed to reach the Domain Name Server (DNS).

DNS Nameserver – Enter the IP addresses of up to three DNS nameservers.

120

121

121

122

122

122



Copyright © 2010-2013 Black Box Network Services. All Rights Reserved.724-746-5500   |   blackbox.com 121

Setup

3G Modem:

If your iCOMPEL can connect to a 3G network, complete the following information then click the  button and
reboot the iCOMPEL:

Enable Select whether you want to connect by 3G or not:

Disable 3G network – The iCOMPEL will not use the 3G network.

Enable 3G network – The iCOMPEL will use the 3G network.

PPP
Authentication

If the 3G network requires authentication, enter the username and password.

PIN If the 3G network requires a PIN, enter the PIN.

Access Point
Name

If the 3G network requires an Access Point Name (APN), enter the APN.

Wireless:

Use these options to manage the iCOMPEL connections to wireless networks.

The iCOMPEL will only connect to a wireless network if:

1. You have enabled the wireless interface.

2. You have defined the wireless network settings. If you define multiple networks, you cannot specify which one the
iCOMPEL will prefer.

3. The wireless network is in range.

Wireless has its own set of tabs and you use them as follows:

Enable/Disable Select the Disabled or Enabled option depending on whether you want to use wireless or not. Click the

 button to switch:

Defined Networks Lists the networks you have already defined. Manage the networks using the buttons displayed next to each
network:

 – Click to delete this network from your list. If the iCOMPEL is currently connected to the network,
clicking this button disconnects it.

 – Click to change the network configuration. When complete, click the Save Change button to update
the details.

 or  – Displays according to the current setting for the network. Click to disable or enable
whether you want the iCOMPEL to try connecting to this network.

 – Click to connect to this network. The iCOMPEL will attempt to make the connection (if you have
enabled wireless). This breaks any existing wireless connection. If you restart the iCOMPEL, it may not
reconnect to the same network. 
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Add New Network Chose the network you want to use, complete the required information, and click the 
button:

Visible – Lists reachable wireless networks. Select the button next to the network you want to connect to. If
the network requires a network password or key, enter it in the Key field.

Other – Select if the network you want is not listed above. Enter the network SSID and select the correct Key
Type option. If the network requires a network password or key, enter it in the Key field.

IP Settings, DHCP Setting, Static Address Settings, and Static DNS Settings – You can use either DHCP
or static IP settings. For guidance on completing these fields, refer to the description of the Ethernet  tab.

Network Status:

Displays the current network connection status and values.

Order:

You can specify the order in which iCOMPEL tries to make a network connection. If a particular network is unavailable, the

iCOMPEL tries the next preference. Change the order using the  and  buttons.

Tests:

In each case, start the test by entering the host's name or IP address and clicking the  button:

Ping Host Ping the host.

Trace Route Trace the route to the host. This can take a few minutes to complete.

DNS Lookup See the host's details held on the DNS.

TCP Dump Collect IP packets for the number of seconds you specify.

9.2.4 TV & Radio

Use the TV & Radio options to configure the iCOMPEL to tune and use TV and radio stations.

Note: Some features may depend on installed feature keys or hardware. Consequently, your iCOMPEL may not display
all of the tabs and options described here.

Click the tab for the option you require:

Rebroadcaster Settings  – Configuring TV rebroadcasting.

Digital Tuning  – Tuning and auditioning digital TV and radio stations.

Analog Settings  – Adding, naming, and managing analog TV stations.

Capture Tests  – Testing the Composite and S-Video capture inputs.

Streaming TV & Radio  – Specifying and checking multicast addresses.

TV System  – Specifying and checking the TV system for your locale.
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Rebroadcaster Settings:

To configure rebroadcasting, complete the following information then click the 
button: 

Enabled Check the Rebroadcast a Digital Station option to enable rebroadcasting. If you enable it, the iCOMPEL TV

card is disabled for analog TV, digital TV and radio, and Composite and S-Video capture.

Station Check the TV or Radio option and select the station from the drop-down list.

Stream As Enter a descriptive name for the station. This is the name that is visible in streaming announcements for other
iCOMPEL players to pick up. If you use a generic name, you can configure a different station here and the
other iCOMPEL players will pick it up by referencing the same generic name.

Media Streams Check the streaming option that best matches your requirements.

Stream Address Specify the address the client needs to listen to for the broadcast.

Port Specify the port number the client needs to listen on for the broadcast.

TTL Enter the number of hops required. For example, 1 means the stream will reach the network. Increase the TTL
by 1 for each multicast router the stream has to pass through.

SAP Address Enter the address that the iCOMPEL sends SAP announcements to.

Digital Tuning:

If you have completed the tuning process before, the iCOMPEL displays a list of the tuned stations. To audition a station,

click its  button (the iCOMPEL auditions it on the screen and stops showing the scheduled layout).

To scan for and tune to digital TV and radio stations, follow these steps:

1. Click the  button. The iCOMPEL starts scanning for digital TV and radio stations. This
takes approximately 8 to 20 minutes depending on circumstances. During the process, the iCOMPEL displays a
progress notice on the screen instead of the scheduled layout.

2. After the iCOMPEL completes the scan, click the  button to store the channel list or click the

 button to revert to a previous channel list.

3. If you wish, click the  button to audition any of the new stations on the screen.

Analog Settings:

If you have selected analog stations before, the iCOMPEL displays a list of the stations. To audition a station, click its 

button (the iCOMPEL auditions it on the screen and stops showing the scheduled layout). To delete a station, click its 
button.

To add a station, follow these steps:

1. Select a channel from the drop-down list.

2. Enter a name to identify in the field next to the list.



Copyright © 2010-2013 Black Box Network Services. All Rights Reserved.724-746-5500   |   blackbox.com 124

iCOMPEL Digital Signage User Guide (V9.2.3)

3. Click the  button.

4. If you wish, click the  button to audition the new station on the screen. 

Capture Tests:

Click the  button to audition the capture feature indicated. 

Streaming TV & Radio:

If the iCOMPEL cannot receive a TV signal directly, you might be able to deliver the TV signals by multicast streams using
the local network. The iCOMPEL decodes the multicast stream and displays the TV image in a zone in the normal way.

If you want to use multicast streams there are these requirements:

An additional feature unlock key.

A streaming transmit server to convert the TV signals into multicast packets.

All routers and switches on the local network between the streaming transmit server and each iCOMPEL enabled for
multicast streaming. 

Sufficient network capacity to efficiently support multicast streaming.

Note: There may be copyright issues involved in rebroadcasting material onto a local network. 

Click the Status tab to display a list of stations available through streaming. Click the  button to audition a station on
the screen.

Click the Settings tab to specify the multicast addresses by following these steps:

1. Specify the range of addresses on which to receive the Service Advertising Protocol (SAP) packets by entering the start
address and end address in the respective fields. Valid addresses are between 224.0.0.0 and 239.255.255.255.

2. If required, specify additional address ranges in the following rows.

3. Click the  button.

TV System:

Different countries use differently configured TV systems. You need to specify your country so that the iCOMPEL can
configure itself correctly.

Select your country from the drop-down list and click the  button. The iCOMPEL now restarts to
complete the configuration.

9.2.5 HTTP Proxy

Use the HTTP Proxy page to set up proxy server access if the iCOMPEL needs to use one to access Internet resources.
Check with your network administrator to see if a proxy is needed.

To use a proxy for accessing an Internet resource, you must perform both of the following actions:

Set up the HTTP proxy by completing the information on the Add HTTP Proxy tab.

Specify that the iCOMPEL must use a HTTP proxy when you setup individual Internet resources (for example, a
newsfeed).
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After you have configured the HTTP proxy, specify that the iCOMPEL uses it on the relevant setup page:

HTML player – Setup on the Setup > Player > Players page.

Channel subscription – Setup on the Channels > Manage Channels page.

Newsfeed – Setup for the individual newsfeed on the Media > Newsfeeds page.

Reporting – Setup on the Setup > System > Reporting & Remote Setup page.

Software update – Setup on the Setup > Maintenance and Troubleshooting > Software Update page (Settings tab).

The iCOMPEL does not transfer a proxy configuration in a channel.

Note: Newsfeeds and channel subscription do not support use of Microsoft NTLM authentication. We recommend
changing the Windows proxy to allow Digest authentication. You must restart the iCOMPEL when you make any
changes to the HTTP proxies.

To configure the HTTP proxy, complete the following information then click the  button: 

Server Address Enter the IP address of the proxy server.

Server Port Enter the port the iCOMPEL needs to connect to on the proxy server (default is 3128).

Username If the proxy server requires authentication, enter the username.

Password If the proxy server requires authentication, enter the password.

Use this proxy for Check the box for each resource the iCOMPEL needs to use the proxy for.

9.2.6 Security – General Settings

Use the Security options to configure the iCOMPEL firewall and other security services and to monitor firewall activity.

Caution: The iCOMPEL comes ready-prepared with default firewall and other security service settings to protect
against unauthorized access. Do not change the security settings unless you have a good working knowledge of IP
networking and network security. Incorrect configuration can block all access to the iCOMPEL.

The iCOMPEL firewall protects it against unwanted and potentially malicious traffic. However, the iCOMPEL also needs to
accept your login and allow necessary communications. To allow and protect such access, the iCOMPEL supports a
variety of secure services:

VPN – Virtual Private Network. Allows the iCOMPEL to communicate over an encrypted path through firewalls. 

HTTP/HTTPS – Hypertext Transfer Protocol and Hypertext Transfer Protocol Secure. HTTP encrypts passwords but
HTTPS is more secure because it also encrypts content.

FTP – File Transfer Protocol. FTP access is controlled by password. Passwords are not encrypted. Use FTP for copying
over backups and software updates. 

SSH – Secure Shell. Only used to access the iCOMPEL kernel for occasional support and maintenance purposes.
Access is by the master password.

You can configure each of those to match the specific security needs of your network or to conform to corporate policy on
port numbering.
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Click the tab for the option you require:

Firewall  – Examining and configuring the firewall and other security services settings.

Master Password  – Changing the iCOMPEL master password.

LDAP  – Detailing access control using the Lightweight Directory Access Protocol.

LDAP Expert  – Entering XML-based LDAP parameters. (Only displayed if you have set the User Interface Policy to
Expert.)

Firewall Status  – Monitoring the detailed firewall activity report.

LDAP Tests  – Testing your LDAP configuration.

SSL Certificates  – Using customized Secure Socket Layer certificates.

Firewall:

The Firewall tab allows you to examine and configure the firewall and other security service settings.

To change your security settings, complete the relevant options then click the  button and reboot the
iCOMPEL:

Firewall Service
Settings

IP Address Filtering – Default: Disabled. Check this box to prevent any access to the iCOMPEL except from
the Allowed IP Addresses.

Allowed IP Addresses – Enter the IP addresses that can access the iCOMPEL, not forgetting to include
your own. To allow more than eight IP addresses, specify a range using the standard syntax (for example,
entering 192.168.1.0/24 allows access for all IP addresses between 192.168.1.0 and 192.168.1.255).

HTTP Service
Settings

Supported Protocols – Default: HTTP and HTTPS. Select either HTTP or HTTPS to restrict access to that
protocol. You cannot manage the iCOMPEL without either HTTP or HTTPS enabled.

HTTP Ports – Default: 80. Modify or add if you want your iCOMPEL to accept HTTP connections through
different ports.

HTTPS Ports – Default: 443. Modify or add if you want your iCOMPEL to accept HTTP connections through
different ports.

FTP Service
Settings

Service State – Default: Enabled. Uncheck this box to disable FTP access.

Supported Protocols – Default: FTP. There are no other options.

FTP Ports – Default: 21. Modify or add if you want your iCOMPEL to accept FTP connections through a
different port.

Passive Port Range – Default: 59000-59009. Modify the Low Port and High Port values to specify a different
range.

Transfer Rate – Default: Limit to 2500 KiB/Second. Modify the Limit to value to specify a different transfer
rate.

SSH Service
Settings

SSH Ports – Default: 22. Modify or add if you want your iCOMPEL to accept FTP connections through a
different port.

Movie Player Service State – Default: Disabled. Check this box to enable the unicast listener service.
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Unicast Listener
Service Settings

Listening Ports – Specify the ports the iCOMPEL listens on.

Master Password:

The Master Password tab allows you to change the master password. You need the master password to access the
iCOMPEL kernel through SSH.

Note: This is not the same password you use to login to the iCOMPEL through a browser. 

It may be desirable to change the master password, but you must know the existing one to do so. Please contact Black
Box Technical Support at +1 (724) 746-5500 or info@blackbox.com for the master password.

To enable the new password, you must click the  button and reboot the iCOMPEL.

LDAP:

See Security – Advanced LDAP Settings . for details.

LDAP Expert:

See Security – Advanced LDAP Settings . for details.

Firewall Status:

The Firewall Status tab displays the detailed iCOMPEL firewall activity report.

Understanding the information in that report requires a good working knowledge of IP networking and network security. In
particular, note these points:

The Chain PLAYER-INPUT section details the rules governing connections made to the iCOMPEL on various protocols.

The iCOMPEL checks the IP address of incoming connections against the Chain PLAYER-INPUT-ADDRESSES rule
set. iCOMPEL drops connections from IP addresses disallowed by security settings.

The iCOMPEL checks allowed connections against the Chain PLAYER-INPUT-PORTS rule set. iCOMPEL drops
connections to a port disallowed by the security settings.

The Pkts (packets) and Bytes columns show the volume of traffic accepted or rejected by each rule. An unusually high
number of packets on a DROP line might indicate an attack on the iCOMPEL.

LDAP Tests:

Run the LDAP test to check your current LDAP settings and to receive feedback on any problems. 

Recommendation: Always test any change to the LDAP settings before rebooting the iCOMPEL. 

To run a test:

1. Enter the name of the target iCOMPEL user in the Test Username field.

2. Click the  button. 

The test results are displayed in two parts: 

A table showing the status of each step.
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A detailed log. 

When you have a correct setup, and the iCOMPEL username is valid, the LDAP test returns the Passed status. To correct
any indicated problems, check the user permissions and change the associated LDAP settings. 

The iCOMPEL performs the following tests and indicates any failures as well as displaying detailed log messages: 

Test Checks

Bind to LDAP server Configuration and Bind sections

Search for FTP user FTP User section

FTP Read/Write Access FTP User section User Filter

Search for HTTP user HTTP User section

Find HTTP user HTTP User section

Search for group membership HTTP Permissions section

Ad hoc Permissions Ad hoc Users section

SSL Certificates

If you want to use customized SSL certificates, rather than the default certificates, follow these steps:

1. Select the Use Custom SSL certificates for the Web Server option.

2. Enter your Certificate, Key, and CA Chain values in the relevant fields.

3. Click the  button and reboot the iCOMPEL:

9.2.7 Security – Advanced LDAP Settings

The iCOMPEL Security page includes tabs to allow you to configure and test LDAP:

LDAP – Detailing access control using the Lightweight Directory Access Protocol.

LDAP Expert – Entering XML-based LDAP parameters. (Only displayed if you have set the User Interface Policy to
Expert.)

LDAP Tests – Testing your LDAP configuration.

Caution: Do not use LDAP to control security for the iCOMPEL unless you have expertise with LDAP implementations.
LDAP is a powerful technology and enabling a misconceived configuration can make the iCOMPEL unusable. 

Before beginning to configure security for the iCOMPEL using the options on the LDAP and LDAP Expert tabs, read
through the guidance that follows. When you have completed your configuration, click on the LDAP Tests tab to test it
before rebooting the iCOMPEL (see LDAP Tests  for details).127
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To begin with, it is important to understand the difference between the iCOMPEL and the LDAP security models:

The basic iCOMPEL security model prevents access to system features unless a user is authenticated and has explicit
permissions. 

In the LDAP security model, a user is considered to have permission if an LDAP filter matches entries in the directory.
Typically, an LDAP filter establishes that a user is a member of a group. 

Caution: If you use LDAP, the authentication method switches to HTTP Basic authentication (passwords are not
encrypted). If this is a concern, communicate over HTTPS.

What follows is guidance for completing each of the fields on the LDAP tab:

Configuration

Fallback User

Bind

FTP User

HTTP User

HTTP Permissions

Ad Hoc Users

Configuration:

You must check the Enable LDAP box to allow the iCOMPEL to use LDAP. 

You must enter the Primary LDAP Server hostname and port and choose the Server Encryption.

The Server Encryption types are: 

None – No encryption (passwords are sent in clear text) (standard LDAP port is 389).

SSL – iCOMPEL encrypts all communications with the LDAP server using SSL (standard LDAP port is 636).

TLS – iCOMPEL encrypts all communications with the LDAP server using TLS (standard LDAP port is 389).

The Certification Authority (CA) Certificate is required when SSL or TLS encryption is used. The certificate is required to be
in PEM format. 

Note: Microsoft Active Directory does not support LDAP over TLS and by default LDAP requires additional configuration
of the Active Directory server. 

Fallback User:

The fallback user can always login to the iCOMPEL and perform management tasks, even when LDAP authentication is not
working. 

Enter the username and password that you wish to use to manage the iCOMPEL in the event of problems with the LDAP
setup. 

Recommendation: Use a very strong password for the fallback user password. 

Bind:

Select Allow Anonymous Bind to use anonymous binding to the LDAP server. Otherwise select Bind using DN and
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complete the Bind Username and Bind Password. 

For example, the bind username is a distinguished name (DN) like: cn=Manager,dc=yourdomain,dc=com. 

FTP User:

The information in this section is used to authenticate users and give them permission to gain FTP read/write access to the
iCOMPEL. You will need to know how to find the user object in the directory that corresponds to the username given to
FTP.

For Scope, select Subtree or One level depending on how you want to limit the search for the user object starting from
the Base DN.

Enter the Base DN in the appropriate format for your implementation.

Set the Login Username Attribute to an attribute that will contain the username given to FTP. This is typically as
described for the relevant context:

Active Directory – Typically, the sAMAccountName attribute. 

Posix Scheme Directory – Typically, the uid attribute. 

In the User Filter field, enter the LDAP filter that will match a user object in the directory (use %s where you wish the filter
to contain the username of the user that is logging in). 

Recommendation: If possible, add checks for group membership to control which users can access FTP on the
iCOMPEL.

Example user filters for the relevant contexts are:

Active Directory – (&(sAMAccountName=%s)(objectclass=user)(memberOf=CN=iCOMPEL ftp access,OU=Security
Groups,DC=yourdomain,DC=com)). 

Posix Scheme Directory – (&(uid=%s)(objectclass=posixAccount)) 

HTTP User:

The information in this section is used to authenticate users to use the web interface of the iCOMPEL. Permissions are set
in the next section. You will need to know how to find the user object in the directory that corresponds to the username
given to HTTP. 

For Scope, select Subtree or One level depending on how you want to limit the search for the user object starting from
the Base DN.

Enter the Base DN in the appropriate format for your implementation.

Set the Login Username Attribute to an attribute that will contain the username given to HTTP. This is typically as
described for the relevant context:

Active Directory – Typically, the sAMAccountName attribute. 

Posix Scheme Directory – Typically, the uid attribute. 

In the User Filter field, enter the LDAP filter that will match a user object in the directory (use %s where you wish the filter
to contain the username of the user that is logging in). Example user filters for the relevant contexts are:

Active Directory – (objectclass=user). 
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Posix Scheme Directory – (objectclass=posixAccount).

In the Display Name Attribute field, enter a name for the user for the iCOMPEL to use in the banner. This is typically as
described for the relevant context:

Active Directory – Typically, the displayName or sAMAccountName attribute. 

Posix Scheme Directory – Typically, the cn or uid attribute. 

HTTP Permissions:

After a user has been authenticated to access the iCOMPEL web interface through HTTP, the iCOMPEL will check the
user's permissions.

For Scope, select Subtree or One level depending on how you want to limit the search for the user object starting from
the Base DN.

Enter the Base DN in the appropriate format for your implementation.

Enter the Filter Attribute appropriate to your context. Example filter attributes for the relevant contexts are:

Active Directory – dn

Posix Scheme Directory – uid

You can set up these permission filters:

Monitor Access Filter Access to player status and system information only.

System Settings Filter Access to the Setup menu and Fonts page.

Layout Manager Filter Access to the Layouts, Schedules, Ad hoc Entry Page, Newsfeeds, Tables, Colors, and
Files & Folders menus

Layout Editor Filter Access to the graphical layout editor.

Publish Channel Filter Access to the Publish Channel menu.

Activate Channel Filter Access to the Activate Channel option.

XML Control Filter Access to the XML message interface allowing non-browser based control of the
iCOMPEL only. (Provides no access to menu options.)

Set those to LDAP filters that match the user's permissions. Use %s where you wish the users username to be written into
the filter.

Typically, the filter checks that the user is a member of a group. Example permission filters for the relevant contexts are:

Active Directory – (&(objectClass=group)(member=%s)(distinguishedName=CN=player monitor,OU=Security
Groups,DC=yourdomain,DC=uk)).

Posix Scheme Directory – (&(objectClass=posixGroup)(memberUid=%s)(cn=monitor)).

Ad Hoc Users:

Click the button to add an ad hoc user and to set the filters for them as required.
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9.2.8 Player Local Information

Use the Player Local Information page to add, delete, or modify data items for customizing the iCOMPEL behavior.
Examples include the following features:

Conditional play – Add data that the iCOMPEL checks to determine which playlist items or schedules to play.

Localize HTML pages – Add data that the iCOMPEL uses to localize output from web pages.

Configure a weather widget – Specify the current location to customize a weather widget display.

Any change you make to the player location information can have an immediate effect on the currently playing item.

These examples further expand and illustrate how you might use player local information:

Design general channel content that also allows each iCOMPEL to play specific content. For example, if your company
has branches in different countries, you could use player local information to specify each location in ISO format. A
weather widget you install checks that value and provides a localized weather forecast.

Design general channel content but that uses conditional play to control the media and schedule for individual iCOMPEL
units. For example, you could create the same channel content for all branches of a chain store but use player local
information to control conditional play items in that content. You could play content in each store based on the profile of
customers visiting that store (using conditional play for playlist items). You might also display specific opening hours for
a store (using conditional play for one or more schedules).

When you enable reporting, the iCOMPEL includes player local information in its reports to the iDM and you can use this
for whatever purpose you wish. For example, you could use player local information for asset tracking purposes by
storing the player's address and asset tracking identifier. If there is a problem, it is easy to determine the location of the
player based on iDM reports.

9.2.9 Reporting & Remote Setup

Use the Reporting & Remote Setup options to configure how your iCOMPEL reports status information to the iDM.

Note: Some features may depend on installed feature keys.

You can configure your iCOMPEL to send reports to the iDM using any of HTTP, HTTPS, or VPN. However, if you want to
use some or all of the remote setup features you must configure your iCOMPEL according to these settings:

Report using VPN – Allows the iDM to remotely control your iCOMPEL (and optionally connect to it over SSH).

Report using VPN and enable the Remote Setup option – The above plus your iCOMPEL can accept setups from and
donate its setup to the iDM.

Report using HTTPS and enable the Remote Setup option – Your iCOMPEL can accept setups from but cannot donate
its setup to the iDM.

Click the tab for the option you require:

Reporting Settings – Enabling and configuring reports.

Status – Checking reporting states and events.

Remote Setup Settings – Enabling and configuring remote setup.
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Reporting Settings:

To configure reporting, complete the following information then click the  button (you must also reboot the
iCOMPEL if you change the Reporting or SSH settings): 

Reporting Check the button for the reporting option you want:

Status reporting is disabled – The iCOMPEL does not send reports.

Report status to a iDM via HTTP – The iCOMPEL sends report using HTTP or HTTPS.

Report status to a iDM via VPN – The iCOMPEL sends report using VPN.

Screen
Thumbnails

Check the box for the iCOMPEL to include a thumbnail of its current display in the report. This increases the
bandwidth required for each report.

Media Auditing Check the button for the media audit reporting option you want:

Do not send media audit logs to the iDM – The iCOMPEL does not send media audit reports.

Send media audit logs every – Specify how often you want the iCOMPEL to send media audit reports.

Send media audit logs every day at – Specify the time when you want the iCOMPEL to send media audit
reports only once a day.

Reporting Interval Specify how often you want the iCOMPEL to send a report. The minimum interval is 5 seconds.

Report to iDM via
HTTP

Select whether the iCOMPEL sends reports using HTTP or HTTPS. Enter the name or network address of the
iDM in the field (optionally with the required port number appended after a colon).

Report to iDM via
VPN

Enter the name or network address of the iDM in the field (optionally with the required port number appended
after a colon).

Check the Allow SSH access via VPN box to allow the iDM to connect to the iCOMPEL over SSH.

Authentication Enter the username and password for the reporter account on the iDM.

Proxy Check the Use proxy if configured box if the iCOMPEL has to send reports through a proxy. You must have
already configured the proxy (see HTTP Proxy  for details).

Remote Setup Settings:

To configure remote setup, complete the following information then click the  button and reboot the
iCOMPEL: 

Remote Setup Check the Enable remote setup for this player box to allow the iCOMPEL to report its setup to and receive
setup updates from the iDM. 

Categories Check the boxes for the categories of setup you want the iCOMPEL to report or donate and for which it will
accept updates. 

Note: You cannot select the Channel category when the iCOMPEL is a publisher.
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9.2.10 Feature Keys

Certain features beyond the normal capabilities of the iCOMPEL are licensed. This page allows you to view currently
installed feature keys and to add new feature keys.

The Licensing tab shows a summary of all installed feature keys, while the Status tab shows all currently licensed
features.

The Add License tab allows you to add new feature keys.

Note: The iCOMPEL must be rebooted for newly installed features to become available.

9.3 Player Setup

Use the Setup > Player options to configure, check, and test the iCOMPEL player settings.

Select the menu item for the option you require:

Audio  – Setting the volume and source of sound.

Screen  – Configuring characteristics of the display screen.

Players  – Enabling HTTP proxy, flash, and XML web service options.

RS-232 Outputs  – Configuring and adding RS-232 items.

Interactivity  – Configuring touch screen, RS-232, and remote keypad interaction.

International  – Designating country and language preferences for screen output.

9.3.1 Audio

Use the Audio page to set the sound volume and output type.

Click the tab for the option you require:

Settings – Enter the settings you require and click the  button to enable them:

o Master Volume – Set the master output volume as a percentage of maximum (100%) output level. You specify

individual item volumes as a percentage of this master volume. (Only applies to the analog output.)

o Input Level – Set the input level as a percentage of maximum (100%) input level.

o Audio Output – Select the output type from the drop-down menu.

Status – Indicates if audio is muted or not.

Tests – Click the  button and the iCOMPEL sends audio test signals so you can hear how the setup sounds.
Running the test stops the currently playing media. To stop the test and restart the media, click the 

 button.

9.3.2 Screen

Use the Screen options to set the screen resolution and orientation and to test its performance.

Click the tab for the options you require:

Settings – Changing the screen settings.
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Status – Displaying a summary of the screen's Extended Display Identification Data (EDID), including screen resolution.

Tests – Testing different aspects of screen performance.

Before setting up your screen, you need to understand the Layout Canvas Size setting and understand its application
when designing your content.

You use the layout canvas size setting to: 

Define the size of the display space on which the iCOMPEL will render your layouts.

Define the design space for the layout editor tool.

Specify the screen resolution if the iCOMPEL cannot read it automatically.

Follow these best practice principles when designing your content:

Decide on your desired output resolution (typically, 1360 x 768 or 1920 x 1080).

Set the layout canvas size to match that output resolution.

Choose or design layouts to fit that layout canvas size.

If your content will be distributed in a channel, set all the screens involved to the same layout canvas size.

The iCOMPEL configures the screen by plug-and-play, using values obtained from the screen's EDID information. If the
screen does not include a preset display mode matching your layout canvas size, the iCOMPEL automatically scales the
layout to fit the screen as best it can. In that case, so long as your layout fills the layout canvas size, the iCOMPEL will
display all of your layout though some of the screen may remain unused.

If the iCOMPEL is unable to obtain EDID values, it outputs at the same resolution as the layout canvas size and uses the
fallback timings you provide on the Settings tab. This can occur because your screen is connected through a VGA
extender or distribution amplifier that does not support EDID or DDC. Otherwise, fallback timings should only be needed for
VGA screens as all digital interface specifications mandate plug and play support.

Note: Only connect one screen to the iCOMPEL at a time.

Settings:

To configure your screen, complete the following information then click the  button: 

Layout Canvas
Size

Specify the dimensions you want for your layout canvas size in pixels:

Width – Whole numbers in the range 640 to 2000.

Height – Whole numbers in the range 480 to 2000.

Orientation Specify the orientation of the display relative to the screen by selecting from the drop-down list:

Landscape - Top edge at top – Default. Corresponds to 0 degrees of rotation.

Portrait - Left edge at top – Corresponds to 90 degrees of rotation.

Portrait - Right edge at top – Corresponds to 270 degrees of rotation.

Landscape - Bottom edge at top – Corresponds to 180 degrees of rotation.

Fallback Timings Select and complete the fallback timings appropriate to your screen: 
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VESA CVT Timings – The width and height are taken from your layout canvas size. The iCOMPEL calculates

timing information using the standard VESA CVT formula. Always use Normal Blanking for CRT screens.
Try Reduced Blanking for flat-screen displays.

Custom Timings – For advanced users only. The width and height are taken from your layout canvas size.
Enter your required values for the indicated timing characteristics.

Target Frame
Rate

The iCOMPEL set this to provide the best results for the hardware available. Select an alternative rate if that
causes problems. 

Status:

The iCOMPEL lists its available screen connection ports and details of the connected screen. 

Tests:

Click the  button for the test you want to run on your screen:

Alignment

Checker board

Color bars

Grey scale bars

Horizontal lines

Vertical lines

Be aware of these characteristics:

Tests run immediately and interrupt the currently scheduled display.

Tests run indefinitely until you stop them. Stop a test by running another test or by clicking the 
button to resume the scheduled display.

9.3.3 Players

Use the Players page to adjust the settings for the iCOMPEL HTML player type.

To configure the HTML player settings, complete the following information then click the  button:

HTTP Proxy Specify whether the iCOMPEL has to use a HTTP proxy to access the Internet:

No Proxy required – The iCOMPEL connects directly to the Internet and does not use a proxy to do so.

Use proxy – A proxy is required. Select the proxy to use (you must have already defined the proxy. See HTTP
Proxy  for details). If the iCOMPEL can also connect to some Internet resources directly, specify their
address or URL in the No proxy for field. 

Trust Local Flash Select the trust level for local flash:

Restrict disk based flash from reading local data and accessing cross-domain urls – Default
and safest option. Select if flash content does not require cross-domain access to data or to read
local files.
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Allow disk based flash to read local data and communicate with internet – Select if flash
content requires cross-domain access to data or needs to read local files.

XML Web
Services External
URL Access

Select whether the HTML player can access external web sites:

Allow XML web services to access external sites – The HTML player can access external sites. 

Do not allow XML web services to access external sites – The HTML player cannot access
external sites.

9.3.4 RS-232 Outputs

Use the RS-232 Outputs options to add and manage RS-232 items.

If your iCOMPEL includes an RS-232 interface, you can use it to send RS-232 strings or RS-232 outputs to control an
external, RS-232 enabled device. You do this by creating RS-232 items on the iCOMPEL. 

The RS-232 item consists of one or more of these properties:

The voltage level for either or both of the RS-232 output lines.

An RS-232 hexadecimal control string.

The event causing the iCOMPEL to execute the item.

Click the tab for the option you require:

Items – Listing the RS-232 items already defined on the iCOMPEL.

Add Item – Adding a new RS-232 item.

Configuration – Accessing the RS-232 configuration options, including baud rate, data bits, stop bits, and parity.

The iCOMPEL can execute an RS-232 item in a playlist or automatically at one of the following events:

Screen is muted or unmuted.

Audio is muted or unmuted.

A specified layout starts or completes.

You have to specify the condition when you create the item: you cannot change it later. 

Note: You can only create one RS-232 item for each of the conditions.

If your iCOMPEL is a publisher, the RS-232 Items are published as part of the channel and are downloaded to subscriber
players. However, the iCOMPEL provides an override so you can designate an RS-232 string or configuration to use locally
that is different from that defined in the channel's RS-232 item.

Items:

For each item, you can take these actions:

Click the  button to delete an item.

Click the  button to review or modify an item's properties. Click the  button to enable any modifications.
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Note: If you have enabled Send RS-232 String Action for the item, a subscriber or publisher iCOMPEL also displays
the Local Override section. This allows you to enable and define a local RS-232 string for the item separate from the
one defined in the channel.

The Last Response section details the response received the last time the iCOMPEL executed this item. Click the
Execute RS-232 String button to have the iCOMPEL execute the RS-232 item immediately and display any response
string.
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Add Item:

To create the RS-232 item, complete the following settings and click the  button:

Name Enter a name to uniquely identify this RS-232 item.

Perform Enabled Actions when Specify when the iCOMPEL executes the RS-232 item (in a playlist or automatically at
the event you specify).

Send RS-232 String Action Check the Send RS-232 String Action box to enable the iCOMPEL to send the RS-232
string you specify. Clearing the box disables it.

RS-232 String (as Hexadecimal) Enter the RS-232 string you want the iCOMPEL to send (in hexadecimal).

DTR (Data Terminal Read) Action Check the Set DTR level box to enable the iCOMPEL to set the DTR line voltage to the
option you select. Clearing the box disables it.

RTS (Ready To Send) Action Check the Set RTS level box to enable the iCOMPEL to set the RTS line voltage to the
option you select. Clearing the box disables it..

Configuration:

Configure the iCOMPEL RS-232 transmission to match the settings of the connected RS-232 equipment. To configure

RS-232, complete the following settings and click the  button:

Bits per Second – Select the baud rate from 110 to 460800.

Data Bits – Select either 7 or 8 data bits.

Stop Bits – Select either 1 or 2 stop bits.

Parity – Select the parity as none, odd, or even.

Note: If your iCOMPEL is either a subscriber or publisher, it also displays the Local Override section. This allows you
to enable and define a local RS-232 configuration separate from the one defined in the channel.

9.3.5 Interactivity

Use the Interactivity page to program the iCOMPEL to respond to input from user-interaction devices.

Click the tab for the option you require:

Touch – Setting up and calibrating touch-sensitive screens.

RS-232 Inputs – Configuring and enabling responses to inputs through the RS-232 port.

Remote Keypad – Programming the actions associated with the buttons on the remote control.

Note: Some features may depend on installed feature keys.

Touch:

The Status field indicates the current state of the touch system:

No touch screen is connected.
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Touch screen is connected but is not calibrated.

Touch screen is available. (The touch screen is only usable when the iCOMPEL displays this status.)

After you have connected a touch screen, you must calibrate it by following these steps:

1. Click the  button.

2. On the touch screen, carefully press your finger on the center of each of the three crosshairs as they appear.

3. Touch the Press to finish message in the center of the screen.

4. On your browser, if necessary adjust the Drag Threshold value (see below).

5. Enter a name for the screen in the Name field (only displayed after the screen is calibrated).

6. Click the  button.

You can cancel the calibration by clicking the Cancel Touch Calibration button on the Calibrating Touch Screen page.
The iCOMPEL will also cancel calibration automatically if:

You do nothing for 60 seconds.

You or the iCOMPEL activates a layout.

You audition an item.

If the calibration process does not complete successfully, the iCOMPEL uses a previously successful calibration or leaves
the screen in an uncalibrated state.

When you perform the calibration, the iCOMPEL estimates a Drag Threshold using the difference between your press and
release on the three calibration crosshairs. The drag threshold is the minimum number of screen pixels distance between
the press and the release to interpret your action as a press-drag-release, rather than a press-release. This is particularly
important when the iCOMPEL passes touch events to a displayed web page, as typically a press-release is required. 

You may need to adjust the drag threshold to take account of the media the iCOMPEL will display and the intended users.
To do so, enter the required value in the Drag Threshold field.

RS-232 Inputs:

The iCOMPEL can respond to voltage changes on the following RS-232 inputs:

Clear To Send (CTS).

Data Carrier Detect (DCD).

Data Set Ready (DSR).

Ring Indicator (RI).

Click the  button to view and edit the properties for each input required:

Enabled – Indicates the availability of the input for use on the iCOMPEL.

Name – The name to use for this input when referencing it elsewhere in the iCOMPEL. 

In addition, there are two informational properties:

Current Level – Indicates the current state of the input (positive or negative voltage). 

Used By – Indicates the zones and layouts that use the input. 
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Remote Keypad:

The iCOMPEL can respond to button presses on a infra-red controller or remote keypad. The buttons are:

Volume up and down – Adjusts the master volume level up and down in 10% divisions. The iCOMPEL indicates the new
volume at the top right of the screen.

Station up and down – Selects the next station up or down in the list of available ad hoc TV or radio stations. The
iCOMPEL indicates the new station, or that none are available, at the top right of the screen.

Four programmable buttons: A, B, C, D – Provides interaction with layout and playlists. If you have not programmed the
button with an action, the iCOMPEL reports that in a message at the top right of the screen.

The status message on the Remote Keypad tab indicates if the iCOMPEL has the infra-red receiver connected or not. The
iCOMPEL requires the infra-red receiver to enable it to received remote keypad inputs.

9.3.6 International Settings

Use the International page to choose language and country preferences for the screen output. You should choose the
setting that best matches the expectations of those viewing the screen.

Note: These are different from the language and localization settings of the user interface, which are determined by the
browser settings.

The settings on the International page are used by:

The HTML player – To provide a preferred language and locale to web sites that support localization.

The text clock – To determine locale-specific date and time formats if you have not specified explicit formats.

9.4 Backing Up Your Player

In case of problems, you should maintain regular backups of the media content files and settings that your iCOMPEL uses.
See Backup Contents  for details of what is backed up.

Use the Setup > Maintenance & Troubleshooting > Backup & Restore page to create and save the backup files. You
save the files on a USB device attached to the iCOMPEL (for example, a USB stick or external disk drive, depending on
how much space your backup needs). If needed later, you can restore those files and settings onto this or another
iCOMPEL.

To create a backup:

1. Attach a USB device to the iCOMPEL.

2. On the menu bar, click Setup and select Maintenance and Troubleshooting > Backup & Restore.

3. Click the Create Backup tab.

4. If you want to create a new folder to hold the backup:

a. Enter the folder name in the Named field.

b. Click the  button.

c. Click the new folder's link to specify it as the backup location.

5. Click the  button. It can take several minutes for the iCOMPEL to create the backup.
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6. When the backup process finishes, remove the USB device.

To restore a backup:

1. Attach the USB device containing the backup to the iCOMPEL.

2. On the menu bar, click Setup and select Maintenance and Troubleshooting > Backup & Restore.

3. Click the  button next to the backup you want to restore.

4. Wait for the iCOMPEL to reboot after the restore process finishes.

5. Remove the USB stick.

If you wish to restore media content onto a different iCOMPEL that does not have the Backup & Restore page, then there
are two methods available:

Using the options on the Manage Channels page – Use for a player that is part of your signage network or to transfer
media content between networked systems. See Configuring the Publisher  for more details.

Using the options on the Layout Packages page – Use to create files that you can store on or transfer to a different
iCOMPEL. See Creating a Layout Package  for more details.

9.5 Software Update

You can access the Software Updates page from the Setup > Maintenance and Troubleshooting menu.

Use the Software Update options to check the latest update status and to configure whether the iCOMPEL performs
updates automatically or not. Please contact Black Box Technical Support at +1 (724) 746-5500 or info@blackbox.com for
more information on available updates.

Note: It is not possible to install an earlier software version than the one currently installed. The currently installed
version is shown highlighted.

Click the tab for the option you require:

Update Status – Checking details of the last update, how the iCOMPEL checks for updates, and if any new updates are
available.

Settings – Configuring or disabling automatic updating.

Manual Update – Performing a manual update from a downloaded file.

Caution: Never turn off the power to the iCOMPEL while it is installing an update. It can take 30 minutes to install a
large update.

Update Status:

The display contains the following information:

Last Update Messages Describes the most recent update.

Status Indicates whether or not the iCOMPEL is allowed to check for updates. If it indicates it is not
allowed, this is because you have either selected Turn off automatic update or have set a
Download Allowed period that does not include the current time. 

Last Checked for updates Indicates when the iCOMPEL last checked for updates.
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Update File Indicates if an update is available or not. If one is, this displays details of the file if it has not yet
been installed.

Update Description A description of what the update listed above provides. (Not displayed if there is no update
available.)

Progress Contains a progress bar during a download. After a download completes, indicates that an
update is ready for installation at the next reboot. (Not displayed if there is no update
available.)

Settings:

To configure software updating, complete the following options and click the  button:

Update Mode Choose how you want automatic updating to work:

Automatically download and install updates

Check for new updates but do not download or install them 

Turn off automatic update 

Reboot Allowed Only activated if you have chosen Automatically download and install updates. Specify the
day and time when the iCOMPEL can reboot to install an update. 

Download Allowed Not activated if you have chosen Turn off automatic update. Specify the day and a time slot
when the iCOMPEL can download an update.

Update Server URL Not activated if you have chosen Turn off automatic update. If different from the default,
specify the URL where the iCOMPEL checks for updates.

Check Interval Not activated if you have chosen Turn off automatic update. Specify how often the iCOMPEL
checks for updates (in hours and minutes).

Authentication Not activated if you have chosen Turn off automatic update. If the update server requires
authentication, enter the details here.

Manual Update:

Confirms the version of the software currently installed on the iCOMPEL. 

If you have manually downloaded an update and wish to install it, follow these steps:

1. Click the  button and navigate to the update file location.

2. Select the file and click the  button

3. Click the  button.

4. Follow the on-screen instructions.
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9.6 Reboot System

You can access the Reboot page from the Setup > Maintenance and Troubleshooting menu.

Use the Reboot page to perform a controlled reboot of the iCOMPEL.

Caution: You can stop and restart the iCOMPEL simply by switching the power off and on. However, following a
software update, you must reboot the iCOMPEL using this controlled process to ensure the update completes
successfully.

Select Yes from the drop-down list and click the  button.
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10. Troubleshooting

Your iCOMPEL requires little maintenance.

From time to time, Black Box Network Services may release software updates for your iCOMPEL. To make sure you keep
your iCOMPEL up to date, you can set it to receive and install those updates automatically (see Software Update  for
more details).

The following topics provide more information about iCOMPEL maintenance and problem solving procedures:

Backing Up Your Player  – Creating and restoring a backup of your media files and iCOMPEL settings.

Reboot System  – Manually rebooting the iCOMPEL.

Support Snap Shot  – Creating a collection of log and device data for support purposes.

Connection Troubleshooter  – Following a sequence of tasks to track down and correct connection problems.

10.1 Support Snap Shot

If you have a problem with your iCOMPEL, your support representative may ask you to create a Support Snap Shot. A
support snap shot consists of a detailed collection of iCOMPEL logs and device setting data.

You can access the Support Snap Shot page from the Setup > Maintenance and Troubleshooting menu

Click the  button and follow the on-screen instructions to create the support snap shot, if you are
asked to do so.

The Extras tab includes further diagnostic tools that you may be asked to use by the support representative to help
diagnose and resolve problems with your iCOMPEL.

10.2 Connection Troubleshooter

If you are having difficulties connecting to your iCOMPEL, work through the tasks in the following table:

Task Comment

There must be network cables connecting the iCOMPEL
to your PC.

Use either a network cable connecting your PC to your LAN and one
connecting the iCOMPEL to the LAN, or a crossover cable connecting
your PC directly to the iCOMPEL. Make absolutely sure that you are
using a crossover cable.

If you are using a laptop. connect it to mains power. If your laptop is running on battery power, and the battery is low, the
networking circuits may have been shut down. You may need to reboot
your laptop and the iCOMPEL.

If you are using a crossover cable, turn off any wireless
networking.

Your laptop may have a switch to turn wireless networking on and off.
Otherwise, look for an icon on your desktop or in your Control Panel
(for Windows PCs).

If you are using a crossover cable, your PC must not be
configured to work through a proxy.

In Internet Explorer, select Tools > Internet Options > Connections.

Click the  button and clear the Use a proxy server for
your LAN box. 
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Task Comment

In Firefox, select Tools > Options > Advanced. On the Network tab,

click the  button and select No Proxy.

Reboot the iCOMPEL and the PC.

During the iCOMPEL boot sequence, press the ESC key
and look for an OK message (in green) for the eth0
parameter.

If you see a [Fail] message (in red) for the eth0 parameter this
usually means that the iCOMPEL has found nothing to connect with at
the other end of the cable.

During the iCOMPEL boot sequence, press the ESC key
and look for the IP address on the screen.

A No Cable message means that the cable is missing or faulty or that
there is another device on the network with the same IP address. The
address 169.254.1.1 either means that DHCP could not be found or
you are using a crossover cable.

The iCOMPEL must have completed its boot sequence. The screen connected to the iCOMPEL should be showing the default
layout and content.

The yellow LEDs on all applicable network sockets
should be on or flashing.

If applicable, check the yellow light (if present) is lit on the socket that
the network cable plugs into on your PC, on the iCOMPEL, and any
hubs or routers in the path from the PC to the iCOMPEL.

You should know the IP address of your PC. To find the IP address of a Windows PC, click Start > Run. Enter cmd

and click the  button. Enter ipconfig and press the Enter
key. Your PC displays its IP address.

Make sure that the IP addresses of the iCOMPEL and PC
are in the same sub-net.

You may need to consult your network administrator for further advice.

You should try to ping the iCOMPEL from the PC. (Some
networks do not allow pings.)

On a Windows PC click Start > Run. Enter  cmd and click the

 button. Enter ping followed by a space and then the IP
address of the iCOMPEL. Press the Enter key. After a few seconds you
should see a message that includes the phrase (0% loss). The
yellow LED on the network socket of the iCOMPEL should flash during
the ping.

You should be able to access the iCOMPEL with your
browser.

In the address bar of your browser, enter the IP address of the
iCOMPEL and click the Enter key. When prompted, enter the
username and password for the iCOMPEL. The home page of the
iCOMPEL should appear in the browser.

Make sure your browser is not showing a cached version
of the iCOMPEL home page.

In Internet Explorer, click File and select Work offline. Also, select

Tools > Internet Options and click the  button in the

Browsing History panel then press F5.

If you are using a crossover cable then you should not be
prompted to dial up to the Internet.

If you are using Internet Explorer, and you cannot prevent the PC from
dialing out for an Internet connection, install the Firefox browser on
your PC and use it to access the iCOMPEL.

You should be able to connect to the iCOMPEL using In Internet Explorer, in the address bar type ftp:// followed by the IP
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Task Comment

FTP. address of the iCOMPEL and press the Enter key. When prompted,
enter the same username and password. 

In Firefox, in the address bar type ftp:// followed by the username, a
colon (:), the password, the at symbol (@), and then the IP address of

the iCOMPEL. For example, ftp//remote:9999@192.168.1.2. You

should see a list of folders including media.
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11. Technical Reference

This section contains technical reference topics not covered elsewhere:

Energy Saving  – Reducing the amount of power your system consumes.

Optimizing Playback Performance  – Enhancing the playback performance of specific media types.

RS-232 Technical Reference  – Understanding RS-232 pin assignments and electrical interfaces.

Backup Contents  – Understanding which files and folders the iCOMPEL saves in a backup.

11.1 Energy Saving

Digital Signage players like the iCOMPEL are designed to run continuously. To reduce the energy consumed, you may
wish to shut down part or all of your system during appropriate times of the day or night. 

Here are some techniques you might consider using: 

Technique Steps to Follow Effects

Switch Screen to
Standby Mode

To put the screen into standby mode immediately, follow these steps:

1.On the menu bar, click Schedule and select Manage Schedules. 

2.Click the  button for the currently running schedule.

3.Click the  button for the current schedule entry.

4.Set Screen to Off. 

5.Click the  button.

To put the screen into standby mode at other times, create schedule entries
to turn the screen off when it is not needed.

Screen in standby mode.

iCOMPEL continues to
run.

Switch Screen off with
RS-232 Cable

1.Refer to the screen manufacturer's information for the RS-232 codes
needed to switch the screen on and off.

2.Connect the iCOMPEL to the screen using a RS-232 cable. 

3.On the menu bar, click Setup and select Player > RS-232 outputs. 

4.Click the Add Item tab and create separate RS-232 items containing the

screen on and off codes. Click the  button to save each item.

5.Add those RS-232 output items to a playlist from the Special tab.

Screen switched off.

iCOMPEL continues to
run.

Switch Screen and
iCOMPEL Off with Timer
Switch

You cannot damage iCOMPEL units by cutting off their power. However, do
not cut off power during a software update. To switch off the screen and the
iCOMPEL with a timer switch, follow these steps: 

1.Obtain a timer switch for the power supply to the screen and the iCOMPEL. 

2.Program the timer switch to turn power on and off at the desired times. 

3.Plug the screen and iCOMPEL power cables into the timer switch.

Screen switched off.

iCOMPEL switched off.

150

151

151

152
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11.2 Optimizing Playback Performance

You can optimize the playback performance of specific media by taking note of these points:

iCOMPEL players have no problem displaying MPEG-2 video at a reasonable rate (up to 10 Mbps). This typically uses
less than half of the iCOMPEL processing power. 

You should resize images (especially digital photos) before uploading them onto the iCOMPEL. Ideally, resize them so
that they match the size of the zone. 

Scrolling text uses relatively little processing power, provided it does not take up more than 30% of the screen area. 

Animations (typically in Flash or HTML with embedded JavaScript) have no upper limit to the processing power they
require and can overwhelm the iCOMPEL. If this occurs, the animation will typically run slowly but other zones will
continue as normal. 

11.3 RS-232 Technical Reference

The pin assignment of the RS-232 9-way D-PLUG is as follows: 

Pin Direction RS-232 Name Quiescent State

1 Input to iCOMPEL DCD High impedance

2 Input to iCOMPEL RxD High impedance

3 Output from iCOMPEL TxD -ve voltage level 

4 Output from iCOMPEL DTR -ve voltage level 

5 Sig. GND

6 Input to iCOMPEL DSR High impedance

7 Output from iCOMPEL RTS -ve voltage level 

8 Input to iCOMPEL CTS High impedance

9 Input to iCOMPEL RI High impedance

For historical reasons, the RS-232 standard uses a variety of terminology to describe its signal status:

Lowered = Negated = Logic 1 = -ve voltage = Off = Marking.

Raised = Asserted = Logic 0 = +ve voltage = On = Spacing. 

The iCOMPEL uses voltage level in order to describe line status since this is the only explicit identification. 

Inputs have: 

Hysteresis (generally of about 0.5 V).

A threshold level of about +1.5 V.

An input impedance of about 5000 ohms connected to GND (defaults to a -ve voltage state with nothing attached).

An acceptable input range of +/-15 V.
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Outputs have: 

A voltage swing ranging from +/-5 V to +/-12 V (depends on hardware).

A source current drive capability of about 15 mA (with output current limiting) (can drive LEDs/PIR modules and provide a
voltage for contact closure applications). 

11.4 Backup Contents

Backing Up Your Player  describes how you create a backup for your iCOMPEL. The folders and files included in the
backup are:

Folders Files

/data/data/ad_hoc_media/ 

/data/data/channel/ 

/data/data/config/ad_hoc/ 

/data/data/control/ 

/data/data/fonts/ 

/data/data/media/ 

/data/data/package/data/config/channel/ 

/etc/onelan/ntb/layout_permissions/ 

/data/data/config/audio_settings.xml 

/data/data/config/http_proxy_settings.xml 

/data/data/config/local_information.xml 

/data/data/config/player_settings.xml 

/data/data/config/remote_setup_settings.xml 

/data/data/config/schedule_log_rotate.xml 

/data/data/config/screen_settings.xml 

/data/data/config/software_update_settings.xml 

/data/data/config/streaming_video_settings.xml 

/data/data/config/tv_settings.xml 

/etc/onelan/common/user_passwords.xml 

/etc/onelan/common/users.xml 

/etc/onelan/ntb/date-and-time-settings.xml 

/etc/onelan/ntb/dsm_reporting_password.xml 

/etc/onelan/ntb/dsm_reporting_settings.xml 

/etc/onelan/ntb/ldap_passwords.xml 

/etc/onelan/ntb/ldap_passwords_pending.xml 

/etc/onelan/ntb/ldap_settings.xml 

/etc/onelan/ntb/ldap_settings_pending.xml 

/etc/onelan/ntb/security_settings.xml 

141
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12. Glossary

Term Meaning

Ad hoc An override to a display schedule, often managed locally by ad hoc users, which is restricted to a
specific zone and/or content type. Ad hoc users control ad hoc content or ad hoc items, which are
kept in ad hoc media folders, and displayed on ad hoc pages.

Ad hoc from center An ad hoc schedule override which is managed and sent by a remote publisher iCOMPEL to one
or more specific subscriber iCOMPEL players.

Audition Manually launching new content to observe how it performs.

Channel A source of display content used by subscribers. Also refers to the content it contains.

Channel Content Server A server storing and publishing channel content to offload processing overhead from the
publisher.

Channel name Identifies the channel.

Conditional play A means of controlling whether content is played or not depending on the values set in the player
local information.

Content An item of digital media or text that is displayed in a zone as part of a playlist.

Digital signage Electronic display that may show a combination of any or all of text, graphics, and still and
moving images.

Digital Signage Network A set of systems connected together to provide integrated management of numerous display
screens.

Display The overall content being shown on the screen, rather than its layout or zone configuration.

Donate The process of applying a player's configuration to a folder that the iCOMPEL Deployment
Manager then uses to configure other players. 

Event An interactive input that causes a change in the display.

Folder play The ability to add an entire folder of items to a playlist and have them play in sequence.

Graphical layout editor The interactive editor for creating and modifying layouts using zones.

Interactivity The iCOMPEL can run predetermined fixed schedules in the different zones within a layout.
However content can also be dictated by external stimuli such as floor pressure pads, the
incorporation of a touch screen display, or changing content using a remote keypad. 

IPTV (Internet Protocol
Television)

The delivery of television services over the Internet (as opposed to traditional broadcast
technology, satellite, or cable reception).

Layout The combination of a background image and one or more display areas (zones) and that can be
shown simultaneously on a screen.

Layout icons view Abstract display of a layout showing only the distribution and size of its zones. The color of each
zone indicates the media it is enabled to play.
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Term Meaning

Layout package The media and settings for a layout bundled a ZIP file for distribution to other players.

Media Dynamic content such as streaming video, TV, radio and newsfeeds is referred to as media.

Media audit Reports indicating which media items played on the iCOMPEL, when, and for how long.

Media folder Designated area on the iCOMPEL disk holding media items for adding to playlists.

Media player The type of media each zone is enabled to display. 

Menu bar Appearing on all of the user interface pages, the menu bar provides access to the various
iCOMPEL configuration and design options (such as Media or Playlists).

Multichannel publishing A publisher configured with more than one channel. Only one channel at a time can be active.

Override Users can override or interrupt a schedule when necessary, for example to display special
instructions in the event of an emergency, or to show a special event from a TV broadcast feed.

Page The iCOMPEL interface is made up of different pages, accessed through the menu bar. Ad hoc
users have their own dedicated pages for their limited-level access.

Player A component of the Black Box Digital Signage Platform. Player is the generic term for the
appliance that runs the screen. Specifically, the player is the Black Box iCOMPEL.

Player local information Data entered on an iCOMPEL used to alter what is displayed according to conditions often tied to
a locality.

Playlist A series of digital media content items displayed in a zone.

Properties, item Refers to the specific characteristics of a display item such as the font and type size of text, the
format of images, or the duration of an item in a playlist. 

Publish To distribute channel schedules to multiple subscriber iCOMPEL players for display on their
associated screens.

Publisher A player that provides content to other players through channels.

Remote keypad A programmable hand-held device for local control of displays, this can be used to switch
between layouts, choose TV or radio stations, and adjust  volume level.

Remote setup A feature allowing a player's configuration to be applied to other players by the iCOMPEL
Deployment Manager through a folder. 

Rendezvous Point This may be added to a playlist as part of an Advance To command or may be used in multiple
playlists to ensure synchronization between them.

Role Describes the function of a player: one of standalone, subscriber, or publisher.

Schedule A plan or timetable for displaying layouts at specific times.

Schedule entry An individual action added to the iCOMPEL schedule.
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Term Meaning

Screen snap shot A picture of what the iCOMPEL is currently displaying.

Standalone A player that is neither a subscriber or publisher.

Streaming video Video which is delivered to the end user 'live' (that is, direct from the video provider).

Subscribe iCOMPEL players that show a schedule from a publishing iCOMPEL subscribe to that device.

Subscriber A player that accepts a channel from a publisher.

Support snap shot A collection of detailed logging information used for support and problem solving purposes.

User Interface policy The level of features exhibited in the menu bar and in other options (can be productive, detailed,
or expert).

Zone A single display area in a layout.
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advanced features     68

advanced media properties     60

analog TV setup     122

audio     45, 134

audit     60

automatic captions     68

automatic colors     64

automatic update     142
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background color     64

backup     96, 141

backup contents     152

buttons     15

- C -

captioning     68

CCS     101

Change Layout command     64, 74

channel content server     101

channels     12, 100, 101, 102, 105

character set     55

click on touch     75

clock properties     58

clocks     38

colors     64, 76

common advanced properties     60

conditional play     60, 111

conflict     97

connection problems     146
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content     20, 36, 40, 41, 48

content types     36

control line inputs     74

control line outputs     74

copy layout package     97

creating layout package     96

- D -

date setup     119

designing layouts     73

digital signage networks     100, 101, 102, 105

digital TV setup     122

directly entered text     36

disk temperature     110

display     20

display part of movie     75

display part of web page     75

display screen     134

displaying content     33

displays     68

drag and drop file upload     41

- E -

edit item properties     51

editing a zone     29

energy     150

energy consumption     150

enhanced features     68

Ethernet     120

event     71

external web pages     50

- F -

fallback user     128

feature keys     134
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files     32, 41

files & folders     40

files and folders in backup     152

firewall     125

firewall status     125

flash     46

folder play     33, 47

folder play example     59

folder play properties     59

folders     33, 47

font files     65

fonts     65

foreground color     64

FTP     101, 125

- G -

glossary     154

GPIO     27, 71, 74

graphical layout editor     28

- H -

Home page     15

HTML pages     50, 75

HTML player     36, 136

HTTP     124, 125, 128

HTTP proxy     124

HTTPS     132
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image player     36

images     44

inputs     74

install layout package     97
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interaction action     71

interaction event     71

interactivity     71, 73, 139

interface options     116

international settings     141

IP TV     49

item properties     51

- L -

layout     12, 20, 22, 25, 26, 27, 28, 33

layout editor     28

layout package     96, 97

layout package conflict     97

layout package information     98

layout properties     27

LDAP     125, 128

LDAP tests     125, 128

letterbox color     64

live screen display     112

live video     49

loading content     41

loading files     41

log in     14

log on     14

- M -

maintenance     96

manual update     142

master password     125

master volume     134

media     20, 36, 37, 38, 40, 43, 44, 45, 46, 48, 49, 50

media audit     60

media backup     96

media items     12

media player     36, 136

media properties     60

media types     36, 40, 48

menu bar     15

minimizing energy use     150

movie     75

movie player     136

movie properties     53

multicast setup     122

multicast video     49

multichannel     105

- N -

network connection order     120

network setup     120

network status     120

network tests     120

networks     100, 101, 102, 105

newsfeeds     37

NTP     119
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options     116

OTF     65

outputs     74
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password     14
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plasma screen burn     76
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player setup     116, 134
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PowerPoint     45

presentation player     136
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processor limitation     151
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remote setup     132

rendezvous point     63, 69
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rotating zones in a layout     76
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RS-232 inputs     139

RS-232 interface     75

RS-232 outputs     137

RS-232 technical reference     151
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screen display     112
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setup     116, 117, 118, 119, 122, 134, 136, 137, 139,
141
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SSL certificates     125

status     15, 110, 112, 120, 125
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